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IntroductionIntroduction

This Fast & Easy guide from Premier will help you find success with Adobe
Photoshop 7.0 for Windows, whether you are altogether a beginner to working with
digital images or simply new to working with Photoshop. This book will show you
how to master the many and diverse features in Photoshop, so you can begin to
become a digital artist.

Adobe Photoshop 7.0 Fast & Easy teaches techniques that will enable you to create
logos, images for published documents, Web page graphics, and more. You also will
learn how to use filters, correction tools, plug-ins, and other tools to enhance and
improve images that you’ve created from scratch, scanned, or shot from a digital
camera.

If you want to create high-quality artwork and have the widest variety of tools and
controls, Photoshop 7.0 and this book provide everything you need to exploit your
imagination and build arresting, effective images.

Who Should Read This Book?
This book is geared for novices who are new to digital image creation or new to
Photoshop. Because it’s the most feature-rich graphics program, Photoshop can be
tough to learn. Nearly every step in this book includes a clear illustration, so you
won’t have to struggle to learn a process or find the right tool in the toolbox. The
nontechnical language also helps smooth the transition from newbie to comfortable
user.



With each task clearly identified by a heading, you’ll also find it easy to use the table
of contents to find the steps you need. So, whether you want to work through the
book from beginning to end or find just the tricks that you need, this book will
accommodate your style and enhance your results.

Mac users also can use this book to learn how to use Photoshop. The features of the
Mac version of Adobe Photoshop 7.0 are nearly identical to those in the Windows
version (with the exception of a few features). Appendix C, “Mac Command
Equivalents,” explains the few differences between working with Photoshop in
Windows and working with Photoshop on a Mac. 

Added Advice to Make You a Pro
Once you get started, you’ll notice that this book presents many steps, with little
explanatory text to slow you down. Where warranted, however, the book presents
these special boxes to highlight a key issue:

• Tips give shortcuts or hints so you learn more about the ins and outs of
Photoshop 7.0.

• Notes offer more detailed information about a feature, food for thought, or
guidance to help you avoid problems or pitfalls in your work.

• Cautions point out trouble spots and traps to avoid.

Valuable appendixes at the end of the book highlight additional skills and topics.
Learn how to work with digital watermarking, how to set preferences in Photoshop,
which command changes you need to know to use Photoshop on a Mac, and where
to go online to find more information about Photoshop and Photoshop plug-ins.
Finally, the glossary explains key terms that you need to understand to work
effectively in Photoshop.

Whether you have an image to edit or want to start with a “blank canvas,” have fun
as you dive in now!
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Congratulations for choosing Photoshop, the leading application
for creating, correcting, and enhancing image files. Photoshop’s
wealth of features serves the technical needs of advanced users, but
at its core it offers a relatively simple interface that’s similar to
applications you may have used before. This first chapter leads you
through the basics of navigating the Photoshop work area. You’ll
learn how to:

Start and exit Photoshop

Use the toolbox

Work with a palette or context menu

View and hide screen elements

Find help when you need it
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Starting Photoshop
As with other applications, you must start Photoshop to be
able to work with its tools and create a new image. Use the
following steps to start Photoshop.

1. Click on the Start button at the left end of the Windows
Taskbar. The Start menu will appear. 

2. Point to All Programs (or
Programs for windows versions
prior to XP). The Programs menu
will appear.

3. Click on Adobe
Photoshop 7.0. The
Photoshop 7.0 application
window will appear. 
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TIP
After you click on Start,
you can point to a menu
choice with a right-
pointing triangle beside it
by moving the mouse
pointer over it. Pointing
will highlight that menu
choice and open a
submenu. When you see
the name of the program
you want to start, click on
the program name.



Taking Charge of the Tools
The work area in Photoshop includes a menu bar like other
Windows applications, as well as a few windows that organize
the tools you use to do your work. Although later chapters will
cover the tools in greater detail, familiarize yourself now with
menus and tools and how to use them.

1. Click on a menu name. The menu will open.

2. Click on a command. The
result will differ, depending on
the nature of the command on
which you clicked:

• If the command has no trailing
element, Photoshop will
execute the command
immediately.

• If the command name is
followed by an ellipsis (…) , a
dialog box will appear. 

• If the command name has a
triangle beside it, a submenu
will appear. You can then click
on a command in the
submenu.

5TAKING CHARGE OF THE TOOLS

NOTE
You can’t use the various Photoshop tools until you
create or open a new file. Chapter 2, “Working with
Image Files,” explains how to create new files in
Photoshop. The illustrations here include a blank file
strictly as an example.



3. Make choices in the dialog box. Typical dialog box choices
include the following:

• Drop-down list box. Click on
the down arrow or scroll
arrow to open a drop-down
list or scroll through a list’s
choices, then click on the list
item you want.

• Text box. Drag over a text
box entry to select it, then
type a new entry. 

• Option button. Click on an
option button to choose it
and deselect other option
buttons in the group.

• Check box. Click on a check
box to select (check) or
deselect (uncheck) it. 
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• Slider. Drag a slider to choose another setting.

• Palette. Click on a button (icon) or palette to select it.

• Command button. Click on a
command button to choose it. 

4a. Click on Cancel. The dialog
box will close.

OR

4b. Press Esc on the keyboard.
The dialog box will close.
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TIP
Clicking on a command
button with an ellipsis (…)
displays a dialog box.
Clicking on an OK or Done
button closes the dialog
box and applies your
choices. Clicking on a
Cancel button closes the
dialog box without
applying your choices. 



5. Click on a toolbox button. The options bar at the top of
Photoshop will change to show available settings for that tool.

6. Review the options bar
choices. These choices will work
just like dialog box options. 

7. Click on a palette tab. The
settings on that tab will appear.

8. Click on the right arrow
button in the upper-right corner
of the palette window. The
palette menu will appear.

9a. Click on an item on the
palette. The item will be
selected.

OR

9b. Press Esc. The palette
menu will close.
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TIP
For some tools, the
options bar includes a
Toggle, the (tool name)
palette button at the far
right end. You can click
that button to display and
hide a palette window
with additional settings
for the selected tool. 



10. Right-click on the image, a palette, or a toolbox tool.
The context menu (shortcut menu) with commands pertaining
to the object on which you clicked will appear.

11. Click on a context menu
command. The results will vary
depending on the nature of the
command:

• If the command name has a triangle beside it, a submenu will
appear. You can then click on a command in the submenu. 

• If the command name has an ellipsis (…) beside it, a dialog
box will appear; you can then make your choices from the
dialog box. 

• If the command has no trailing element, Photoshop will
execute the command immediately.

9TAKING CHARGE OF THE TOOLS

NOTE
If you have certain toolbox
tools selected when you
right-click on the image, a
pop-up palette of settings
for the tool appears
instead. You’ll learn more
about using a palette like
this in Chapter 3. 



Hiding and Showing Screen
Elements
The toolbox and the palettes consume quite a bit of the
Photoshop work area. When you’re not using the toolbox or a
particular palette, you can close it using a command on the
Window menu. If you choose the same command again,
Photoshop redisplays or toggles on the specified screen
element. (When a checkmark appears beside a command on
the Window menu, the screen element represented by the
command is currently displayed.) Review the applicable
commands next.

1. Click on Window. The
Window menu will appear.

2. Click on Tools. Photoshop
will hide the toolbox. 
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3. Click on Window. The
Window menu will appear.

4. Click on Tools again.
Photoshop will redisplay the
toolbox.

5. Click on Window. The
Window menu will appear.

6. Click on Navigator.
Photoshop will close the
Navigator palette, which is the
top palette by default. 
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7. Click on Window. The
Window menu will appear.

8. Click on Navigator again.
Photoshop will redisplay the
Navigator palette. 

9. Click on Window. The
Window menu will appear.

10. Click on Color. Photoshop
will close the Color palette,
which is the middle palette by
default.
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11. Click on Window. The
Window menu will appear.

12. Click on Color again.
Photoshop will redisplay the
Color palette. 

13. Click on Window. The
Window menu will appear.

14. Click on Layers. Photoshop
will close the Layers palette,
which is the bottom palette by
default.
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NOTE
Clicking on many of the
other commands on the
Window menu, such as
Swatches or Paths, selects
a particular tab in one of
the palettes.



15. Click on Window. The
Window menu will appear.

16. Click on Layers again.
Photoshop will redisplay the
Layers palette. 

Reviewing Help Features
When you get stuck while working in Photoshop, you can
consult the product’s Help system. Not only does Photoshop
offer Help that you can browse or search, but it also offers
Internet Help and news that you can consult to stay up-to-date
with the latest Photoshop developments. Adobe, the publisher
of Photoshop, offers extensive Help and resources for
Photoshop users. 

Using Help Contents and Search
Features
Photoshop offers a huge number of features, and using them in
combination can be a little tricky. If you get stuck at any point,
you can consult Help in Photoshop to learn more about the
feature that’s at issue. The following steps explain how to
browse and search in Help. 
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1. Click on Help. The Help
menu will open.

2. Click on Photoshop Help.
The Photoshop Help system will
open in the Web browser
installed on your system
(typically Internet Explorer).

3. Click on a topic link at the
left side of the window. The Help
topic will appear at the right side
of the window, along with links
to subtopics.

4. Click on the down scroll
arrow. The window contents will
scroll down, so you can read
more or see additional
subtopics.

5. Click on a subtopic link. The subtopic information will
appear at the right side of the window, so that you can read it. 
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6. Review the Help. You will be
able to continue to navigate in
Help if the information doesn’t
solve any issue you’re having. 

7. Click on the Index link at the top left of the page. The
index letters will appear in the pane at the left side of the
screen.

8. Click on the first letter of
the topic you want Help about.
The left pane will display a list of
topics beginning with the letter
you specified. You can scroll
down the list as needed. 

9. Click on a topic number. The
topic information will appear at
the right side of the window, so
that you can read it. 
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10. Click on the Search link at
the top of the page. The Find
pages containing text box will
appear at the left side of the
screen.

11. Type the term to search
for in the Find pages containing
text box, then click on Search.
The left pane will display a list of
help topics that include the term
you specified.

12. Click on a topic. The topic
information will appear at the
right side of the browser
window.

13. Click on a topic link at the
top of the page. The topic
information for that earlier topic
appears.

14. Click on the Previous or
Next link. The Help system
navigates to another previously
viewed topic.
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15. Click on File in the Web
browser. The File menu will
appear.

16. Click on Close. The Help
system (and your system’s Web
browser) will close.

Reviewing Adobe
Online
Adobe Online provides a quick
and easy method for retrieving
Photoshop Help, news, and

information from Adobe’s Web site. The steps here illustrate
how to use Adobe Online when you need it. 

1. Click on Help. The Help menu will appear.

2a. Click on Adobe Online. The Adobe Online dialog box will
open.

OR

2b. Instead of Steps 1 and 2a,
you can click the Go To Adobe
Online button at the top of the
toolbox.
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TIP
The first time you start
Adobe Online, you will be
prompted to check for
program updates. You can
click on Yes to do so, or
No to continue without
checking for updates. 



3. Click on Go Online if the
dialog box shown here appears.
If your system needs to connect
to the Internet, the Dial-Up
Connection dialog box will
appear.

4. Click on Connect. Your
system will dial up and log on to
the Internet. The Adobe home
page will appear. 
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NOTE
The first time you connect
under Windows XP, the
Network Connections
dialog box may appear
first. If it does, choose
your connection in the list,
and then click on Connect.
Then click on Dial in the
next dialog box that
appears. If you have an
“always on” Internet
connection or you have
set up your system to dial
automatically, skip Step 4.



5. Click on a link on the Web
page to browse for more
information. Adobe’s Web site
will display the proper page. You
can continue browsing online to
topics of interest. 

6. Click on File in the Web browser. The File menu will open. 

7. Click on Close. The Web
browser window will close. 

8. Disconnect from the Internet,
if needed. 
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NOTE
If Windows doesn’t
prompt you to hang up
your Internet connection,
you can right-click on the
connection icon in the
system tray area at the far
right end of the Windows
Taskbar, and then click on
Disconnect.
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Exiting Photoshop
When you finish working in Photoshop or want to shut down
your system altogether, you need to exit the Photoshop
program. It takes just a few brief steps, as detailed here. 

1. Save the currently open file. Photoshop will preserve the
latest changes to the file. The section called “Saving a File” in
Chapter 2 will explain how to save a file. 

2. Click on File. The File menu
will open. 

3. Click on Exit. The Photoshop
application window will close. 
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When you use Photoshop to create and work with images, you
store those images digitally rather than storing them as film
negatives or hard copies. So, you need to learn the ins and outs of
managing your Photoshop files, as well as how to transfer image files
from a device into Photoshop. In this chapter, you’ll learn how to do
the following:

Create a new image file

Open a file

Import a scanner or digital camera image

Add File Info

Save and close a file

Use the new File Browser

Save your workspace

22
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Creating a New File
In some cases, you may want to start the creative process with
a blank canvas—a new, blank image file. Photoshop doesn’t
open a blank file by default when you start the program, so
you must do it manually. When you create a new file in
Photoshop, you can specify the file size, whether it includes a
background color, and more.

1. Click on File. The File menu will appear.

2. Click on New. The New dialog box will open.
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3. Type a name for your file in
the Name text box.

4. Set the image settings in the
Image Size box, as follows:

• Double-click on the Width
text box contents and type a
new image width value. If
needed, click on the down
arrow for the unit list, and
then select another
measurement unit.

• Double-click on the Height text box contents and type a
new image height value. If needed, click on the down arrow
for the unit list, and select another measurement unit.

• Double-click on the
Resolution text box contents
and type a new resolution
value. If needed, click on the
down arrow for the unit list,
and select another resolution
unit.

25CREATING A NEW FILE

TIP
Rather than specifying
image dimensions, you
can choose a predefined
image size from the Preset
Sizes drop-down list.



• Click on the down arrow for
the Mode list, and then click
on the color mode to use.

5. Click on a Contents box option. The options work as
follows:

• White. Fills the image with a
default white background.

• Background Color. Fills the
image with the background
color currently selected in the
Photoshop toolbox.

• Transparent. Gives the image
a transparent background, so
that when you use the image
in a document or Web page,
the page background and
page elements can show
through the image file.
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NOTE
Resolution refers to the
number of pixels (dots)
printed per measurement
unit (commonly per inch).
The color mode controls
how many colors define
the image, as required by
a particular type of display
and output. See Chapter
15, “Understanding Colors
and Channels,” to learn
more about color modes.



6. Click on OK. The New dialog
box will close, and the new
image file will open onscreen.

Opening an Existing File
If you’ve already saved an image file, you can reopen it at any
time to make changes and improvements.
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CAUTION
If you choose a white
background for a 
new image and the
background appears
yellow onscreen (or white
areas in other images
appear yellow), you can
easily fix the problem,
which occurs on systems
using certain 3D-
accelerated video cards. In
Windows XP, click on
Start, then click Control
Panel. In the See Also list
at the left, click Other
Control Panel Options.
Click the Adobe Gamma
icon, then follow the
instructions that appear to
create a new ICC color
profile for your monitor,
which should solve the
problem.



1. Click on File. The File menu
will appear.

2. Click on Open. The Open
dialog box will open.

3. Navigate to the file location. The desired file will be
displayed in the file list. You may need to do one or more of
the following steps to locate the file:

• Click on the down arrow to
the right of the Look In list,
then click on the icon for the
disk that holds the file. 
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TIP
To open a file you’ve
recently used, click on the
File menu, drag the mouse
pointer down to the Open
Recent command, and
then click on the name of
the file you want to open
in the submenu that
appears.



• Double-click on folder icons
in the list to navigate to the
folder that holds the file to
open.

• Click on Up One Level to
return to a folder that’s one
level higher.

4. Click on the file that you
want to open. A preview of the
file will appear at the bottom of
the Open dialog box.

5. Click on Open. The file will
appear onscreen.
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NOTE
If a scroll bar appears below the list of files, click on the
scroll arrow at either end of the scroll bar to scroll the
list of files.



Importing an Image
You may want to use Photoshop to improve images you
generate from another source, such as a scanner or digital
camera. Assuming you’ve installed the Windows software
driver that came with the scanner or camera, Photoshop should
be able to recognize the device and import images directly
from it.
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Using File Formats in Photoshop
Photoshop supports more than a dozen different file
formats by default, so chances are you can open an image
created in another program by selecting the appropriate
file type from the Files of type drop-down list in the Open
dialog box. Here are some of the common file formats you
might use:

• .BMP. The Windows Bitmap format created by the
Windows Paint applet.

• .GIF. A compact file format often used for Web graphics.

• .PDF. The Adobe Acrobat file transfer format.
Photoshop 7.0 now supports password protection for
.PDF files, so you may be prompted to enter a password
when you open a .PDF file. 

• .JPG or JPEG. Another file format often used for Web
graphics.

• .PCX. An alternate to the Windows Bitmap format that
was originally popularized via the PC Paintbrush
program.

• Photo CD. A format originally developed by Kodak.

• PICT. A Macintosh graphics format.

• .TIF or TIFF. A common format for scanned images.
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Grabbing a Scanner Image
Impressive scanners costing $300 or less have become widely
available. You can use Photoshop to scan hard copy photos and
other graphics for modifications and editing. When you’re
ready to scan an image, turn on the scanner and position the
image on the scanner bed before continuing with the following
steps. If you’re not sure how to position it correctly, consult the
scanner’s user manual.

1. Click on File. The File menu will appear.

2. Drag the mouse pointer down to the Import command.
(That is, point to the command.) A submenu will appear.

3. Click on the name of your
scanner in the submenu. The
scanner software (TWAIN or
Windows Image Acquisition
[WIA] software) for your scanner
will load.
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NOTE
Be aware that copyright law generally prohibits you from
using images created or photographed by others for
your own commercial purposes. When in doubt, play it
safe and do not use information from another source.

NOTE
From Step 4 on, the steps
that you use and the
information that you see
onscreen will differ
d e p e n d i n g on what software
came with your scanner.



4. Click on the Preview button
or its equivalent. A preview of
the image appears so you can
make adjustments.

5. Size the scan area. This may
involve dragging a border to
define the scan area or entering
width and height settings.

6. Adjust other settings, if available. Make other scan setting
changes as needed, such as choosing another scan resolution
or color setting. (You may have to choose a Custom Settings
option or another link to display the available options.)

7. Click on the Scan button or
its equivalent. Your system will
scan the image and place it in
Photoshop. Note that the
scanning process may take a few
minutes, depending on the size
of the image and the speed of
your system.

8. Click on the Close button or
its equivalent to close the
scanner software if it doesn’t
close on its own.
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Grabbing a Digital Camera Image
Digital cameras skip the film and hard copy stage, storing
images digitally directly within the camera. To work with the
images, you need to install the camera software under
Windows, connect the camera to your system via the applicable
cable, and place the camera in its playback mode. From there,
you use the following procedure to copy images from the
camera into Photoshop.

1. Click on File. The File menu
will appear.

2. Drag the mouse pointer
down to the Import command.
A submenu will appear.

3. Click on the name of your
digital camera in the submenu.
The software (TWAIN or WIA
software) for your camera will
load.
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NOTE
Some cameras may not enable you to import images
directly into Photoshop. In such cases, an icon for a
removable disk representing the camera’s removable
media appears in the My Computer window, and you can
copy the images from that “disk” to the system’s hard
disk to work with the images.



4. Click on the Folder tab or its
equivalent. The tab will appear.

5. Click on Open Folder or its
equivalent. A dialog box will
open, enabling you to navigate
through the files and folders
stored on the camera and then
select a folder to open.

6. Navigate to the file location.
The desired file will be displayed
in the file list. (See “Opening an
Existing File” earlier in this
chapter for help with the Open
dialog box.)

7. Click on Open. Your system
will display a preview of the
images from the selected folder.
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NOTE
From Step 4 on, the steps that you use and the
information that you see onscreen will differ depending
on what software came with your camera. In some cases,
you may be able to open a list of all the camera images
directly using an Open Camera button or Camera tab
rather than using all the steps listed here.



8a. Click on the thumbnail for
the image to open.

OR

8b. Click on Select All to select
all the images.

9. Click on Get Picture. The
selected images(s) will be copied
from the camera’s storage and
opened in Photoshop as a new
image file.
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NOTE
If the camera software
doesn’t close
automatically, click on the
Taskbar button for the
software, and then click
on the software window’s
Close button or the
equivalent to close the
software.



Adding File Info
You can save special information with an image file to give it a
caption, describe its origin, identify who created or shot it, and
so on. The information follows professional image identification
standards, but even home users may find this information
useful in building a digital “photo album.” 

Embedding Information in the File
Use the following process to store file info for the current file.

1. Click on File. The File menu will appear.

2. Click on File Info. The File
Info dialog box will open.
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3. Type entries as desired in
the text boxes on the tab. Of
course, you don’t have to use all
the entries. You can use only
those that are relevant to you.

4. Click on the down arrow to the right of the Section list,
then click on the next category to complete.

5. Repeat Steps 3 and 4 to
enter information for other
categories of File Info.

6. Click on OK. The File Info
dialog box closes, adding the information to the file.
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NOTE
In some cases, you must
enter text box information
and click on the Add
button to add the entry.
Or, you can click on a
button like the Today
button (in the Origin
category) to make the
entry automatically.



Saving and Appending XMP
Information
Chances are, some of the File Info you want to add will be the
same for every image file. Rather than typing that information
over and over again, you can save it in a special file and
append the file to additional images as needed. Photoshop 7.0
saves File Info files in the .XMP (Extensible Metadata Platform)
format. Adobe has developed the .XMP data to help you
better track files and to facilitate using the workflow
management features in Photoshop. The following steps
illustrate how to save File Info and append it to additional
Photoshop files:

1. Open the file in which you’ve
embedded File Info. The file will
appear in its own window in
Photoshop.

2. Click on File. The File menu
will appear.

3. Click on File Info. The File
Info dialog box will open.
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4. Click on Save. The Save
dialog box will appear.

5. Navigate to the file location. The desired file will be
displayed in the file list. (See “Opening an Existing File” earlier
in this chapter for help with navigating folders.)

6. Double-click on the File
Name text box entry, then type
a new name for the file. The new
name will be displayed.

7. Click on Save. Photoshop
will save the .XMP file and return
to the File Info dialog box.
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8. Click on OK. The File Info
dialog box will close, adding the
information to the file.

9. Close the file that holds the
File Info. 

10. Open the file to which you
want to add File Info. The file will
appear in its own window in
Photoshop.

11. Click on File. The File menu will appear.

12. Click on File Info. The File
Info dialog box will open.
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13. Click on Append. The Load
dialog box will appear.

14. Navigate to the file location. The desired file will be
displayed in the file list. 

15. Click on the file in the list.
The file will be selected.

16. Click on Load. Photoshop
will load the .XMP file
information and return to the
File Info dialog box.
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TIP
If you click the Load
button, all existing File
Info will be replaced.
When there is no existing
File Info, the Append
button adds all the stored
File Info file information;
however, when there is
existing File Info, the
Append button updates
only the Caption and
Keywords categories.



17. Click on OK. The File Info
dialog box closes, adding the
information to the file.

18. Save the file. The File Info
will be preserved in the file.

Saving a File
If you’ve just created an image file or have just imported it into
Photoshop from a scanner or digital camera, you need to save
the image file to name it and store it to the location of your
choice on your system’s hard disk. The following steps lead you
through the process for saving the current file.

1. Click on File. The File menu
will appear.

2. Click on Save. The Save As
dialog box will open.
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3. Navigate to the file location
where you want to save the file.
The files in that folder will be
displayed in the file list. (See
“Opening an Existing File”
earlier in this chapter for help
with navigating folders.)

4. Double-click on the File
name text box entry, then type
a new name for the file.

5. Click on Save. The Save As
dialog box will close. Photoshop
saves the file and leaves it open
onscreen for further work.

Saving to Another Format
By default, Photoshop saves new images in its Photoshop (.PSD
or .PDD) format. You may need to save an image in another
format. For example, you may want to save the file in the
Windows bitmap (.BMP) or Paint (.PCX) format to use the file in
a word processor document. Photoshop enables you to save
images in more than a dozen formats. 
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NOTE
If you make changes to the file, be sure to click on File
and then click on Save or press Ctrl+S to save your
changes. The Save As dialog box will not appear for
subsequent saves unless you click Save As rather than
Save on the File menu.



Using Save As
Use the following process to save the current file to one of the
available graphics formats. (The Adobe .PDF format will be
covered in the next section.) 

1. Click on File. The File menu
will appear.

2. Click on Save As. The Save
As dialog box will open.

3. Navigate to the location
where you want to save the file.
The files in that folder will be
displayed in the file list. 

4. Double-click on the File
name text box entry. The name
will be selected.

5. Type an alternate name, if
needed, for the converted file.
The new name will be displayed.
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6. Click on the down arrow for
the Format list, then click on the
format to use for the converted
file in the list. The list will close
and the format will be selected. 

7. Click on Save. The Save As
dialog box will close.

8. Set needed options if an
Options dialog box appears. An
Options dialog box appears only
for certain types of conversions,
and the options vary depending
on the conversion format.

9. Click on OK. Photoshop
converts and saves the file,
closing the original file. The
converted file remains open in
Photoshop for further work.
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TIP
To save a copy of the current file (in the same file format)
rather than the original, click on the As a Copy check box
to place a check in it. Then skip to Step 7.



Saving a Password-Protected .PDF File
When you save a Photoshop file in Adobe’s portable .PDF
format, you can now add password protection to the .PDF file.
With this new security feature, you can prevent others from
making changes to the file or from doing certain things with
the file (such as printing it) from Acrobat. Follow these steps to
save a Photoshop file as a .PDF file and add password
protection to the file: 

1. Click on File. The File menu will appear.

2. Click on Save As. The Save
As dialog box will open.
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3. Navigate to the location
where you want to save the file.
The files in that folder will be
displayed in the file list. 

4. Double-click on the File
name text box entry. The name
will be selected.

5. Type an alternate name, if
needed, for the converted file.
The new name will be displayed.

6. Click on the down arrow for
the Format list, then click on
Photoshop PDF. The list will
close and that format will be
specified for the converted file.

7. Click on Save. The Save As
dialog box will close and the PDF
Options dialog box will open.
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8. Click on the PDF Security
check box. It will be checked,
and the Security Settings button
will become active.

9. Click on Security Settings.
The PDF Security dialog box will
open.

10. Click on the Password Required to Open Document
check box. It will be checked, and the User Password text box
will become active.

11. Type a password in the
User Password text box. An
asterisk will appear for each
character you type.

12. Click on OK. The Confirm
Password dialog box will open.
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13. Type the password again
in the Confirm Password text
box. An asterisk will appear for
each character you type.

14. Click on OK. The Confirm
Password and PDF Security
dialog boxes will close.

15. Click on OK. Photoshop
converts and saves the file,
closing the original file. The
converted file remains open in
Photoshop for further work. In
the future, users will be
prompted to enter the password
you specified to open the
converted .PDF file in Photoshop
7.0.
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TIP
At this point, you could
click on the Security
Settings button in the PDF
Options dialog box to
reopen the PDF Security
dialog box and specify
additional security
settings.



Switching between Files
Photoshop enables you to have multiple image files open, in
case you need to compare images or copy information
between them. However, you can only work in one image file
at a time, called the current image or active image. The
following steps detail how to select a file and make it the
current or active file.

1. Click on Window. The Window menu will appear.

2. Point to Documents. The
Documents submenu will appear.

3. Click on the file name for the
file to display. The file window
moves to the top of other open
files and becomes the active
image, so you can work with the
file.

Closing a File
Although you can have multiple images open, image files tend
to consume a lot of system memory, so your system will
perform better if you close images that you are not currently
using. Again, the following steps identify two methods you can
use to close the current image file.
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1. Click on File. The File menu
will appear.

2. Click on Close. In some
cases, a message window will
open.

3. Click on Yes if you see the
message window prompting you
to save the file. Photoshop will
finish saving it and the file will
close.

OR

4. Click on Close for the
window of the image file to
close. If prompted, save your
changes as described in Step 3.
Photoshop closes the image
window.
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NOTE
If you added a new text
layer, a dialog box may
first prompt you to
commit (finish) the layer.
Click on Commit to do so.



Finding a File with File
Browser
Photoshop 7.0 includes a new feature called File Browser. File
Browser displays a preview thumbnail of each image in the
currently selected folder. If you click on an image, you also can

see metadata information (such
as image size, color mode, and
the File Info for a file) in order to
verify that you’re opening the
correct file. The following steps
show you how to find and open a
file with File Browser.

1. Click on File. The File menu
will appear.

2. Click on Browse. The File
Browser window will open.

3. Click on the plus icons in the
folder tree in the upper-left pane
in the File Browser to navigate to
the desired folder. Clicking a
plus icon will display the folders
within a particular disk or folder
on your system or a network
drive.

4. Click on the desired folder
when you see it in the folder
tree. The images in that folder
will appear in the right pane of
the File Browser window.
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5a. Click on the thumbnail for
the desired image. Its metadata
will appear in the lower-left pane
of the File Browser for you to
review as needed.

OR

5b. Double-click on the
desired image. It will open
immediately in Photoshop.

6. Click on Window. The
Window menu will appear.

7. Click on File Browser. The
File Browser window will close.
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Saving and Loading Your
Workspace
Depending on how you use Photoshop and whether you share
your computer with a co-worker, you may find that you spend a
lot of time setting up your screen—dragging palettes around,
for example. Rather than spending your time setting up for a
new task or getting back up to speed after someone has
messed with your Photoshop tools, you can save your favorite
palette positions in a workspace. Later, when you need a
particular workspace, you can load it at any time. After you’ve
set the screen up the way you like it, use these steps to save a
workspace, reset the palettes, and load a particular workspace.

1. Click on Window. The Window menu will appear.

2. Point to Workspace. The
Workspace submenu will appear.

3. Click on Save Workspace.
The Save Workspace dialog box
will open.
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4. Type a name for the
workspace in the Name text
box.

5. Click on Save. Photoshop
will save your workspace.

6. Click on Window. The
Window menu will appear.

7. Point to Workspace. The
Workspace submenu will appear.

8. Click on Reset Palette
Locations. The palettes will
reappear and will be moved back
to their default locations.
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9. Click on Window. The
Window menu will appear.

10. Point to Workspace. The
Workspace submenu will appear.

11. Click on the desired
workspace name. The palettes
will rearrange to the positions
saved in the workspace.
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57PART I REVIEW QUESTIONS

Part I Review Questions
1. How do you open the Photoshop program? See “Starting

Photoshop” in Chapter 1.

2. What’s the difference between a toolbox and a palette, and how do
you use them? See “Taking Charge of the Tools” in Chapter 1.

3. Which menu holds the commands for hiding and showing the
toolbox and other elements? See “Hiding and Showing Screen
Elements” in Chapter 1.

4. What kinds of help can you get in Photoshop? See “Reviewing Help
Features” in Chapter 1.

5. What should you do before you exit Photoshop? See “Exiting
Photoshop” in Chapter 1.

6. How do you create a new file? See “Creating a New File” in
Chapter 2.

7. How do you save a file? See “Saving a File” in Chapter 2.

8. How do get an image into Photoshop from your scanner or digital
camera? See “Importing an Image” in Chapter 2.

9. What is File Info for and how do you add it? See “Adding File Info”
in Chapter 2.

10. How do you convert a file to another format? See “Saving to
Another Format” in Chapter 2.
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Several of the tools in the Photoshop toolbox enable you to add
content to a blank image or to an image you’ve created or opened
from another source. Painting and drawing with your computer may
take some practice, but like any other skill, the results are worth the
effort. In this chapter, you’ll learn how to:

Choose the tool you need

Set tool options and choose the colors to use

Paint with the painting tools

Draw with the drawing tools

Add and improve text

Create a note on an image

Create your own brushes
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Selecting a Tool
Photoshop uses the toolbox to organize your tools by type.
Because Photoshop offers such a wealth of editing tools, the
toolbox looks a bit crowded. What’s more, further
investigating will reveal even more tools than those you initially
see in the toolbox. It’s great to have so many options, but it
may take more than one step to find the tool you want.

You can access some Photoshop tools with one click. Others
you may need to select from a tool “group” shortcut menu.

1. Click on a tool button in the
Photoshop toolbox (after you
open a new or existing file, of
course). The tool will become
active, and available settings for
the selected tool will appear on
the options bar.
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NOTE
A small triangle in the lower-right corner of a toolbox
button indicates that additional tools of this type are
available. Move the mouse pointer over such a tool, then
press and hold the left mouse button to display the
additional tools. 

NOTE
A tool button becomes
white while the tool is
active or selected, and the
tool remains active until
you choose another tool.



2. Right-click on a tool button.
A shortcut menu that lists similar
tools will appear.

3. Click on the desired tool in
the shortcut menu. The tool will
become active, and the available
settings for the selected tool will
appear on the options bar. Use
the active tool to create or edit
your picture with that tool’s
effect.

Setting a Tool’s Options in the
Options Bar
The options bar below the menu bar displays settings for the
currently selected tool, such as a brush size and shape and
opacity. The available settings vary widely depending on which
tool you have selected. Choosing the correct settings before
you draw or paint will save you time, because you won’t have
to go back and make changes. The following steps show an
example of how to use the options bar, but keep in mind that it
may display very different settings for each tool that you
choose.
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TIP
After you select a tool, the right side of the status bar
displays a brief description of how to use the tool. Later
chapters cover the various tools as needed, because
there are so many toolbox tools and they are so diverse
in function.



1. Click on the down arrow for
a setting in the options bar. A list
or palette will appear with the
choices for the selected setting.

2. Drag the lower-right corner
of a palette. Additional palette
choices will become visible.

3. Click on the desired setting
in the list palette. That setting
will become active for the
selected tool.

4. Click on the down arrow
again if the list or palette
remains open. The list or palette
will close.
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5. Drag the slider if a setting
offers a slider rather than a list or
palette. This changes the current
setting for the selected tool.

6. Click on the down arrow
again. The slider will close.

7. Click on a button. Photoshop will either enable (press) or
disable (release) the setting.

8. Click on a check box setting.
Photoshop will either check
(enable) or uncheck (disable) the
setting.
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TIP
For some tools, the
options bar includes a
Toggle, the (tool name)
palette button at the far
right end. You can click
that button to display and
hide a palette window
with additional settings
for the selected tool. 



Resetting Tool Defaults
When you choose the settings for a tool, they remain active
until you change them. So, as you jump between the various
tools, you can reset a tool to its default settings and then
choose the settings that apply during your current use of the
tool. The following steps show how to reset a tool. 

1. Right-click on the tool
button at the left end of the
options bar. A menu will appear.

2. Click on Reset Tool.
Photoshop resets the options
bar settings to the default for
the tool.

Choosing Colors
As when you choose other settings for a tool, you should
choose the foreground and background colors to be used by
the tool. Generally, Photoshop uses the selected foreground
color when you draw lines, and the background color for
gradient fills and erased areas. The Foreground Color,
Background Color box near the bottom of the toolbox shows
the currently selected foreground and background colors. The
following steps detail the numerous methods you can use to
select a new foreground or background color.
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1. Click on the desired
foreground color on the color
ramp in the Color palette. The
foreground box on the toolbox
changes to show the new
foreground color.

2. Press and hold the Alt key,
then click on the desired
background color on the color
bar in the Color palette. The
background box on the toolbox
changes to show the new
background color.

3. Click on the Swatches tab in
the Color palette. The color
swatches appear.

4. Click on the desired
foreground color on the
Swatches tab in the Color
palette. The foreground box on
the toolbox changes to show the
new foreground color.

5. Press and hold the Ctrl key,
then click on the desired
background color on the
Swatches tab in the Color
palette. The background box on
the toolbox changes to show the
new background color.
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6. Open the Color Picker dialog box:

• Click on the foreground color box in the toolbox. The Color
Picker dialog box will enable you to choose the foreground
color.

• Click on the background
color box in the toolbox. The
Color Picker dialog box will
enable you to choose the
background color.

7. Click on a color in the
narrow band of colors near the
middle of the dialog box.
Photoshop will display a
different range of colors in the
Select foreground color or Select
background color box. 
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TIP
Click on the Default
Foreground and
Background Colors (the
small button with the
black-and-white color
chips on it below and to
the left of the larger color
chip buttons on the
toolbox) to reset the
foreground and
background colors to the
defaults: black for the
foreground and white for
the background.



8. Click on a color in the Select foreground color or Select
background color box. The color you click on will become the
active spot color. 

9. Click on OK. The Color
Picker dialog box will close.

10. Open a color picture.
The picture will become the
active picture.

11. Click on the Eyedropper
tool in the toolbox. The
Eyedropper tool will become the
active tool.

12. Click on the d e s i r e d
foreground color. Press and hold
t h e Alt key a n d then click on a
color to select the background
color instead. The color you
clicked on will become the active
foreground color or background
color. You can use those colors to
paint and draw in the current
image file or another file.
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NOTE
The Color Picker and Color
palette may display a
special alert icon when you
choose a particular color. A
cube alert icon indicates
that a color may not dis-
play correctly on the Web.
A triangle with exclamation
point icon indicates that a
color cannot be accurately
reproduced via CMYK
printing. 



Working with Painting Tools
Photoshop combines features of both paint programs—which
paint to change the color of pixels in the image, so that you
cannot later select painted objects—and draw programs—
which create objects that can be selected, edited, and
rearranged later. The images you create with a paint program
work much like drawing or painting on paper; to make a
change, you need to erase or replace something, which can be
tricky if you accidentally erase or paint over an adjoining area.
A draw program works more like a collage, where you can pick
up the individual collage pieces to move, resize, or reshape
them. The steps in this section focus on using drawing tools
that basically color different pixels (color dots) in the picture.

Painting with the Paintbrush
The Paintbrush tool enables you to use the mouse to create
freehand strokes with any of a number of brush shapes.
Photoshop 7.0 includes some neat new brush shapes for
painting. One brush shape paints leaves onto the image.
Another adds blades of grass. Another adds stars. You can use
these interesting new brushes to create pictures from scratch
or enhance an existing image.
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NOTE
Photoshop places painted information on the
background layer by default. You can separate painted
information by placing it on different layers in the file,
which enables you to move and work with the painted
information independent of other information in the
image. See Chapter 8, “Working with Layers,” to learn
how to place content on different layers in an image.
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1. Click on the Paintbrush tool
in the toolbox. It will become the
active tool.

2. Choose the desired settings
in the options bar. Your
selections will become the active
settings for the tool.

3. Select the foreground color
using the method of your choice.
The color you select will become
active for the Paintbrush.

4. Drag on the picture in the work area. Keep the mouse
button pressed as you drag in any desired direction. When you
release the mouse button, the finalized paint stroke will
appear.
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TIP
If you paint or draw on the
image and make a
mistake, immediately
press Ctrl+Z or choose
the Undo (tool) Tool
command on the Edit
menu to undo the
mistake.



Painting with the Pencil
Technically speaking, the Pencil tool functions as a drawing
tool in Photoshop, recoloring pixels as you drag along with 
the tool. The following example illustrates how to use the
Pencil tool. 

1. Right-click on the Paintbrush
tool in the toolbox. Its shortcut
menu will appear.

2. Click on Pencil Tool. The
Pencil tool will become the
active tool.

3. Choose the desired settings
in the options bar. Your
selections will become the active
settings for the tool.

4. Select the foreground color
using the method of your choice.
The color you select will become
active for the Pencil.
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TIP
When the Pencil tool is
active, you must right-click
on the Pencil tool in the
toolbox, and then click on
the Brush Tool choice to
return to using the
Paintbrush tool.



5. Drag on the picture in the
work area. Keep the mouse
button pressed as you drag in
any desired direction. When you
release the mouse button, the
finalized pencil stroke will
appear.

Painting with the Airbrush
The Airbrush tool can help you create a more subtle painted
effect. It creates a “sprayed” effect rather than laying down
solid color, and you can use it by dragging, clicking, or holding
down the mouse button to apply the paint. 

1. Click on the Paintbrush tool
in the toolbox. It will become the
active tool.
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2. Choose a brush and other
desired settings in the options
bar. Your selections will become
the active settings for the tool.

3. Click on the Set to Enable
Airbrush Capabilities button on
the options bar. The button will
appear pressed and the airbrush
will become active.

4. Select the foreground color
using the method of your choice.
The color you select will become
active for the Airbrush.

5. Drag on the picture in the work area. Keep the mouse
button pressed as you drag in any desired direction. When you
release the mouse button, the finalized brush stroke will
appear.
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NOTE
You also can click on the
image while the Airbrush
tool is active to “spritz”
color onto selected
locations. If you hold
down the mouse button
without moving the
mouse, the Airbrush tool
increases the amount of
paint applied, for a
“thicker” application.



Working with Drawing Tools
The drawing tools enable you to create regular shapes in an
image, such as a rectangle, rounded rectangle, ellipse, polygon,
line, or custom shape. When you draw a shape, Photoshop by
default places the shape on its own layer in the image, so refer
to Chapter 8 if you have a question about working with layers.

Drawing a Line
As you might expect, you use the Line tool to draw lines. The
following steps explain how to use that tool. 

1. Right-click on the Rectangle
(or Rounded Rectangle) tool in
the toolbox. Its shortcut menu
will appear.

2. Click on Line Tool. The Line
tool will become the active tool.
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NOTE
The Pen tool is for creating paths, not drawing lines.
Chapter 10, “Using Paths,” explains how to work with
paths.



3. Choose the desired settings in the options bar. Your
selections will become the active settings for the tool.

4. Select the foreground
color using the method of
your choice. The color you
select will become active for
the Line tool.

5. Drag on the picture in the
work area. Keep the mouse
button pressed as you drag in
any desired direction. When you
release the mouse button, the
finalized line will appear.
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TIP
Click on the Fill pixels
button on the options bar
if you want to place the
drawing on the
background layer rather
than on a new layer in
your image. Otherwise,
leave the Shape layers
button selected. If you
instead click on the Paths
button, Photoshop will
create a path and not a
line. (You can find these
buttons together in a
group near the left end of
the options bar.) Chapter
10, “Using Paths,”
explains what paths are
and how to use them. 



Drawing a Rectangle, Oval, or Other
Shape
As you may have noticed from the preceding set of steps, the
shape tools are grouped with the Line tool on the Photoshop
toolbox. The following set of steps demonstrates how to use
one of the shape tools. (They all basically work in the same
way.)

1. Right-click on the Rectangle (or Rounded Rectangle) tool
in the toolbox. Its shortcut menu will appear.

2. Click on the desired shape
tool to use in the submenu. The
selected tool becomes the active
tool.
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3. Choose the desired settings
in the options bar. Your
selections will become the active
settings for the tool.

4. Select the foreground
color using the method of
your choice. The color you
select will become active for
the tool, and will become the
fill color for the drawn object.

5. Drag diagonally on the
picture in the work area. Keep
the mouse button pressed as
you drag in any desired
direction. When you release the
mouse button, the finalized
shape will appear.
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NOTE
If you choose Custom
Shape Tool, be sure to use
the Shape drop-down list
on the options bar to
specify which kind of
shape to draw. Again,
leave the Shape layers
button selected unless
you want to add the shape
to the current layer
(whether it’s the
background layer or
another layer).



Adding Text
Photoshop allows you to embellish any image with fun or
descriptive text. The text you create appears on a new layer in
the image. Photoshop 7.0 now offers additional tools, such as a
spell checker and a find and replace feature, to enable you to
fine tune the text in your image.

Creating the Text Layer
You use the Type tool and the options bar to add text to an
image. In this case, the options bar gives you a number of
choices to customize the text for fun and interesting text
treatments in an image.

1. Click on the Horizontal Type (or Vertical Type) tool in the
toolbox. It will become the active tool.

2. Select the desired
foreground color using the
method of your choice. The color
you select will become active for
the tool, and will become the fill
color for the text.
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NOTE
To switch between
horizontal and vertical
type, right-click on the
currently selected Type
tool, and then click on the
desired option.



3. Drag diagonally on the
image in the work area. This
defines the area that will hold
the text.

4. Choose the desired settings in the options bar. Your
selections will become the active settings for the tool.

5. Type the desired text. Your
text will appear in the text box.

6. Click on the Create Warped
Text button on the options bar.
The Warp Text dialog box will
open.

80 CHAPTER 3:  ADDING CONTENT WITH TOOLS

TE
AM
FL
Y

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Team-Fly® 



7. Click on the down arrow
next to the Style list. The
available styles for warping
(bending) text will appear.

8. Click on the desired warp
style. The list will close, and the
settings for the selected style
will appear.

9. Select the desired options.
The text in the image will
preview your choices.

10. Click on OK. The Warp
Text dialog box will close.
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11. Click on the Commit Any Current Edits (check) button
on the options bar. Photoshop will insert the text on its new
layer.

Spell-Checking the
Text
You’ll be investing a lot of time
to add professional polish to the
images you create and edit in
Photoshop. To ensure you put
your best foot forward in your
work, you can spell-check the
text that you’ve included in the
image to ensure its accuracy.
Follow these steps to spell-check
text.

1. Click on the text layer in the
Layers palette. It will become the
active layer.
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NOTE
If you later edit text that
you’ve warped, keep in
mind that you may have to
adjust the warp settings
based on the new text
contents. You can use the
Create Warped Text
button on the options bar
to redisplay the Warp Text
dialog box after you’ve
edited the text. 



2. Click on Edit. The Edit menu
will appear.

3. Click on Check Spelling. The
Check Spelling dialog box will
open and display the first word
not found in the spell checker’s
dictionary.

4a. Click on the replacement to use in the Suggestions list.
The replacement word will be selected.

4b. Click on Change. The spell
checker will replace the word in
the image file.

OR

4c. Click on Ignore. The spell
checker will skip the word
without replacing it.

5. Repeat Step 4 as needed.
The spell-checking will continue
until the spell checker finds no
additional unrecognized words,
at which point it will display a
message telling you that the
spell check is complete. 

83ADDING TEXT



6. Click on OK. The Check
Spelling dialog box will close.

Finding and Replacing Text
Just as you can repeatedly refine the color and other aspects
of an image, you can refine the words you’ve chosen for the
text in an image file. Photoshop 7.0 now includes a find and

replace feature to enable you to
update the text in an image with
precision. Follow these steps to
perform a find and replace.

1. Click on the text layer in the
Layers palette. It will become the
active layer.

84 CHAPTER 3:  ADDING CONTENT WITH TOOLS



2. Click on Edit. The Edit menu
will appear.

3. Click on Find and Replace
Text. The Find And Replace Text
dialog box will open.

4. Type the word or phrase to
replace in the Find What text
box. The text will appear in the
text box.

5. Type the new word or
phrase to use in the Change To
text box. The replacement text
will appear in the text box.

6. Click on Find Next. The find
and replace feature will find the
first instance of the word or
phrase and highlight it in the
text.
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7. Click on Change. The find
and replace feature will replace
the selected word or phrase with
the replacement word or phrase,
and then look for the next
instance of the word or phrase in
the text.

8. Repeat Steps 6 and 7 as
needed. The find and replace
operation will continue until it
finds no additional instances of
the word or phrase, at which
point it will display a message
telling you that no more matches
were found. 

9. Click on OK. The Find And
Replace Text dialog box will
close.
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Adding a Note
If you want to add information to an image that others can read
in the file, but that won’t print along with the image, add a
note. These steps detail the process for adding and working
with notes.

1. Click on the Notes tool in
the toolbox. It will become the
active tool.

2. Click on the image in the
location where you want the
note to appear. A blank note
box will open.

3. Type the note text. It will
appear in the box.

4. Click on the small Close box
in the upper-right corner of the
note. The note box will close and
a note icon will appear on the
image.
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5. Click on another tool. The Notes tool will be deselected,
so you don’t accidentally add another note.

6. Right-click on the note icon. Its shortcut menu will appear.

7. Click on Delete Note. A message box will open, prompting
you to confirm the deletion.

8. Click on OK. Photoshop will
delete the note from the image.
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TIP
Double-click on a note
icon to open the note at
any time. Click on the
small close box in the
upper-right corner of the
note when you finish
reading it. Be sure to then
choose a tool other than
the Notes tool before
continuing. Otherwise, the
Notes tool remains active. 



Creating or Displaying a Brush
Photoshop 7.0 enables you to create your own custom brushes,
giving you maximum creative power for editing and developing
image files. This section looks at how to create your own
brushes and how to use the new Brushes palette to find and
work with available brushes. 

Sampling a New Brush
The fastest way to create a new brush is to base it on a shape
available in your image. To sample a brush, you have to select a
portion of the image on a layer. Chapter 5, “Selecting Image
Content,” will explain in detail how to make selections. You can
refer to that chapter if you need help with Step 1 here. The
following steps show you how to create your own brush in
Photoshop.

1. Select the image content to
save as a new brush shape. The
selection marquee will appear in
the image.
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2. Click on Edit. The Edit menu
will appear.

3. Click on Define Brush. The
Brush Name dialog box will
open.

4. Type a brush name. The
name will appear in the Name
text box.

5. Click on OK. The brush will
be created and will be included
in the Brush drop-down list on
the options bar choices for
painting tools.
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Opening the Brushes Palette
Photoshop 7.0 offers a new Brushes palette that you can use to
work with available brushes, including custom brushes that
you’ve created. You can use one of two methods to open (or
hide) the Brushes palette.

1a. Click on Window. The
Window menu will appear.

OR

1b. Click on Brushes. The
Brushes palette will open in its
own window (or close).

2. Click on the Toggle the
Brushes Palette button at the
right end of the options bar
when a painting tool has been
selected. The Brushes palette
will open in its own window (or
close).
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Deleting a Brush
You may create a brush and find that it doesn’t offer the effect
you had hoped for. In such an instance, you can delete the
brush so that it no longer takes up space among the brush
choices. Follow these steps to use the Brushes palette to
delete a brush.

1. Scroll down to view
additional brushes, if needed.
You will see the brush to delete
among the choices.

2. Click on the brush to delete.
It will be selected.

3. Click on the Delete Brush
button near the lower-right
corner of the Brushes palette. A
message will appear to prompt
you to confirm the deletion.

4. Click on OK. The brush will
be deleted.
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Using a Custom Brush
Using a custom brush shape works just like using any other
brush shape provided with Photoshop. This final set of steps
shows an example custom brush, not to teach you again how to
select a brush, but instead to show you how cool a custom
brush can be and to get you excited about the possibilities in
your own work. The following steps show an example of using
a custom brush based on the shape of a daffodil.

1. Click on the Paintbrush tool
in the toolbox. It will become the
active tool.
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TIP
As on other palettes, the Brushes palette features a
menu that you can display if you click the button with the
right triangle near the upper-right corner of the palette.
You can use the choices on the menu that appears to
create, rename, and otherwise work with brushes. The
menu also offers a variety of additional brush collections
that you can select and display in Photoshop.



2. Open the Brush drop-down
list on the options bar, click on
the custom brush to use, then
close the drop-down list. The
custom brush you selected will
become the active brush shape. 

3. Select the foreground color
using the method of your choice.
The color you select will become
active for the Paintbrush.

4. Click on the picture in the
work area. Each time you click, a
paint stroke in the shape of the
brush will appear.

94 CHAPTER 3:  ADDING CONTENT WITH TOOLS

TIP
Custom brushes typically
appear at the bottom of
the list of brush choices.



As you’re working with your image, you may need to zoom in to
make minute changes, zoom out to see how your image looks
overall, and otherwise move around to ensure you’re working with
just the image area that you need. Photoshop offers a number of
techniques that you can use to change your view of the image. In this
chapter, you will master the following skills:

Zoom in and out on an image

View the actual pixel size or print size

Zoom the image to the screen

Scroll with the scroll bar

Move around with the Hand tool and Navigator
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Using the Zoom Tool
You may have worked with a zoom tool in another program,
clicking on a file to zoom in and then clicking again to zoom
back out. Photoshop’s Zoom tool offers the same behavior,
plus some additional features to help you quickly display an
image in the view that works best. Note that zooming merely
adjusts the size of the image file onscreen so that you can work
more effectively. Zooming does not adjust the dimensions of
the file itself, and therefore does not affect the size at which
the file prints. 

Zooming In and Out
The most common zoom operations are to zoom in (get a
closer view of the image) and to zoom out (get a further, more
overall view of the image). The steps here illustrate these
common uses for the Zoom tool. 

1. Click on the Zoom tool in
the Photoshop toolbox. The
mouse pointer will change to a
magnifying glass, and the
options bar will show the options
for the Zoom tool.

2. Click on the image, near the
spot that you want to magnify.
Each time you click with 
the default zoom pointer 
(a magnifying glass with a plus
sign in it), Photoshop will zoom
in on the image by one zoom
increment.
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3. Press and hold the Alt key,
and then click on the image.
Photoshop will zoom out by one
zoom increment each time you
Alt+click with the mouse pointer
for zooming out (a magnifying
glass with a minus sign).
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NOTE
The remainder of the
book will use the phrase
Alt+click to indicate when
you should press and hold
the Alt key while clicking
on a screen item. 

NOTE
The View menu also offers
a number of zooming
commands: Zoom In,
Zoom Out, Fit on Screen,
Actual Pixels, and Print
Size.



Zooming to Print and Pixel Size
You also can use the Zoom tool to zoom the image to one of
two predetermined sizes: its pixel size (100%) or the actual
print size (if you’ve used the Page Setup commands to change

the size for the printout). You’ll
learn about these two zoom
types next. 

1. Click on the Zoom tool in
the Photoshop toolbox. The
mouse pointer will change to a
magnifying glass, and the
options bar will show the options
for the Zoom tool.

2. Click on Resize Windows To
Fit on the options bar.
Photoshop will check the check
box. When checked, Resize
Windows To Fit will change the
window size to accommodate
the zoomed image. Also leave
Ignore Palettes unchecked. (It
should be unchecked by default.)
Ignore Palettes turns off color
palette features that may change
the image’s appearance as you
zoom.
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3. Click on Actual Pixels on the
options bar. Photoshop will
zoom the image to 100% size
(the actual pixel size).

4. Click on Print Size on the
options bar. Photoshop will
zoom the image to the actual
size it will be when printed.
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TIP
Double-clicking on the
Zoom tool in the toolbox
also zooms to 100% size.



Fitting the Image to the Screen
To take advantage of all the workspace available in Photoshop,
you can zoom the image to the screen size using the Zoom
tool, as explained here. 

1. Click on the Zoom tool in
the Photoshop toolbox. The
mouse pointer will change to a
magnifying glass, and the
options bar will show the options
for the Zoom tool.

2. Click on Resize Windows To Fit on the options bar.
Photoshop will check the check
box. When checked, Resize
Windows To Fit will change the
window size to accommodate
the zoomed image. Also leave
Ignore Palettes unchecked. (It
should be unchecked by default.)
Ignore Palettes turns off color
palette features that may change
the image’s appearance as you
zoom.

3. Click on Fit On Screen.
Photoshop will zoom the image
to the largest zoom setting it can
have and fit on the screen.
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Changing the View Zone
If you did not opt to resize the image window as you zoomed,
zooming in on the image may magnify it to such a size that the
image can’t fully display in the image window. When this
happens, you can use a few different methods to choose which
area of the image appears in the image window, thus enabling
you to view and work with that portion of the image. This
section explores those methods: scroll bars, the Hand tool, and
the Navigator.

Using Scroll Bars
Scroll bars appear whenever you’ve resized the image window
so that it can’t display all of the image. When this happens, you

use the scroll bars as described
next to scroll the portion of the
image that you’d like to work
with into view. 

1. Click on a scroll arrow on
either the vertical or horizontal
scroll bar. Each time you click,
Photoshop will scroll the image
by a small increment.
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TIP
While the Zoom tool is active, you also can right-click on
the image to see a shortcut menu with commands for
zooming the image.



2. Drag a scroll bar box.
Photoshop will scroll the image
much more quickly.

3. Click on the scroll bar itself
above or below the scroll box.
Depending on the scroll bar and
side of the scroll box on which
you click, Photoshop scrolls the
image as far as possible in the
designated direction. 

Using the Hand Tool
You can use the Hand tool to scroll the image in multiple
directions at once—much like using both scroll bars
simultaneously. The following steps explain how to do so. 

1. Click on the Hand tool on
the toolbox. The mouse pointer
will change to a hand pointer.

2. Drag the image with the
hand pointer. Photoshop will
scroll the image in the same
direction that you drag.
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Using the Navigator
You can use the Navigator palette for multiple purposes—to
change the image zoom and to scroll the displayed portion of
the image. These steps describe both uses for the palette.

1. Click on the Navigator tab
in the Navigator palette, if
needed. The Navigator tab will
become active.

2. Drag the zoom slider in the
Navigator palette. Photoshop
will zoom the image to the
specified size.

3. Drag the red box on the
image thumbnail in the
Navigator palette with the hand
pointer. Photoshop will scroll the
image to display the portion of
the image bounded by the red
box in the thumbnail.
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NOTE
You also can type a zoom
percentage into the text
box on the Navigator
palette and then press
Enter, or click on one of
the buttons at either end
of the zoom slider in the
Navigator palette to
change the zoom.
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Precision image editing requires making precision selections. Before
you can delete, move, fill, or replace part of an image, you have to
select the portion of the image with which you want to work.
Photoshop offers a number of selection tools that you can use to
zero in on an area to edit with precision and control. This chapter
teaches you how to:

Select rectangular or oval shapes

Make an irregular selection

Select by color

Add or remove part of the selection

Cancel the selection
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Using the Marquee Tool
The Marquee tool appears in the upper-left corner of the
Photoshop toolbox. Use the Marquee tool to make selections
that are regular in shape—rectangles, squares, ovals, circles, or
one-pixel borders (also called a row or column selection). 

Selecting a Rectangle
The steps here show you how easy it is to make a selection
that’s rectangular in shape. 

1. Right-click on the Marquee
tool in the Photoshop toolbox.
The shortcut menu for the
Marquee tool will appear.

2. Click on Rectangular
Marquee Tool. The Rectangular
Marquee tool will become active.
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NOTE
If the area to select appears on a particular layer, you
need to select that layer in the Layers palette before
using any type of tool to make the selection. See
Chapter 8, “Working with Layers” to learn more about
selecting layers.



3. Click on the New Selection button on the options bar, if
needed.

4. Make an entry (in pixels, up
to 250) in the Feather text box
on the options bar. The
feathering setting will become
active.

5. Click on the down arrow next to the Style drop-down list.
The list will appear. 

6. Click on Normal. The normal selection method will become
active.

107USING THE MARQUEE TOOL

TIP
Feathering blurs the
edges of the selection.
The results of feathering
become more apparent if
you copy and paste the
selection.

NOTE
If you choose the Fixed Aspect Ratio or Fixed Size
choices from the Style drop-down list, the Width and
Height text boxes become active. Make an entry in one
of the text boxes (for Fixed Aspect) or both text boxes
to specify a selection size, and then click on the image to
make the selection.



7. Drag on the image over the
area to select. (Press and hold
Shift as you drag to select a
perfect square.) The selection
marquee will appear on the
image.

Selecting an Ellipse
If you instead need to make a round or elliptical selection, you
can use the following steps to do so. 

1. Right-click on the Marquee
tool in the Photoshop toolbox.
The shortcut menu for the
Marquee tool will appear.

2. Click on Elliptical Marquee
Tool. The Elliptical Marquee tool
will become active.
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3. Click on the New Selection button on the options bar, if
needed.

4. Make an entry (in pixels, up
to 250) in the Feather text box
on the options bar. Leave the
Anti-aliased check box checked.
The feathering setting will
become active.

5. Click on the down arrow next to the Style drop-down list.
The drop-down list will appear. 

6. Click on Normal. The normal selection method will become
active.
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TIP
Anti-aliasing fixes
jaggedness along the
edges of a selection,
which occurs when the
selection marquee has
curves.

NOTE
Again, choosing the Fixed Aspect Ratio or Fixed Size
choices from the Style drop-down list activates the
Width and Height text boxes. 



7. Drag on the image over the
area to select. (Press and hold
Shift as you drag to select a
perfect circle.) The selection
marquee will appear on the
image.

Selecting a Row or Column
Use the Single Row Marquee tool or the Single Column
Marquee tool to select a one-pixel-wide area in the image. You
can then cut or copy and paste the selection to use it as a
border in another image.

1. Right-click on the Marquee
tool in the Photoshop toolbox.
The shortcut menu for the
Marquee tool will appear.

2. Click on Single Row
Marquee Tool or Single Column
Marquee Tool. The specified
marquee tool will become active.
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3. Click on the New Selection
button on the options bar, if
needed.

4. Click on the image over the
area to select as a border. The
selection marquee will appear on
the image.

Using the Lasso Tool
Like the Marquee tool, the Lasso tool offers a few different
techniques you can employ to make selections in an image. The
Lasso tool’s variations enable you to make selections that are
not typical or symmetrical in shape. You can select an irregular
area by dragging (Lasso tool), select a polygon by clicking to
place the angles (Polygonal Lasso tool), or get help selecting an
irregular area (Magnetic Lasso tool).
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NOTE
Because Photoshop operates primarily as a paint
program, you may find that you can’t separate out an
area that you’d like to select, no matter which selection
technique you use. That’s why you retain more editing
flexibility in an image if you place the objects for the
image on various layers. See Chapter 8, “Working with
Layers” to learn how to create and use layers.



Selecting an Odd Shape
You can use the Lasso tool to
drag around selections that are
irregular in shape, but don’t
necessarily have a lot of angle
points. (If the shape does have a
lot of angles or corners, consider
using the Polygonal Lasso tool,
described next.) 

1. Right-click on the Lasso tool
in the Photoshop toolbox. The
shortcut menu for the Lasso tool
will appear.

2. Click on Lasso Tool. The
Lasso tool will become active.

3. Click on the New Selection button on the options bar, if
needed.

4. Make an entry (in pixels, up
to 250) in the Feather text box
on the options bar. Leave the
Anti-aliased check box checked.
The feathering setting will
become active.

5. Drag around the desired
area to select it; drag all the way
back to the starting point or
release the mouse button to
close the selection. The selection
marquee will appear on the
image.
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Selecting a Polygon
Use the Polygonal Lasso tool to select odd shapes that have
corners and angles, as the following steps demonstrate. 

1. Right-click on the Lasso tool
in the Photoshop toolbox. The
shortcut menu for the Lasso tool
will appear.

2. Click on Polygonal Lasso
Tool. The Polygonal Lasso tool
will become active.

3. Click on the New Selection button on the options bar, if
needed.

4. Make an entry (in pixels, up
to 250) in the Feather text box
on the options bar, and leave the
Anti-aliased check box checked.
The feathering setting will
become active.

5. Click around the desired
area to specify corners for the
selection; double-click the last
point to close the selection. The
selection marquee will appear on
the image.
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Using the Magnetic Lasso
The Magnetic Lasso tool helps you make a selection by
snapping to fastening points along the edge of a shape in an
image.

1. Right-click on the Lasso tool in the Photoshop toolbox.
The shortcut menu for the Lasso tool will appear.

2. Click on Magnetic Lasso
Tool. The Magnetic Lasso tool
will become active.
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TIP
You can press the Alt key while using either the Lasso
tool or the Polygonal Lasso tool to switch between
freehand drawing and clicking to set corner points. Press
Delete while using any Lasso tool to remove the most
recently drawn selection segment.



3. Click on the New Selection button on the options bar, if
needed.

4. Change other settings on the
options bar as needed:

• Make an entry (in pixels, up
to 250) in the Feather text
box on the options bar, and
leave the Anti-aliased check
box checked. The feathering
setting will become active.

• Change the Width text box
entry (in pixels, between 1
and 40) to set the search
width for the tool. The tool
will look for edges within the
specified zone beside the
points you identify with the
mouse.

• Change the Edge Contrast
text box entry (in percentages
between 1 and 100) to identify
how much contrast the tool
requires. A lower setting will
enable the tool to find edges
with less contrast, whereas a
higher setting will restrict the
tool to finding only high-
contrast edges.

• Change the Frequency text
box entry (between 0 and 100)
if needed. A higher setting
causes the tool to set more
fastening points, whereas a
lower setting results in fewer
fastening points.
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5. Drag and click on the
desired area to specify the
selection border. (Click to place
a fastening point in a particular
location.) The selection marquee
will appear on the image.

Selecting Pixels with the 
Magic Wand
If all the pixels in the area that you want to select are about the
same color and adjoin one another in the image, you can use
the Magic Wand tool to select the area by clicking.

1. Click on the Magic Wand
tool in the Photoshop toolbox.
The Magic Wand tool will
become active.
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2. Click on the New Selection button on the options bar, if
needed.

3. Change other settings on the
options bar as needed:

• Change the Tolerance text
box entry (between 0 and
255) to specify how much
variation can occur between
the colors included in the
selection. A low entry will
result in a smaller selection
zone composed of fewer like
colors, whereas a higher entry
will result in a larger selection
zone.

• Leave the Anti-aliased check
box checked. The tool will
smooth the edges of the
selection.

• Leave the Contiguous check
box checked. The tool will
select all adjoining pixels of
the same (or similar) color, not
just the pixel on which you
click.

• Click on the Use All Layers
check box to check it if
desired. The tool will then
select the matching colors on
all layers in the picture.
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4. Click on the color to select
on the image with the Magic
Wand tool. The selection
marquee will appear on the
image.

Selecting by Color Range
Selecting by color works somewhat like the Magic Wand tool,
except it enables you to select all the pixels of the specified
color in the image—not just adjoining or contiguous pixels.

1. Click on Select. The Select menu will appear.

2. Click on Color Range. The
Color Range dialog box will
open.
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3. Click on the down arrow
beside the Select list. The Select
list will open.

4. Click on a selection type in
the list. If you choose anything
other than Sampled Colors from
the list, Photoshop immediately
previews the color selection in
the dialog box, and you can skip
to Step 8. If you choose Sampled
Colors, continue with the next
step.

5. Drag the Fuzziness slider to
change its setting, if needed.
Increasing this value will cause
Photoshop to select colors
similar to the color you select for
the match.

6. Click on the Eyedropper
Tool button to select it, if
needed. The Eyedropper tool will
become active.

7. Click on the desired color in
the picture. If you choose 
anything other than Sampled
Colors from the Select list,
Photoshop immediately previews
the color selection in the dialog
box.
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8. Click on OK. The dialog box
will close and Photoshop will
display marquees around the
matching selections in the
picture.

Adjusting a
Selection
Once you’ve made a selection, you can change it, extend it, or
otherwise work with it. The following steps run through the
possibilities for modifying a selection.

1. Drag from the center of the
selection with the mouse pointer
that looks like an arrow plus a
box. The selection will move to
another location.
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NOTE
To add or remove colors
from the selection, click
on either the Add to
Sample or Subtract from
Sample button (next to
the Eyedropper Tool
button), and then click a
color on the image.

NOTE
Pressing an arrow key
moves the selection by
one pixel in the specified
direction.
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2. Click on the Add
To Selection, Subtract from
Selection, or Intersect
with Selection button on the
options bar, if available for the
active selection tool. The
selection tool will begin to use
the specified selection method.

3. Click or drag on the image
as required for the active
selection tool. Depending on the
selection method selected in
Step 2, Photoshop adds to,
removes from, or crops out the
selection.

121ADJUSTING A SELECTION

TIP
You also can press Shift and then use a selection tool to
add a selection.

TIP
To remove the latest selection you’ve added, don’t press
Delete! Press Ctrl+Z to undo the selection, instead.



4. Click on Select. The Select
menu will appear.

5. Click on Inverse. Photoshop
will select the area that
previously was not selected in
the image, and deselect the area
that was selected.

Removing a Selection
When you need to remove or deselect the selection, you can
do so with ease.
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NOTE
You also can right-click on
a selection and then click
on Save Selection to save
a selection as a new
channel in the image. See
“Saving a Selection” and
“Loading a Selection” in
Chapter 6, as well 
as Chapter 15,
“Understanding Colors
and Channels.”



1. Click on Select. The Select
menu will appear.

2. Click on Deselect.
Photoshop will remove the
selection immediately, no matter
what selection tool or method
you used to make the selection.

3. Click on the New Selection button on the options bar. This
will ensure that you can remove the selection.

4. Click on the gray area within
the image window, if it appears.
Photoshop will remove the
selection immediately, if you’re
using the Rectangular Marquee,
Elliptical Marquee, or Lasso tool.
(Follow Steps 1 and 2 to remove
selections created with the other
selection tools; for some tools,
like the Polygonal Lasso, clicking
in the gray area begins another
selection.)

123REMOVING A SELECTION



5. Click on Select. The Select
menu will appear.

6. Click on Reselect.
Photoshop will reinstate the
selection.
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After you’ve selected part of the image, the fun begins. You can
then start manipulating the selection to change the appearance of
the image or share information between image files. This chapter
introduces you to the basic changes you can make once you’ve
selected part of the information on a layer in the image. (Chapter 8,
“Working with Layers,” explains how to layer information.) When you
finish this chapter, you’ll know how to:

Delete, move, or copy what you’ve selected

Change a selection by transforming or rotating it

Fine-tune the selection marquee

Save and reuse a selection

Undo a change

Work with the History palette
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Deleting a Selection
In the last chapter, you learned that you can press the Delete
key while you’re creating a selection using the Lasso tool to
remove the most-recently-added segment. Pressing Delete has
a different effect once you’ve finished the selection—it clears
the content within the selected area. The steps that follow
describe how to clear or delete the content in a selected area. 

1. Make a selection in the
image using the selection tool of
your choice. The selection
marquee will appear.
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2. Click on Edit. The Edit menu
will appear.

3. Click on Clear. The selection
will disappear completely from
the current layer.

Moving a Selection
Moving a selection requires a tool you haven’t used yet—the
Move tool. Trying to drag while the selection tool you used is
active moves the selection marquee only, not the actual image

content within that selection. No
matter which layer you’re
working on or what type of
content you’re dealing with, the
Move tool always works in the
same way.

1. Make a selection in the
image using the selection tool of
your choice. The selection
marquee will appear.
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TIP
You can press the Delete
key in place of Steps 2
and 3.



2. Click on the Move tool on
the Photoshop toolbox. The
Move tool will become active.

3. Click on the desired options
in the options bar to check them
as needed. If you check Auto
Select Layer, clicking on an area
of the image will select its layer.
If you check Show Bounding Box,
the selection box may change to
show handles.

4. Drag the selection from
within the marquee. The
selection will move as you draw
and will appear in its final
location when you release the
mouse button.
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NOTE
If other buttons become active on the options bar,
clicking one of them aligns information within the
selection marquee, such as text, relative to the borders
of the selection marquee.



Copying a Selection
You can copy a selection to re-use it in another location, such
as on another layer in the image file or in a completely new file.
This comes in handy, because once you’ve drawn or scanned in
image content, you can reuse it as often as you need to with a
minimum of effort. This example illustrates how to create a new
image file from content that you copy.

1. Make a selection in the
image using the selection tool of
your choice. The selection
marquee will appear.

2. Click on Edit. The Edit menu
will appear.

3. Click on Copy. Photoshop
will copy the selection to the
Windows Clipboard, a memory
holding area.
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NOTE
Rather than starting a new image at this point, you could
switch to another open image file. If you choose to do
that, jump to Step 8.



4. Click on File. The File menu
will appear.

5. Click on New. The New
dialog box will open.

6. Change the New dialog box
settings as needed. The changes
you make will affect the size of
the new image. You may not
need to change the Width and
Height entries; typically, those
will reflect the size of the copied
selection. (See “Creating a New
File” in Chapter 2 to refresh your
memory about the New dialog
box settings.) 

7. Click on OK. The new image
file will open.
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8. Click on Edit. The Edit menu
will appear.

9. Click on Paste. Photoshop
will paste the copied selection
into the new file.

Transforming a Selection
Photoshop offers a number of transformations you can make to
affect a selection in an image. Table 6-1 reviews the types of
transformations you can make.
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NOTE
Don’t forget to save the
new image file after
you’ve pasted the
selection into it.

Table 6-1 Selection Transformations

Transform Enables you to...

Scale Change the size of the selection while maintaining its vertical-to-
horizontal proportions.

Rotate Change the angle positioning of the selection, such as rotating it 90
degrees in a clockwise direction.

Skew Drag one side of the selection to “angle” the selection, such as
changing a square selection to a slanted square (rhombus).

Distort Drag the corner handle bounding the selection to “stretch” the
selection in multiple directions at once.

Perspective Simultaneously resize opposite (parallel) boundaries of the selection
to achieve one-point perspective.

Flip Flip the selection horizontally or vertically.



1. Make a selection in the image using the selection tool of
your choice. The selection marquee will appear.

2. Click on Edit. The Edit menu will appear.

3. Point to Transform. The
Transform submenu will appear.

4. Click on the desired
transform command. If you
choose Rotate 180°, Rotate 90°
CW (clockwise), Rotate 90° CCW
(counter-clockwise), Flip
Horizontal, or Flip Vertical, the
transformation will appear
immediately. If you choose one
of the other transforms, the
options bar will become active
and special transform handles
will appear around the selection.
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NOTE
To transform text, you just go to the layer that holds the
text; you don’t need to select the text itself. The Distort
and Perspective transformations aren’t available for text.



5. Drag a handle. The
transformation will occur.
Alternately, you can use the text
boxes on the options bar to
enter precise transformation
settings.

6. Click on the Commit Transform (check) button at the right
end of the options bar. Photoshop finalizes the transform.
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TIP
Whenever you see a
Cancel button (a circle
with a slash through it) on
the options bar, you can
click on that button to
cancel the application of
the current command or
tool settings.

NOTE
You also can choose the
Free Transform command
on the Edit menu and then
drag handles on the
selection to transform the
selection.



Modifying Part of the
Selection
The Select menu gives you a number of commands for
adjusting the selection marquee itself. You can use these
features before you use other features for altering a selection
to be sure that you’re working with the proper selection.

Changing the Selection Border
You can add another selection around the current selection
marquee so that the specified area within the two marquees
becomes the selection. You could then remove that selection
or fill it in some way to create a visual border around the
selection.

1. Make a selection in the image using the selection tool of
your choice. The selection marquee will appear.

2. Click on Select. The Select
menu will appear.

3. Point to Modify. The Modify
submenu will appear.

4. Click on Border. The Border
dialog box will open.
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5. Type a new entry (between
1 and 64 pixels) for the Width
text box. The entry will appear
in the text box.

6. Click on OK. The dialog box
will close, and the new border
selection will appear.

Smoothing the Selection
If you’ve selected by choosing a color (as described under
“Selecting by Color Range” in Chapter 5), your selection may
end up with some stray pixels that are surrounded by a
selection marquee. Or, if you’ve used a lasso tool, the selection
might be a bit more jagged in shape than you now wish. To
simplify the selection in such instances, you can smooth the
selection.
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NOTE
Use the Fill and Stroke commands on the Edit menu to
fill in the selected border.



1. Make a selection in the image by using a color selection
method or by using a lasso tool. The selection marquee or
marquees will appear.

2. Click on Select. The Select
menu will appear.

3. Point to Modify. The Modify
submenu will appear.

4. Click on Smooth. The
Smooth Selection dialog box will
open.

5. Type a new entry (between
1 and 16 pixels) for the Sample
Radius text box. The entry will
appear in the text box.

6. Click on OK. The dialog box
will close, and Photoshop will use
the radius setting you entered to
add pixels to and eliminate them
from the selection.
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Photoshop treats each pixel in
the selection as the center of a
circle, with a radius of the width
you specified. Depending on
whether most of the pixels in the
circle are selected, Photoshop
will add pixels to the selection (if
most are selected) or remove
them from the selection (if most
aren’t selected).

Expanding or Contracting the
Selection
Expanding or contracting the selection really moves the
selection marquee rather than affecting the selection itself.
Using this method provides more accuracy than dragging or
using a color technique like smoothing to increase the size of
the selection, because you specify exactly how many pixels to
add or remove from the selection, in terms of height and width.
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NOTE
You also can use the Grow and Similar commands on the
Select menu to expand a selection that you’ve made by
color. The Grow command adds pixels adjoining the
current selection that have similar colors to the selection,
whereas Similar adds pixels of similar colors from the
entire image to the selection.



1. Make a selection in the image using the selection tool of
your choice. The selection marquee will appear.

2. Click on Select. The Select menu will appear.

3. Point to Modify. The Modify
submenu will appear.

4. Click on Expand or Contract.
The Expand Selection or
Contract Selection dialog box
will open.

5. Type a new entry (between 1 and 100 pixels) for the
Expand Selection text box. The entry will appear in the text
box.

6. Click on OK. The dialog box
will close, and the new border
selection will appear.
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NOTE
You can use the Feather
command on the Select
menu to feather or soften
the edge of the selection.
This affects the selection if
you copy or paste it, or
apply another effect like a
filter.



Saving a Selection
When you save a selection, you give it a name in the Photoshop
file. Then, you can easily load the selection in the future. This
enables you to repeatedly select exactly the same pixels—
which is tough no matter which selection technique you
originally used to make the selection.

1. Make a selection in the image using the selection tool of
your choice. The selection marquee will appear.

2. Click on Select. The Select menu will appear.

3. Click on Save Selection. The
Save Selection dialog box will
open.
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4. Click in the Name text box,
then type a name for the
selection. The name will appear
in the text box.

5. Click on OK. The Save
Selection dialog box will close,
and the saved selection will be
added to the file.

Loading a Selection
When you need to apply a selection that you’ve previously
saved—that is, to reselect a previous selection—you can load
the selection.
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NOTE
Be sure to save the file to
save the named selection.
Also note that saving the
selection creates a new
channel from the
selection. Chapter 15,
“Understanding Colors
and Channels,” explains
how to work with
channels.
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1. Click on Select. The Select
menu will appear.

2. Click on Load Selection. The
Load Selection dialog box will
open.

3. Click on the down arrow next to the Channel box. The list
of saved selections will appear.

4. Click on the desired
selection. It will appear as the
Channel selection.

5. Click on OK. The Load
Selection dialog box will close,
and the selection marquee will
appear in the file.
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Undoing a Change
The Edit menu offers a number of commands that you can use
to undo prior changes and actions, such as deselecting a
selection.

1. Click on Edit. The Edit menu
will appear.

2. Click on Undo (Action
Name). Photoshop will undo
your most recent change or
action.

3. Click on Edit. The Edit menu
will appear.

4. Click on Step Backward.
Photoshop will undo your next
most recent change or action.
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5. Click on Edit. The Edit menu
will appear.

6. Click on Step Forward.
Photoshop will redo the change
or action you undid by stepping
forward.

Using the History to Undo
Changes
The History palette provides one last method for discarding
(undoing) actions and changes to a selection that you’ve made
previously. When you use the History palette, you select a
change or action out of the sequence of actions you’ve
performed during the current work session with the image file.
When you remove that selected action or change, Photoshop
undoes that action or change, plus all the changes below it in
the History list.
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NOTE
You should only use the Undo command once. After
that, use the Step Backward command (described in
Steps 3 and 4) as many times as needed to step further
backward through your changes. Use the Step Forward
command (as in Steps 5 and 6) to step further forward.
To redo a single change, click on Redo (Action Name) in
the Edit menu.



1. Click on Window. The
Window menu will appear.

2. Click on History. The History
palette will open.

3. Click on the down scroll
arrow for the scroll bar in the
History palette. The list of
changes and actions in the
History list will scroll down.

4. Right-click on the change or
action to undo in the list. The
shortcut menu will appear.

5. Click on Delete. A message
box asking you to confirm the
History deletion will open.
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6. Click on Yes. Photoshop will
close the dialog box and undo
the specified change and
changes below it in the History
palette.

7. Click on Window. The
Window menu will appear.

8. Click on Layers. The Layers
palette choices will reappear in
the palette window. 
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Photoshop provides more precision editing tools than perhaps any
other graphics program. Now that you know how to select and move
image content, you may want to try out tools that you can exploit to
align selections perfectly. Before you start making many moves in
your image files, review this chapter to learn the following skills:

Displaying a grid you can use for alignment

Displaying rulers you can use for alignment

Snapping a selection to a guide or grid

Adding custom alignment guides and locking them in place

Building presets to customize tools
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Showing and Hiding the Grid
You can display non-printing gridlines in the current image
window, and then use those gridlines to help you align
selections in the image. You can show and hide the grid as
needed, turning it on to position selections, and turning it back
off when you want to assess the image’s background or overall
appearance. See the “Guides, Grid & Slices” section in
Appendix B to learn about setting grid preferences.

1. Click on View. The View
menu will appear.

2. Point to Show. The Show
submenu will appear.

3. Click on Grid. The gridlines
will appear immediately in the
current image file.
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NOTE
Remember, you have to be working on the layer that has
the image content to select. Chapter 8, “Working with
Layers,” explains how to navigate to and use layers. In
some cases, you can choose the layer and then use the
Move tool to move the layer contents without making a
selection.



4. Make a selection (if needed)
and align it using the Move tool.
The selection will be better
aligned with a gridline.

5. Click on View. The View
menu will appear.

6. Point to Show. The Show
submenu will appear.

7. Click on Grid. The gridlines
will disappear immediately from
the current image file.
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NOTE
If the selection “jumps
around” and won’t align
as you think it should, the
Snap To feature might be
active. See the section
“Using Snap and Snap To”
later in this chapter to
learn how to use this
feature.



Showing and Hiding Rulers
The rulers come in handy when you need to position selections
(such as a logo inserted on a new layer) at a precise location
within the image. Turn on the rulers when you need to position
selections based on measurements, and then turn them back
off when you no longer need them.

1. Click on View. The View menu will appear.

2. Click on Rulers. The rulers
will appear immediately in the
current image window.
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NOTE
The vertical ruler appears along the left side of the
image window, and the horizontal ruler appears across
the top of the ruler.
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3. Make a selection (if needed)
and drag to align it. Watch the
dotted gray lines on the rulers to
judge position as you drag. The
selection will drop into the
specified location when you
finish dragging.

4. Click on View. The View
menu will appear.

5. Click on Rulers. The rulers
will disappear from the image
window.
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TIP
Make your selection tight
to the object, then drag
by a corner for very
precise positioning.



Using Snap and Snap To
The Snap To feature in Photoshop ensures that a selection
aligns to the grid or the custom guides that you add as you
drag. You can turn snapping to grids or guides off and on
individually, or use the Snap command to toggle all snapping
on and off. By default, snapping to both the grid and
guidelines is turned on in Photoshop.

1. Click on View. The View
menu will appear.

2. Point to Snap To. The Snap
To submenu will appear.

3. Click on Guides or Grid. The
check beside the feature you
clicked will be removed, and the
selected Snap To feature will no
longer be active. The next time
you move a selection, it will not
snap into position.
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NOTE
The grid must be displayed to enable the command for
turning on or off snapping to the grid. In contrast, the
command for turning on or off snapping to guidelines is
available whether or not you’ve added guidelines into
the image file, as described in the next section.

NOTE
Turning off snapping can help when you need to position
selections relative to one another rather than relative to
a grid.



4. Click on View. The View
menu will appear.

5. Point to Snap To. The Snap
To submenu will appear.

6. Click on Guides or Grid. A
check will appear beside the
feature you clicked, and the
selected Snap To feature will
become active again. The next
time you move a selection, it will
snap into position.

7. Click on View. The View
menu will appear.

8. Click on Snap. The check
beside the Snap command will
be removed, and all snapping
will no longer be active. The next
time you move a selection, it will
not snap into position.
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9. Click on View. The View
menu will appear.

10. Click on Snap. The check
beside the Snap command will
reappear, and all snapping will
become active again. The next
time you move a selection, it will
snap into position.

Adding Guides
Guides, in a sense, serve as custom gridlines. You put a
guideline into position so that you can align selections to it.
Ideally, you would add a guideline in a location where no
gridline occurs or use guidelines rather than the grid. Also,
because guidelines appear in blue, you can add a guideline to
highlight an important grid location.
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TIP
You don’t have to display the rulers to add guidelines,
but if you do, you can add a guideline more quickly, as
one of the techniques in the steps here demonstrates.



1. Click on View. The View
menu will appear.

2. Click on New Guide. The
New Guide dialog box will open.

3. Click on an Orientation option. Photoshop will use the
specified type of guide.

4. Select the Position text box
contents, and type a new entry.
Photoshop will use the specified
position for the guide.
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TIP
If you include in (for
inches) with the Position
entry, Photoshop uses
inches of measure for
positioning the guideline.
(You also can use cm for
centimeters and pt for
points.) If you don’t
include a measurement
abbreviation, Photoshop
by default assumes you’re
entering a measurement
in pixels (px).



5. Click on OK. The guideline
will appear at the position you
specified.

6. Drag from a ruler. Another
guideline will appear where you
release the mouse button.
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TIP
Press and hold Shift as
you drag to have the
guideline snap to
successive increments on
the applicable ruler.



7. Click on the Move tool in
the Photoshop toolbox. The
Move tool will become active.

8. Drag a guideline. The
guideline will move to a new
location.

9. Click on View. The View
menu will appear.

10. Click on Clear Guides.
Photoshop will immediately
delete all the guidelines you’ve
added.
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Locking Guides
You can lock guides to prevent any accidental guideline
changes. (For example, you could mistakenly move a guideline
rather than the selection, especially when the selection falls
very close to the guideline.) When you need to change
guidelines, unlock them first.

1. Click on View. The View menu will appear.

2. Click on Lock Guides.
Photoshop will immediately lock
the guides into position. A check
mark will appear beside the Lock
Guides command on the menu.
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NOTE
Locking guidelines doesn’t prevent you from clearing
them. If you unintentionally clear guidelines, immediately
undo the change.



3. Click on View. The View
menu will appear.

4. Click on Lock Guides.
Photoshop will immediately
unlock the guides and remove
the check mark beside the Lock
Guides command.

Setting Up Your Tools with the
Preset Palette
In the section in Chapter 3 called “Creating or Displaying a
Brush,” you learned how to create and use your own custom
brush in Photoshop. In addition to creating a custom brush, you
can create a preset. To make a preset, you select a tool,
choose your favorite settings for the tool, and then save the
preset. The preset stores your favorite settings for the tool.
Later, when you load the preset, the tool and specified settings
immediately become active. This section describes how to
create and use presets, as well as how to load additional brush,
color, or pattern choices for your tools using the Preset
Manager.

Saving a Preset
Because Photoshop offers so many tools and settings, you have
nearly unlimited possibilities for editing images. Over time,
however, you’ll probably develop favorite techniques that
involve using a particular tool and particular settings. Rather
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than having to remember the desired tool and all the
associated settings, you can simply save each favorite
combination as a preset using the Tool Presets palette. 

1. Click on the desired tool. Its
options will become active in the
options bar.

2. Choose the desired settings
in the options bar, and choose a
foreground or background
color if needed. Those settings
will become the current settings
for the tool.

3. Click on Window. The
Window menu will appear.

4. Click on Tool Presets. The
Tool Presets palette will open.
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5. Click on the Create New
Tool Preset button at the
bottom of the palette. The New
Tool Preset dialog box will open.

6. Type a name for the preset in the Name text box. The
preset name will appear in the dialog box.

7. Click on the Include Color
check box as needed. When it’s
checked, Photoshop will save the
current color selections along
with the other preset settings.

8. Click on OK. The dialog box
will close and the new preset will
appear in the Tool Presets
palette.
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9. Click on Window. The
Window menu will appear.

10. Click on Layers. The Layers
palette will reappear.

Using a Preset
When you want to use a preset that you’ve created, open the
Tool Presets palette and choose the preset.

1. Open or create the image
where you want to use the
preset. The image window will
become active.
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2. Click on Window. The
Window menu will appear.

3. Click on Tool Presets. The
Tool Presets palette will open.

4. Click on the Current Tool
Only check box at the bottom of
the palette. The check box will
be cleared, and all the available
presets will appear.

5. Scroll down the list of
presets. The desired preset will
appear in the list. 
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6. Click on the preset in the
list. The tool and settings stored
in the preset will become active.

7. Use the tool in the image.
The desired changes will appear
in the image. 

8. Click on Window. The
Window menu will appear.

9. Click on Layers. The Layers
palette will reappear.
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NOTE
To choose presets, you
also can click on the
button for the selected
preset at the left end of
the options bar. A pop-up
list of the presets will
appear. Double-click on
the preset you want to
use to select the preset
and close the list. 



Loading More Options with the Preset
Manager
In addition to the brush shapes and other choices that you
initially see on the options bar when you select a particular
tool, you can load other brush shapes, patterns, and more to
make them available for use in Photoshop. Use the Preset
Manager to load additional tool choices.

1. Click on Edit. The Edit menu will appear.

2. Click on Preset Manager.
The Preset Manager dialog box
will open.

165SETTING UP YOUR TOOLS WITH THE PRESET PALETTE



3. Click on the Preset Type
drop-down list arrow. The
Preset Type list will appear.

4. Click on the desired preset
type. The Preset Manager will
display the currently loaded
selections for the type.

5. Click on the palette menu
button. The menu will appear.

6. Click on the desired preset
library. The Preset Manager will
display a dialog box asking
whether you want to replace or
append the patterns in the
library.
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NOTE
Use the Reset (Type)
command on the palette
menu to return the
available presets for the
preset type to the default
choices.



7. Click on the appropriate button. The presets will be
replaced or appended as indicated:

• OK. Replaces the current
presets with the new presets
from the library selected in
Step 6.

• Append. Adds the presets
from the library selected in
Step 6 to the available
choices.

8. Click on Done. The newly
selected presets will be available
for the appropriate tool(s). 
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Part 2 Review Questions
1. How do you select a tool? See “Selecting a Tool” in Chapter 3.

2. Which are the painting tools, and which are the drawing tools? See
“Working with Painting Tools” and “Working with Drawing Tools” in
Chapter 3.

3. What’s a fast way to change the portion of the image that appears
in the window? See “Using the Hand Tool” and “Using the
Navigator” in Chapter 4.

4. What can you select with the Marquee tool? See “Using the
Marquee Tool” in Chapter 5.

5. What different selections does the Lasso tool offer? See “Using the
Lasso Tool” in Chapter 5.

6. How do you deselect a selection? See “Removing a Selection” in
Chapter 5.

7. How do you delete selected image content? See “Deleting a
Selection” in Chapter 6.

8. Can you reuse a selection? See “Saving a Selection” and “Loading
a Selection” in Chapter 6.

9. What if I need to undo a change? See “Undoing a Change” and
“Using the History to Undo Changes” in Chapter 6.

10. Can Photoshop align selections that I move? See “Using Snap and
Snap To” in Chapter 7.
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The ability to create content on layers has long set Photoshop apart
from other paint programs. Creating content on separate layers
enables you to retain control of the placement and effects for various
individual elements in an image. (If you simply created objects on one
layer in Photoshop, they would “blend” together.) By using
transparency on the various layers and positioning objects carefully,
you can create interesting and complex compositions while keeping
open your options for making changes later. In this chapter, you’ll
learn how to:

Use various methods to create a layer

Select layers

Create new patterns for use in layers

Change layer settings

Arrange layers

Merge layers to flatten the image
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Creating a Layer
Nearly every image file by default has one special layer called
the background layer. (If you create a new transparent image,
it starts with Layer 1.) An image can have more layers than your
computer’s memory can probably handle—up to 8,000. Some
actions, such as adding text, create a new layer automatically.
In other instances, you may need to create a layer manually
before adding elements into it. This section explains how to 
do so.

Making a New Layer
The simplest way to create a layer is to simply add a new, blank
layer.

1. Click on Layer. The Layer
menu will appear.

2. Point to New. The New
submenu will appear.

3. Click on Layer. The New
Layer dialog box will open.

172 CHAPTER 8:  WORKING WITH LAYERS

NOTE
When you create a new image, it sometimes helps to
click on the Transparent option in the New dialog box.
This ensures that a white background won’t hide other
layers you may add.



4. Type a name for the layer
into the Name text box. The
specified name will be used for
the layer.

5. Click on a choice from the
Color and Mode lists, if needed.
Making a Color choice will apply
a color to the new layer’s listing
in the Layers palette. Making a
Mode choice will apply a layer
blending mode, which controls
how the individual pixels on the
layer blend with pixels on other
layers.
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TIP
A layer set organizes layers, much as a folder organizes
files on a hard disk. Click on Layer, point to New, and
then click on Layer Set to create a layer set.

TIP
Some blending modes enable the Fill with . . . check box.
You can click on it to check it and apply the applicable
neutral color.

TIP
Depending on the choice you make from the Mode list,
you may have to make other layers, such as the
Background layer, transparent. To do so, double-click on
the layer in the Layers palette, change the Opacity
setting to 0, and then click on OK.



6. Type a new entry into the
Opacity text box, if needed, or
click on its arrow, drag the slider,
and click on the arrow again.
Photoshop will make the layer’s
contents more transparent.

7. Click on OK. Photoshop will
close the New Layer dialog box
and create the new layer, which
will appear in the Layers palette.

Selecting a Layer
Selecting a layer makes it the current or active layer, so that
the changes you make next will apply to the layer. You use the
Layers palette to select a layer, as shown here. 

1. Click on the name of the
layer in the Layers palette. The
layer will appear selected in the
Layers palette, making it the
active layer.
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NOTE
You can hide a layer’s
contents by clicking on
the eye icon to the left of
the layer name in the
Layers palette. The layer’s
content disappears
immediately. Click on the
spot where the eye icon
previously appeared to
redisplay the layer. 



Duplicating a Layer
When a layer has content that you’d like to reuse, you can
duplicate the layer in the image file. Then, you can position the
layer content or add different effects independently.

1. Select the layer to
duplicate. The layer name
appears selected in the Layers
palette.

2. Click on Layer. The Layer
menu will appear.

3. Click on Duplicate Layer.
The Duplicate Layer dialog box
will open.

4. Type a name for the layer
into the As text box. The
specified name will be used for
the layer.

5. Click on OK. Photoshop will
close the Duplicate Layer dialog
box and create the new layer,
which will appear in the Layers
palette.
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Copying a Layer between Images
When a layer has content that you’d like to reuse, you can
make a copy of the layer and paste it into another image file.

1. Open or create the image
file to which you want to copy
the layer. The image window
appears in Photoshop.

2. Open the image file that has
the layer to copy. The image
window appears in Photoshop.
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NOTE
You can create a new image file by duplicating a layer.
To do so, click on the down arrow beside the Document
choice, then click on New. Type a name for the new file
in the Name text box, then click on OK.

NOTE
Make sure you position the image windows so that you’ll
be able to drag and drop between them. This means that
you need to be able to see at least part of the image
window for the image you opened in Step 1.



3. Drag the layer from the
Layers palette. The layer will
appear selected and the mouse
pointer will change to a clenched
hand.

4. Drop the layer on the
window for the file into which
you want to copy the layer. The
new layer appears immediately
in the destination image.
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Adding a Fill Layer
You can add a fill layer to color the entire image background.
This technique is preferred over drawing a colored box on a
layer, which can leave a white edge around the image.

1. Click on Layer. The Layer
menu will appear.

2. Point to New Fill Layer. The
New Fill Layer submenu will
appear.

3. Click on Solid Color. The
New Layer dialog box will open.

4. Type a name for the layer
into the Name text box. The
specified name will be used for
the layer.

5. Make a choice from the
Color and Mode lists, if needed.
Making a Color choice will apply
a color to the new layer’s listing
in the Layers palette. Making a
Mode choice will apply a layer
blending mode, which controls
how the individual pixels on the
layer blend with pixels on other
layers.
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6. Type a new entry into the
Opacity text box, if needed, or
click on its arrow, drag the slider,
and click on the arrow again.
Photoshop will make the layer’s
contents more transparent.

7. Click on OK. Photoshop will
close the New Layer dialog box
and open the Color Picker dialog
box.

8. Click on a color in the
narrow band of colors near the
middle of the dialog box.
Photoshop will display a
different range of colors in the
Pick a solid color box.

9. Click on a color in the Pick a
solid color box. The color you
click on will become the active
color.
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TIP
Depending on the choice you make from the Mode list,
you may have to make other layers, such as the
Background layer, transparent. To do so, double-click on
the layer in the Layers palette, change the Opacity
setting to 0, and then click on OK.



10. Click on OK. Photoshop
will close the Color Picker dialog
box and create the new fill layer.
Its name will appear in the Layers
palette.

11. Click on Layer. The Layer
menu will appear.

12. Point to Arrange. The
Arrange submenu will appear.

13. Click on Send to Back. The
new layer will shift to the back of
the available layers.
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TIP
You can change the type
of fill for a layer after you
create it. To do so, first
select the layer. Then click
on Layer, point to Change
Layer Content, and click
on Solid Color, Gradient,
or Pattern.
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Adding a Gradient Layer
A gradient layer blends one or more colors, for another
interesting background effect.

1. Click on the foreground
color for the gradient on the
color ramp in the Color palette.
The selected color will become
the foreground color (first color)
for the blend.

2. Click on Layer. The Layer
menu will appear.

3. Point to New Fill Layer. The
New Fill Layer submenu will
appear.

4. Click on Gradient. The New
Layer dialog box will open.
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5. Type a Name for the layer
into the Name text box. The
specified name will be used for
the layer.

6. Make a choice from the
Color and Mode lists, if needed.
Making a Color choice will apply
a color to the new layer’s listing
in the Layers palette. Making a
Mode choice will apply a layer
blending mode, which controls
how the individual pixels on the
layer blend with pixels on other
layers.

7. Type a new entry into the
Opacity text box, if needed, or
click on its arrow, drag the slider,
and click on the arrow again.
Photoshop will make the layer’s
contents more transparent.

8. Click on OK. Photoshop will
close the New Layer dialog box
and open the Gradient Fill dialog
box.
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TIP
Depending on the choice you make from the Mode list,
you may have to make other layers, such as the
Background layer, transparent. To do so, double-click on
the layer in the Layers palette, change the Opacity
setting to 0, and then click on OK.



9. Click on the down arrow
beside the Style box, then click
on a gradient style. Photoshop
will apply the selected style.

10a. Type a new entry into
the Angle text box, if
needed. Photoshop will
adjust the gradient to the
specified angle.

OR

10b. Drag the bar in the
Angle circle. Photoshop will
adjust the gradient to the
specified angle.
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NOTE
If needed, click on the
down arrow beside the
Gradient box, and then
click on a new gradient to
use. Photoshop will apply
the selected gradient and
its colors. If you click on
the Gradient box itself,
the Gradient Editor dialog
box opens. You can use it
to edit the gradient style,
or click on the arrow
button at the top right of
the Presets section of the
dialog box and then click
on a choice at the bottom
of the submenu that
appears to see other
gradient possibilities.



11. Type a new entry into the
Scale text box, if needed, or
click on its arrow and then drag
the slider for the setting.
Photoshop will adjust the
proportion of dark to light (or
various colors) in the gradient.

12. Click on OK. Photoshop
will close the Gradient Fill dialog
box and create the new fill layer.
Its name will appear in the Layers
palette.

Adding a Pattern Layer
Adding a pattern layer resembles adding each of the layer
types just described. You can use one of the predefined
patterns that comes with Photoshop or create your own
pattern, as described in the next section. 
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NOTE
If your gradient layer appears on top of the other layers
in the image and covers the objects from those layers,
don’t panic. See the later section called “Arranging Layer
Order” to learn how to fix the problem.

NOTE
You can load additional patterns using the Preset
Manager, which was described in Chapter 7.



1. Open or create the image file into which you want to add
a pattern layer. The image appears in its own window.

2. Click on Layer. The Layer
menu will appear.

3. Point to New Fill Layer. The
New Fill Layer submenu will
appear.

4. Click on Pattern. The New
Layer dialog box will open.

5. Type a Name for the layer into the Name text box. The
specified name will be used for the layer.

6. Make a choice from the
Color and Mode lists, if needed.
Making a Color choice will apply
a color to the new layer’s listing
in the Layers palette. Making a
Mode choice will apply a layer
blending mode, which controls
how the individual pixels on the
layer blend with pixels on other
layers.
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7. Type a new entry into the
Opacity text box, if needed, or
click on its arrow, drag the slider,
and click on the arrow again.
Photoshop will make the layer’s
contents more transparent.

8. Click on OK. Photoshop will
close the New Layer dialog box
and open the Pattern Fill dialog
box.

9. If needed, click on the down
arrow beside the Pattern Picker
box, click on a pattern in the
palette that appears, and then
click on the down arrow again.
Photoshop will apply the
selected pattern.
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TIP
Depending on the choice you make from the Mode list,
you may have to make other layers, such as the
Background layer, transparent. To do so, double-click on
the layer in the Layers palette, change the Opacity
setting to 0, and then click on OK.



10. Type a new entry into the
Scale text box, or click on its
arrow, drag the slider, and click
on the arrow again. Photoshop
will adjust the size of the
repeated pattern section
accordingly.

11. Click on OK. Photoshop
will close the Pattern Fill dialog
box and display the new fill
layer. Its name will appear in the
Layers palette.

12. Click on Layer. The Layer
menu will appear.

13. Point to Arrange. The
Arrange submenu will appear.

14. Click on Send to Back. The
new layer will shift to the back of
the available layers.

187CREATING A LAYER



Creating Patterns
If none of the patterns provided with Photoshop suits your
needs, you can create your own using one of two methods:
sampling a pattern or using the Pattern Maker plug-in.

Sampling a Pattern
You create a pattern “on the fly” and then use it to create a
pattern layer. The new pattern immediately becomes part of
the library of available patterns.

1. Open or create the image file that holds the area to use as
the pattern. The image appears in its own window.

2. Select the area to use as a
pattern using the selection tool
of your choice. The selection
marquee will appear.
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3. Click on Edit. The Edit menu
will appear.

4. Click on Define Pattern. The
Pattern Name dialog box will
open.

5. Type a name for the pattern
in the Name text box.
Photoshop will use the name you
specify to identify the pattern.

6. Click on OK. The Pattern
Name dialog box will close.
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NOTE
If the Define Pattern
command is disabled, it’s
probably because the
image bit depth is set to
16 Bits/Channel, the
typical setting for many
scanners. To enable the
Define Pattern command,
you have to convert the
image to 8 Bits/Channel
by choosing Image, Mode,
8 Bits/Channel. 



Using the Pattern Maker Plug-In
The Pattern Maker plug-in enables you to preview a pattern
and alter it slightly before you save it as a preset. Follow these
steps to create a basic pattern with the Pattern Maker plug-in. 

1. Open or create the image
file that holds the area to use as
the pattern. The image appears
in its own window.

2. Select the area to use as a
pattern using the selection tool
of your choice. The selection
marquee will appear.
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Organizing Your Patterns in a
Custom Library

After you create one or more patterns, you can use the
Preset Manager to save a new library with your custom
patterns. Choose Edit, Preset Manager. Choose Patterns
from the Preset Type drop-down list. Click on one of the
patterns you created, and then click on the Save Set
button. Enter a File Name for the pattern library in the
Save dialog box, and then click on Save. Click on the Load
button, click on the name of the new pattern library file,
and then click on Load. This loads the new library. You can
right-click on any pattern and then click Delete Pattern to
remove it from the library; just save the library again to
preserve your changes. Click on the Done button to close
the Preset Manager dialog box when you finish. 
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3. Click on Edit. The Edit menu
will appear.

4. Click on Copy. Photoshop
will copy the selection, so that
you can use it as the new
pattern.

5. Click on Filter. The Filter
menu will appear.

6. Click on Pattern Maker. The
Pattern Maker window will open.
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7. Change settings such as the tile Width, Height,
Smoothness, and Sample Detail as needed. The Pattern Maker
will apply those settings when you generate the pattern tile
preview.

8. Click on Generate. The
Pattern Maker window will
preview the pattern, both as a
single tile in the Tile History area
and as an applied pattern in the
main portion of the dialog box.

9. Change settings again as
needed. The Pattern Maker will
apply those settings when you
regenerate the pattern tile
preview.

10. Click on Generate Again.
The Pattern Maker window will
preview the pattern, both as a
single tile in the Tile History area
and as an applied pattern in the
main portion of the dialog box.
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11. Click on buttons in the Tile History area as needed. The
preview that you want to save as a pattern preset will appear.
From left to right, the buttons (which work like similar
navigation buttons in other programs) are:

• First Tile. Displays the first
sample you generated. 

• Previous Tile. Displays the
sample you created
immediately before the
current sample.

• Next Tile. Displays the
sample you created
immediately after the current
sample.

• Last Tile. Displays the final
sample you created.

12. Click on the Save Preset
Pattern button. The Pattern
Name dialog box will open.

13. Type a name for the
pattern in the Name text box.
Photoshop will use the name you
specify to identify the pattern.

14. Click on OK. The Pattern
Name dialog box will close.
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15. Click on Cancel. The
Pattern Maker window will close.

Deleting a Layer
When you want to remove a layer from an image, it’s fastest to
use the Layers palette, as detailed here.

1. Right-click on the layer to
delete in the Layers palette. A
shortcut menu will appear.

2. Click on Delete Layer. A
warning message box will open.
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NOTE
If you click on OK rather
than Cancel in Step 15,
Photoshop will replace the
contents of the current
layer with the tiled new
pattern.



3. Click on Yes. Photoshop will
complete the deletion.

Setting Layer Properties
The layer properties include the layer’s name and the color
used to identify the layer in the Layers palette. You can change
either of these settings as needed.

1. Right-click on the desired
layer in the Layers palette. A
shortcut menu will appear.

2. Click on Layer Properties.
The Layer Properties dialog box
will open.
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NOTE
Be sure to right-click to
the right of the layer name
in the Layers palette to
display the proper
shortcut menu. If you
select a layer in the Layers
palette, you also can use
the Delete Layer
command on the Layer
menu to delete it.



3. Change Name and Color
settings as needed. Photoshop
will display the changes.

4. Click on OK. Photoshop will
apply the changes.

Choosing a Layer Style
The layer style consists of some of the settings you made when
creating the layer, such as its opacity and blend mode. The
style also includes special effects you might want to add to the
layer’s contents.

1. Right-click on the desired
layer in the Layers palette. A
shortcut menu will appear.

2. Click on Blending Options.
The Layer Style dialog box will
open.
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3. Click on a style in the Styles list. Photoshop will check the
style (effect) to indicate that it’s selected.

4. Change Blending Options as
needed. The Preview will change
to show the impact of your
changes.

5. Click on OK. Photoshop will
close the Layer Style dialog box
and apply the changes. The
Layers palette will show the
effects applied to the layer.
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TIP
You can change the style for any layer, not just fill layers.
The style (effect) you choose applies to the layer
contents, whether those contents include text, objects
you’ve drawn, or scanned photos.

TIP
You also can click on a layer, and then click on the Add a
Layer Style button in the bottom-left corner of the
Layers palette to add a style (effect) without changing
other layer settings.



Arranging Layer Order
You need to arrange layers to control how the various layer
contents relate to one another and which portions of one layer
might hide areas on another layer.

1. Click on the layer to move in
the Layers palette. Photoshop
will select the layer.

2. Click on Layer. The Layer
menu will appear.

3. Point to Arrange. The
Arrange submenu will appear.

4. Click on an arrangement
choice. For example, you might
want to click on Send to Back to
send a fill layer all the way to the
back of the layers stack.
Photoshop will apply the new
layer position immediately.
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Grouping and Ungrouping
Layers
You group layers by creating a layer set and then dragging the
layers into and out of the set on the Layers palette.

1. Click on Layer. The Layer menu will appear.

2. Point to New. The New
submenu will appear.

3. Click on Layer Set. The Layer
Set dialog box will appear.
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TIP
Press and hold Ctrl and then click a layer in the Layers
palette to select the layer contents. This places a
selection marquee around the layer’s contents in the
image window.



4. Type a Name for the set into
the Name text box. The
specified name will be used for
the set.

5. Make a choice from the
Color and Mode lists, if needed.
Making a color choice will apply
a color to the new set’s listing in
the Layers palette. Making a
Mode choice will apply a
blending mode, which controls
how the individual pixels on the
layers in the set blend with pixels
on other layers in the set.

6. Type a new entry into the Opacity text box, if needed, or
click on its arrow, drag the slider, and then click on the arrow
again. Photoshop will make the set’s contents more
transparent.

7. Click on OK. Photoshop will
close the New Layer dialog box
and create the new layer, which
will appear in the Layers palette.
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8. Drag a layer name and drop
it onto the set name in the
Layers palette. The layer will be
added into the set.

Flattening the Image
Flattening the image combines all the layer contents on a single
layer, which can make the file size more compact. Use this
process only if you’re finished editing your image, and undo the
action immediately if you’ve done it by mistake.

1. Click on Layer. The Layer
menu will appear.

2. Click on Flatten Image.
Photoshop immediately
combines the contents of all the
layers onto a single layer.
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NOTE
To remove a layer from
the set, drag it back off
the set and drop it
elsewhere in the list on
the Layers palette.

NOTE
Click on Edit, then click on
Undo Flatten Image (or
press Ctrl+Z) to separate
the image back into
layers. Or, use the History
palette to undo the
Flatten Image command.
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If you’ve ever taped off an area while you’re doing a painting project
to protect that area from drips and spatters, you’ve created a mask.
In Photoshop, you apply a mask to designate part of an image for
changes, but shield (mask) the unselected areas against those
changes. In this way, you can apply different effects and filters in
varying portions of the image or layer. Read on to see how to:

Set options for a quick mask

Work in Quick Mask mode

Create and use a layer mask

Explore mask examples
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Changing Quick Mask Options
Before you change to Quick Mask mode, you can set a few
different options that affect how Quick Mask mode behaves.

1. Double-click on the Quick
Mask mode button on the
toolbox. The Quick Mask
Options dialog box will open.

2. Click on an option in the
Color Indicates area. Photoshop
will apply the mask color to
either the Masked Areas or
Selected Areas in the image,
depending on your selection.

3. Click on the Color box. The
Color Picker dialog box will
open.

4. Click on a color in the narrow band of colors near the
middle of the dialog box. Photoshop will display a different

range of colors in the Select
Quick Mask color box.

5. Click on a color in the Select
Quick Mask color box. The color
you click on will become the
active mask color.

6. Click on OK. Photoshop will
close the Color Picker dialog box
and return to the Quick Mask
Options dialog box.
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7. Type a new entry into the
Opacity text box, if needed.
Photoshop will make the mask
color more or less transparent,
depending on your entry.

8. Click on OK. Photoshop will
close the Quick Mask Options
dialog box and apply the new
settings the next time you use
Quick Mask mode.

9. Click on the Standard mode
button on the toolbox. This
turns off Quick Mask mode so
that you can make a selection.

Using Quick Mask to Adjust a
Selection
Quick Mask mode enables you to use a selection on the current
layer as a temporary mask. Once you’ve masked the area, you
can make the needed changes to the unmasked area, and then
turn off Quick Mask mode to remove the mask.
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1. Make a selection on the
current layer using the selection
method of your choice. The
selection marquee will appear.

2. Click on the Quick Mask
mode button on the toolbox.
The Quick Mask mode will
become active, and the mask
color will appear over the
masked area.
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TIP
See Chapter 5, “Selecting
Image Content,” to
refresh your memory
about the various
selection methods. One
trick is to select the area
that you don’t want to
mask, click on Select, and
then click on Inverse to
select the image areas
that previously were not
selected. (The figure here
shows an inverted
selection.)



3. Make the desired change to the masked area, using a
toolbox tool or filter. The mask boundaries will change
accordingly. This example shows a mask with the Torn Edges
filter applied.
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TIP
Chapter 13, “Using a
Filter,” explains how to
use the Photoshop filters.
Applying some filters
affects the unmasked
area, or the entire layer,
depending on the nature
of the filter, so you may
need to experiment a bit.

NOTE
Paint or draw on the non-masked area with a color other
than white to create a semi-transparent masked area.
Use white to exclude an area from the mask, and black
to add area to the mask (the hidden area).



4. Click on the Standard mode
button on the toolbox.
Photoshop will leave Quick Mask
mode and return to the altered
selection. You can then apply the
needed changes to the selected
areas, as described later under
“Putting a Mask to Work.”

Using Layer Masks
You can add a mask to a particular layer in the image so that
you can hide part of the layer from display or even apply
effects only to the area selected by the mask. By adding layer
masks to various layers, you can mix and match effects as
needed in the image.

You can’t add a layer mask to the background layer, so you
may need to add another layer such as an adjustment layer or
duplicate the background layer and delete the original to work
with a layer mask on the background layer content itself. In
some cases, you also may want to hide the background layer
(by clicking on the eye icon beside it) to ensure that you can
select only the image content that you want. 
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NOTE
You also can create a special, color-related type of mask
that’s called an alpha channel. See “Adding an Alpha
Channel” in Chapter 16 to learn more. 



Creating a Mask on a Layer
Adding a mask on a layer will have different effects, depending
on the layer’s contents. For text layers, it enables you to select
text and apply filters without rasterizing the text layer (that is,
converting the layer to pixels rather than a vector layer, where
objects are based on larger, resizable shapes). For layers with
small photos, fills, and other objects, the layer mask excludes
the information not contained within the mask area, so it
doesn’t display in the image. For adjustment layers like a
hue/saturation layer, the mask enables you to adjust the image
color only within the areas defined by the mask.

1. Click on the layer in the
Layers palette to which you
want to add a mask. The layer
will become the current or active
layer.

2. Make a selection on the
current layer using the selection
method of your choice. The
selection marquee will appear.
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NOTE
The examples in this chapter illustrate layer masks. You
also can create vector masks to mask sharp shapes
based on paths in an image. See the next chapter to
learn how to add a path and use it to create a vector
mask.



3. Click on the Add Layer
Mask button on the bottom of
the Layers palette. Photoshop
will create the mask immediately.
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NOTE
When you add certain types of layers, such as gradient
fill layers, they automatically include a mask that includes
all the layer content. It’s often best to delete this mask
by right-clicking on the mask thumbnail in the Layers
palette, and then clicking on Discard Layer Mask. See the
next section, “Changing or Trashing a Mask,” for more
information. If you try to add another mask without
deleting the first one, Photoshop will add a clipping path
instead. Chapter 10 describes what a clipping path is and
how to use one.

TIP
Press and hold the Alt key
as you click to invert the
selection in the mask.
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4. Review the mask thumbnail
in the Layers palette. The black
area in the thumbnail will show
the zone that the mask hides or
excludes.

Changing or Trashing a Mask
The selection on a layer mask isn’t permanent once you’ve
made it, so you can adjust the mask at a later time by painting
or drawing. You also can delete a mask from a layer altogether.

1. Click on the mask thumbnail
for the desired layer in the
Layers palette. The mask (and
layer) will become active.

2. Click on the Set Foreground
Color box on the bottom of the
toolbox. The Color Picker dialog
box will open.
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3. Click on the color to use for
the mask edits (black, white, or
gray) in the Select foreground
color box. The color you select
controls the effect of the edits
you will make:

• White will reveal more of the
layer, decreasing the amount
of masked off area.

• Black will hide more of the
layer, increasing the amount
of masked off area.

• Gray will create a transparent
area on the mask, so the area
will be partially visible.

4. Click on OK. The Color Picker dialog box will close, and the
color you selected will become active.
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NOTE
For solid color, gradient, and pattern fill layers, painting
with white has no effect, because the entire layer is
revealed. Painting with black hides the portion of the fill
that you’ve painted over.



5. Select the tool to use in the toolbox. The tool will become
the active tool.

6. Set tool options on the
options bar. The options you
specify will become active.

7. Draw or paint on the layer.
The mask will be altered
accordingly.

8. Right-click on the thumbnail
for the mask to delete in the
Layers palette. A shortcut menu
will appear.

9. Click on Discard Layer
Mask. Photoshop removes the
layer mask immediately.
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NOTE
A fill layer may jump
around a bit onscreen as
you edit the mask. It
should stabilize after you
save your changes.



Using a Selection from One Layer as a
Mask on Another
In some instances, the selection that you want to use to define
a mask for a layer may appear on another layer instead of on
the layer where you want to add the mask. For example, if you
have a text layer and a gradient layer, you may want to mask
out the gradient layer so that the gradient appears only over
the text. The steps below illustrate that case while showing you
how to use a selection from one layer to create a mask on
another.

1. Click on the eye icon beside
any layer to hide in the Layers
palette. The eye icon will
disappear and the layer will
become hidden, making it easier
for you to select content on
another layer.
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CAUTION
Delete all other masks on the layer to which you want to
copy a mask before beginning the steps.



2. Click on the layer with the
content to select in the Layers
palette. The layer will become
the current or active layer.

3. Make a selection on the
current layer using the selection
method of your choice. The
selection marquee will appear.

4. Click on the layer in the
Layers palette to which you
want to add the mask. The layer
will become the current or active
layer, and it should become
visible if you hid it in Step 1.

5. Click on the Add Layer
Mask button on the bottom of
the Layers palette. Photoshop
will create the mask immediately.
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6. Review the mask thumbnail
in the Layers palette. The black
area in the thumbnail will show
the zone that the mask hides or
excludes.

Reviewing the Mask
You can disable and enable a layer mask as needed, so you can
see how your image looks with and without the mask applied.
The following steps show you the fastest way to control
whether a mask appears.

1. Right-click on the desired
mask thumbnail in the Layers
palette. A shortcut menu will
appear.

2. Click on Disable Layer Mask.
Photoshop will disable the mask
display immediately and will
place a red X through the mask
thumbnail.
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3. Right-click on the thumbnail
for the mask to enable in the
Layers palette. A shortcut menu
will appear.

4. Click on Enable Layer Mask.
Photoshop will reapply the mask
immediately, and the image
display will be affected
accordingly.

Putting a Mask to Work
As was noted earlier in this chapter, a layer mask may behave a
bit differently or enable you to do different things, depending
on the nature of the layer where you added the mask. This
section reviews two examples of how you can use layer masks
to adjust or enhance selected content in an image.

Cropping a Photo
To use this technique, make sure the photo to crop appears on
its own layer, not on the background layer.
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1. Click on the layer in the
Layers palette to which you
want to add the mask. The layer
will become the current or active
layer.

2. Make a selection on the
current layer using the selection
method of your choice. The
selection marquee will appear.

3. Click on the Add Layer
Mask button on the bottom of
the Layers palette. Photoshop
will create the mask immediately.

4. Review the mask results in
the image. Photoshop will mask
out the areas not included within
the selection from which you
created the mask.
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Adding a Filter
When you apply a filter, it only affects the currently selected
area. Because a mask in effect protects an area like a selection,
applying a filter to a layer that has a mask on it filters only the

portions of the layer that aren’t
masked off. This is a particularly
vital technique for text layers;
with the mask, Photoshop would
prompt you to rasterize the text
layer, eliminating your ability to
edit the text in the future.

1. Click on the desired layer in
the Layers palette. The layer will
become the current or active
layer.

2. Click on Filter. The Filter
menu will appear.

3. Click on the filter command
of your choice. A submenu with
specific filter choices will appear.

4. Click on a filter in the
submenu. In most cases, a dialog
box with options for the filter will
appear.
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5. Set filter options as needed. A preview in the dialog box
will show how the filter will look when applied using the
settings you specified.

6. Click on OK. The filter
settings dialog box will close,
and the filter will be applied to
the layer contents not hidden or
protected by the mask.

7. Review the filter results in
the image. Photoshop will
display the newly filtered areas.
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Recoloring Part of the Image
This mask technique works with a special color correction layer
called an adjustment layer. (You’ll learn more about working
with colors in Chapters 15 through 17.) It enables you to make
a color change on part of an image only. This example shows

how to make a hue and
saturation change, but you can
make other changes depending
on the nature of the adjustment
layer you choose to use.

1. Click on Layer. The Layer
menu will appear.

2. Click on New Adjustment
Layer. A submenu with specific
layer choices will appear.

3. Click on Hue/Saturation in
the submenu. The New Layer
dialog box will appear.

4. Type a Name for the layer
into the Name text box. The
specified name will be used for
the layer.

5. Make a choice from the
Color and Mode lists, if needed.
Making a Color choice will apply
a color to the new layer’s listing
in the Layers palette. Making a
Mode choice will apply a layer
blending mode, which controls
how the individual pixels on the
layer blend with pixels on other
layers.
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6. Type a new entry into the Opacity text box, if needed, or
click on its arrow, drag the slider, and click on the arrow again.
Photoshop will make the layer’s contents more transparent.

7. Click on OK. Photoshop will
close the New Layer dialog box
and open the Hue/Saturation
dialog box.
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TIP
Depending on the choice you make from the Mode list,
you may have to make other layers, such as the
Background layer, transparent. To do so, double-click on
the layer in the Layers palette, change the Opacity
setting to 0, and then click on OK.



8. Drag the sliders as needed.
The image will display the
corrected color.

9. Click on OK. The
Hue/Saturation dialog box will
close.

10. Right-click on the
thumbnail for the mask for the
new hue/saturation layer in the
Layers palette. A shortcut menu
will appear.

11. Click on Discard Layer
Mask. Photoshop will remove
the layer mask immediately.
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12. Make a selection on the
layer of your choice using the
selection method of your choice.
The selection marquee will
appear.

13. Click on the
hue/saturation layer in the
Layers palette. It will become
the current or active layer.

14. Click on the Add Layer
Mask button on the bottom of
the Layers palette. Photoshop
will create the mask immediately.

15. Review the mask results in
the image. Photoshop will apply
the color correction to only the
area not blocked by the mask.

224 CHAPTER 9:  ADDING VARIETY WITH MASKS

NOTE
If you double-click on the
layer thumbnail (to the far
left) for the hue/saturation
layer, the Hue/Saturation
dialog box reopens so you
can further adjust the
color correction in the
areas not blocked by the
mask.



A path is essentially a vector-based selection outline in Photoshop.
Because paths are vector-based (an outline rather than a selection of
pixels), creating paths in an image file rather than saved selections
will have less of a tendency to increase the file size. This can be
beneficial if the file is a large scan, has dozens of layers, or is simply
large because it’s complex. You can use a path as a selection at any
time, fill the path or color the path outline, or even use a special type
of path to clip image content when you plan to reuse a file. This
chapter shows you how to:

Create various types of paths

View and work with paths

Fill a path or color the path outline

Use a path to define a selection

Use a clipping path to prepare an image for reuse in other files or
settings
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Creating Paths
You use the Paths palette to save the paths you create, and
use the pen tools and shape tools to actually draw each path.
The tool you should use to create the path depends on the
desired shape for the path.

Adding a Shape Path
The section titled “Drawing a Rectangle, Oval, or Other Shape”
in Chapter 3 explained how to use the Rectangle tool (and the
other shape tools you access via the Rectangle tool) to draw
shapes on an image. You also can use those tools to create a
path for later use, as described here.

1. Right-click on the Rectangle
tool in the toolbox. Its shortcut
menu will appear.

2. Click on the desired shape
tool to use in the submenu. The
selected tool will become the
active tool.
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NOTE
Paths do not print unless you fill them with color or color
their border.

NOTE
If you choose the Custom
Shape tool, be sure to use
the Shape drop-down list
on the options bar to
specify which kind of
shape to draw.



3. Click on the Paths button on
the options bar. The selected
tool will become active for path
selection.

4. Drag diagonally on the
picture in the work area. Keep
the mouse button pressed as
you drag in any desired
direction. When you release the
mouse button, the path will
appear.

5. Click on Window. The
Window menu will appear.

6. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.
The Paths palette will show that
the path you’ve drawn appears
as a temporary path called a
Work Path.
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TIP
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



7. Click on the Paths palette
menu button. The palette menu
will appear.

8. Click on Save Path. The Save
Path dialog box will open.

9. Type a name for the path in
the Name text box. Your new
name will replace the temporary
name in the text box.

10. Click on OK. The Save Path
dialog box will close and
Photoshop will finish saving the
path under the name you
specified.
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NOTE
You don’t have to save a
temporary work path
unless you want to reuse it
later.



11. Click on a blank area in the
Paths palette. Photoshop will
deselect the path.

12. Click on the Layers tab in
the Layers palette window.
(Alternately, you can choose
Window, Layers.) Photoshop will
return to the regular view of
layers in the image.

Making a Pen Path
The Pen tool enables you to create paths with straight lines,
curves, and angles. Use this tool when you want to create a
path that’s irregular in shape or has swooping, controlled
curves.
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NOTE
If you skip this last step when using a tool to create a
path, the path will remain selected and any further
actions you take pertain to that path. For example, if you
try to create a path with another tool, it would simply be
added into the current path rather than created as a
separate work path.

NOTE
You must be careful in using the mouse with the Pen
tool. Different mouse actions have different results. The
following steps illustrate the various mouse techniques
you need to master when using the Pen tool. 



1. Click on the Pen tool in the
toolbox. Its options will appear
in the options bar.

2. Click on the Paths button on
the options bar. The Pen tool will
become active for path selection.

3. Click on the starting point
for the first segment in the path.
An anchor point appears at the
location where you clicked.

4. Click on the location where
you want to end the segment. A
straight line segment appears
between the anchor points.
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NOTE
If you click on the Shape
Layers button on the
options bar for any tool
described in this chapter,
instead of the Paths
button, the tool draws a
shape or outline on a new
layer in the image rather
than simply creating a
path.TE
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5. Drag on the location for the end of the next segment.
Because you dragged, Photoshop will create a curved segment.

6. Drag the direction point at
the end of the direction line,
then release the mouse button.
Photoshop will adjust the depth
and direction of the curved
segment based on where you
drag the direction point.

7. Drag in the opposite direction on the location for the end
of the next segment. Because you dragged in the opposite
direction, Photoshop will create a segment that curves in the
opposite direction.

8. Drag the direction point at
the end of the direction line,
then release the mouse button.
Photoshop will adjust the depth
and direction of the curved
segment based on where you
drag the direction point.
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TIP
To create a corner point between segments, press and
hold the Alt key when you set the anchor point for the
next segment. Press and hold the Ctrl key to drag an
anchor point or corner point.

9. After you create all the
needed segments, finish drawing
the path in one of two ways:

• Click on the first anchor
point to close the path shape.
Note that when the mouse
pointer is over the first anchor
point, a small circle appears
along with the pointer to tell
you that clicking would then
close the path.

• Click on the Pen tool in the
toolbox to finish the path
without closing the shape.

10. Click on Window. The
Window menu will appear.

11. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.
The Paths palette will show that
the path you’ve drawn appears
as a temporary path called a
Work Path.
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12. Click on the Paths palette
menu button. The palette menu
will appear.

13. Click on Save Path. The
Save Path dialog box will open.

14. Type a name for the path
in the Name text box. Your new
name will replace the temporary
name in the text box.

15. Click on OK. The Save Path
dialog box will close and
Photoshop will finish saving the
path under the name you
specified.
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16. Click on a blank area in the
Paths palette. Photoshop will
deselect the path.

17. Click on the Layers tab in
the Layers palette window.
(Alternately, choose Window,
Layers.) Photoshop will return to
the regular view of layers in the
image.

Making a Freeform Path
The Freeform Pen tool enables you to create a path by
dragging on the image. In addition, you can turn on the
Magnetic option with the Freeform Pen tool to have the path
outline “snap to” a shape in the image. This tool comes in
handy when you want to create a path around a particular item
or region in an image.

1. Right-click on the Pen tool in
the toolbox. Its shortcut menu
will appear.

2. Click on Freeform Pen Tool.
The Freeform Pen tool will
become the active tool.
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3. Click on the Paths button on
the options bar. The Freeform
Pen tool will become active for
path selection.

4. Click on the Magnetic check
box to check it, if desired.
Checking this option will cause
the Freeform Pen tool to
function as the Magnetic Pen
tool, and your path will snap to
the outline for an item in the
image.

5. Drag on the picture in the
work area. Keep the mouse
button pressed as you drag in
any desired direction. When you
release the mouse button, the
path will appear.
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NOTE
The Magnetic feature works via color and tone contrast.
You can click on the Magnetic check box near the center
of the options bar to make the Freeform Pen tool work
magnetically.



6. Finish drawing the path in one of three ways:

• Click on the first anchor
point to close the path shape.
Note that when the mouse
pointer is over the first anchor
point, a small circle appears
along with the pointer to tell
you that clicking would then
close the path.

• Double-click on the next-to-
last anchor point to close the
path automatically.

• Click on the Freeform Pen
tool in the toolbox to finish
the path without closing the
shape.
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TIP
If you’re using the Magnetic Pen tool, you can click to set
specific anchor points and press Delete to remove the
most recent anchor point. However, with the Freeform
Pen tool, you must keep the mouse button pressed as
you drag.

NOTE
When you’re drawing any path, you can press Esc to
stop drawing the path. 



7. Click on Window. The
Window menu will appear.

8. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.
The Paths palette will show that
the path you’ve drawn appears
as a temporary path called a
Work Path.

9. Click on the Paths palette
menu button. The palette menu
will appear.

10. Click on Save Path. The
Save Path dialog box will open.
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NOTE
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



11. Type a name for the path
in the Name text box. Your new
name will replace the temporary
name in the text box.

12. Click on OK. The Save Path
dialog box will close and
Photoshop will finish saving the
path under the name you
specified.

13. Press Esc. Photoshop will
deselect the path.

14. Click on the Layers tab in
the Layers palette window.
(Alternately, choose Window,
Layers.) Photoshop will return to
the regular view of layers in the
image.
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Viewing and Changing a Path
The Paths palette enables you to view and work with the paths
in an image file. When you change a path, you move, add, and
delete anchor points.

1. Click on Window. The
Window menu will appear.

2. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.

3. Click on the desired path on
the Paths palette tab. The path
will become the active path.

4. Use the Navigator to pan
the path into view, if needed.
The path will become visible in
the work area.
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TIP
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



5. Right-click on the Pen tool in
the toolbox. Its shortcut menu
will appear.

6. Click on Add Anchor Point
Tool. The Add Anchor Point tool
will become the active tool.

7. Click on the path at the
location where you want to add
the new anchor point. The
anchor point will appear.

8. Drag the new anchor point
(and any others) to the desired
location. The path will reshape
accordingly.
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9. Right-click on an anchor
point that you want to delete. A
shortcut menu will appear.

10. Click on Delete Anchor
Point. The path will reshape
accordingly.

11. Right-click on the Path
Selection tool in the toolbox. A
shortcut menu will appear.

12. Click on Direct Selection
Tool. The Direct Selection tool
will become the active tool.

241CREATING PATHS



13. Drag anchor points to
reposition them as needed.
Again, the path will reshape
accordingly, but in this case, you
didn’t have to add new anchor
points.

14. Press Esc. The path will be deselected, but your changes
will remain in the path. From here, you can click on the Layers
tab in the Layers palette or choose Window, Layers to resume
working with layers.

Filling or Coloring a Path
You can fill a path with color to add a blotch of color in an
image or “stroke” the path outline with color to add a subtle
outline of color in the image. Although by default a path
doesn’t print, it will print after you fill or stroke it with color.
These steps explain how to use color with a path.
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NOTE
You can use the Path
Selection tool to drag the
whole path on the image.



1. Click on the desired fill or
outline color in the color ramp
at the bottom of the Color
palette. The color will become
the active foreground color.

2. Click on Window. The
Window menu will appear.

3. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.
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TIP
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



4. Click on the desired path to color in the Paths palette.
The path will become the active path.

5a. Click on the Fill Path with
Foreground Color button at the
bottom of the Paths palette.
Photoshop will fill the path with
the color you selected in Step 1.

OR

5b. Click on the Stroke Path
with Foreground Color button
at the bottom of the Paths
palette. Photoshop will apply a
very thin outline of the
foreground color to the path
outline.

6. Review the resulting color.
This example shows the path
filled with color. If you merely
stroked the path with color, the
result could be fairly subtle, and
may not be visible until you finish
working with the Paths palette.
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NOTE
At this point, you can click
on the Layers tab in the
Layers palette or choose
Window, Layers to finish
working with paths.



Using a Path to Make a Selection
As was noted much earlier in the chapter, you can use a path as
a selection at any time, making it easy for you to work with the
path area later, applying a filter or other effect.

1. Click on Window. The
Window menu will appear.

2. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.

3. Click on the desired path.
The path will become the active
path.

4. Click on the Load Path as a
Selection button at the bottom
of the Paths palette tab. A
selection marquee will appear
around the path. You then can
work with the selection just as
you would any other selection.
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TIP
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



Using a Path to Create a Vector Mask
A vector mask enables you to define a mask based on an
outline (rather than based on image pixels and colors, as for a
layer mask). You base a vector mask on a work path that
you’ve previously created. Once you’ve created the vector
mask, you can move or resize it as needed to adjust the
masked area—something you can’t easily do with a layer mask. 

1. Click on Window. The Window menu will appear.

2. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.
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NOTE
Vector masking does not work on the Background layer.
So, right-click on the Background layer and click
Duplicate Layer. Enter a name for the new layer in the
Duplicate Layer dialog box, and then click on OK. Finally,
click the eye icon beside the original Background layer in
the Layers palette to hide that layer so that you can see
the effects of your vector mask.

TIP
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



3. Click on the desired path.
The path will become the active
path.

4. Click on the Layers tab in
the Layers palette window.
Photoshop will return to the
regular view of layers in the
image.

5. Click on the layer with the
content to mask. The layer will
become the active layer.
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6. Click on Layer. The Layer
menu will appear.

7. Point to Add Vector Mask.
The Add Vector Mask submenu
will appear.

8. Click on Current Path. The
mask will be created and applied
immediately.

9. Review the resulting mask.
Layer content outside the mask
(path) will be hidden.
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NOTE
At this point, you could
use the Path Selection tool
to move the mask around
on the layer or adjust the
shape of the mask. To turn
off the mask, right-click on
the mask thumbnail in the
Layers palette and then
click on Disable Vector
Mask. Right-click again
and then click on Enable
Vector Mask to reapply
the mask. 



Using Clipping Paths
A clipping path works much likes a mask, but should be used
instead of a mask if you plan to save a copy of a file and insert
that copy into another file or use the copy in a document. The
area outside the clipping path will be transparent in the file
copy when you insert it into a file or document. Using a clipping
path ensures that other content in the location where you use
the file copy—especially when you insert it into another
Photoshop file or another type of document—will be able to
show through areas made transparent by the clipping path.

Adding a Clipping Path
The fastest way to create a clipping path is to duplicate an
existing path in the image and then save it as a clipping path,
as the following steps will illustrate.

1. Click on Window. The
Window menu will appear.

2. Click on Paths. The Paths
palette will become the active
tab in the Layers palette window.
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TIP
In place of opening the
Window menu and
choosing Paths, you can
click on the Paths tab in
the Layers palette
window.



3. Right-click on the path to
duplicate. A shortcut menu will
appear.

4. Click on Duplicate Path. The
selection marquee will appear
around the path and the
Duplicate Path dialog box will
appear.

5. Type a name for the
clipping path in the Name text
box. Your new name will replace
the temporary name in the text
box.

6. Click on OK. The dialog box
will close and the new path will
appear in the Paths palette.
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TIP
Use the Navigator to
scroll the path into view
first, if needed, to verify
that you’re duplicating the
correct path.
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7. With the new path still
selected in the Paths palette,
click on the Paths palette menu
button. The palette menu will
appear.

8. Click on Clipping Path. The
Clipping Path dialog box will
open.

9. Click on the down arrow
beside the Path drop-down list,
and then click on the name of
the path you just duplicated.
The path will be selected.

10. Click on OK. Photoshop
will save the duplicated path as a
clipping path. You can then
return to the Layers palette and
continue working if you want.
You should save the file to save
all of your paths in the original
file. To learn to use the clipping
path content, proceed to the
next section.
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Using Clipped Content
Merely creating the clipping path doesn’t clip the image. You
must save a copy of the image in Photoshop EPS, DCS, or PDF
format (or TIFF if you plan to use the image with a non-
Postscript printer), then import or place it in another file or

document. The steps here show
an example of how this process
works.

1. Open the file that holds the
clipping path. The file will
become the active file.

2. Click on File. The File menu
will appear.

3. Click on Save As. The Save
As dialog box will open.

4. Use the Save in list to
choose another save location, if
needed. The clipped file will be
saved to the designated
location.

5. Edit the file name in the File
name text box, if needed.
Photoshop will use the name you
specify for the clipped file.
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6. Click on the down arrow
beside the Format list, and then
click on Photoshop EPS, one of
the Photoshop DCS choices,
Photoshop PDF, or TIFF. The
clipped file will be saved with the
specified format.

7. Click on Save. Photoshop
may display an options dialog
box, depending on the file
format you selected in Step 6.

8. Choose options as needed
in the dialog box. Photoshop will
apply your choices when it
finishes saving the clipped file.

9. Click on OK. Photoshop will
save the clipped file and it will
stay open, although it will not
appear clipped onscreen.
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10. Click on File. The File
menu will appear.

11. Click on Close. The clipped
file will close.

12. Click on File. The File
menu will appear.

13. Click on New. The New
dialog box will open.
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14. Specify settings for the
new file. The new file will use the
designated settings.

15. Click on OK. Photoshop
will open the new file.

16. Click on File. The File
menu will appear.

17. Click on Place. The Place
dialog box will open.
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18. Select the file type you used for the clipped file from the
Files of type drop-down list. (Also use the Look in list to
navigate to the location holding the clipped file, if needed.)
The file will appear in the list of files in the dialog box.

19. Click on the clipped file in
the list. It will become the
selected file.

20. Click on Place. Photoshop
will insert the clipped file in the
new file you created.

21. Review the position of the
clipped information, and then
click on the check mark button
(Commit Place) at the right end
of the options bar to finish
placing the clipped file into the
new Photoshop file. The inserted
clipped file will appear on its
own new layer in the image file.
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Part 3 Review Questions
1. How do you add a new layer? See “Making a New Layer” in

Chapter 8.

2. How do you go to a layer to work with it? See “Selecting a Layer”
in Chapter 8.

3. What other kinds of layers can you add? See “Adding a Fill Layer,”
“Adding a Gradient Layer,” and “Adding a Pattern Layer” in
Chapter 8.

4. What do you do if one layer is hiding part of another? See
“Arranging Layer Order” in Chapter 8.

5. Why do you use a mask? See “Using Layer Masks” in Chapter 9.

6. Can you convert a selection to a mask? See “Using a Selection from
One Layer as a Mask on Another” in Chapter 9.

7. What can you do once you’ve created a mask? See “Putting a Mask
to Work” in Chapter 9.

8. How and why do you create a path? See “Adding a Shape Path,”
“Making a Pen Path,” and “Making a Freeform Path” in Chapter 10.

9. How do you convert a selection to a path? See “Using a Path to
Make a Selection” in Chapter 10.

10. How do you create and use a clipping path? See “Using Clipping
Paths” in Chapter 10.
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Photoshop includes a number of editing tools that you can use to
touch up specific areas of an image or layer. Many of the techniques
resemble traditional techniques used to correct a photo during
development. You can adjust the focus of a particular area, enhance
the intensity of an area, or use other techniques such as filling an
area with color. In this chapter, you learn how to:

Add blurring or smudging to an area

Sharpen an area

Use the eraser tools to erase to the background color or
transparency

Erase all of a particular color on a layer using the magic eraser

Add a gradient or fill an area with color

Dodge, burn, or sponge an area

Use new tools to fix scratches, spots, and imperfections
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Blurring an Area
It may seem contrary to your needs in most cases, but blurring
part of an image can help camouflage an imperfection or
achieve an effect. For example, it’s common to blur a portrait
to achieve a dreamy effect or downplay skin imperfections. Or,
you can blur certain parts of an image to call attention to the
main subject of the image. The steps here explain how to blur
an area in an image, which reduces the sharpness of any edges
or reduces detail in the affected area.

1. Click on the layer in the
Layers palette that holds the
content you want to blur. 
The selected layer will become
the active layer.

2. Use the Navigator to zoom
in on and display the desired
area. The selected area will
become more visible.

3. Click on the Blur tool in the toolbox. The Blur tool will
become the active tool.
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NOTE
Photoshop includes filters that correspond with the
capabilities of many of the tools described in this chapter.
Use a filter when you want to change the appearance of a
selection or a layer. Use a tool when you want to “paint”
on a particular area to make a correction.

NOTE
Most of the tools
described in this chapter
cannot be used on a type
layer.



4. Choose a Brush style on the options bar. The selected
brush will become active for the Blur tool.

5. Make a choice from the
Mode drop-down list on the
options bar. The selected mode
will become active for the Blur
tool.

6. Select the Strength text box
contents, type a new entry, and
press Enter. (Alternately, click
on the right arrow beside the
Strength choice, drag the slider,
and then click on the right arrow
again.) The strength setting will
become active for the Blur tool.

7. Drag on the layer to apply
the blur. Blurring will begin to
appear.
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NOTE
To choose a brush for any
tool, click on the down
arrow beside the Brush
choice in the options bar,
click on the brush to use,
and then click on the
down arrow beside the
Brush choice to close the
drop-down palette. If you
click on the right arrow
button in the palette of
brushes, you can use the
menu that appears to load
other brushes.



8. Drag as much as is needed. Photoshop will continue to
add more blurring, but it may take quite a bit of dragging.
When you finish, you can continue working with another tool or
operation in Photoshop.

Smudging an
Area
The Smudge tool helps you drag
color from one area into another,
much as you could with a
paintbrush full of wet paint. You
can use the smudge tool to add
a painted effect in a very specific
area of the image. Smudging
resembles blurring, but has a
much more dramatic effect.
Follow the next set of steps to
practice smudging.

1. Click on the layer in the
Layers palette that holds the
content you want to smudge.
The selected layer will become
the active layer.
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NOTE
The Blur tool can be quite
subtle, but if you compare
the outline of the bunch of
bananas in the last screen
shot with the prior two,
you can see the blurring
that’s been applied
around the bananas.



2. Use the Navigator to zoom
in on and display the area to
smudge. The selected area will
become more visible.

3. Right-click on the Blur tool
in the toolbox. A submenu will
appear.

4. Click on Smudge Tool. The
Smudge tool will become the
active tool.

5. Choose a Brush style on the options bar. The selected
brush will become active for the Smudge tool.

6. Make a choice from the
Mode drop-down list on the
options bar. The selected mode
will become active for the
Smudge tool.

7. Select the Strength text box
contents, type a new entry, and
press Enter. (Alternately, click
on the right arrow beside the
Strength choice, drag the slider,
and then click on the right arrow
again.) The strength setting will
become active for the Smudge
tool.
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8. Drag on the layer over two
contrasting colors to make the
smudge. Smudging will begin to
appear. When you finish creating
all the needed smudges, you can
continue working with another
tool or operation in Photoshop.

Sharpening an Area
The Sharpen tool works in the opposite way as the Blur tool: It
tries to improve the focus of edges that are soft so that the
image appears clearer. So, for example, you might want to use
this tool if one small spot on a layer looks out of focus.
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NOTE
If you click on the Finger Painting check box in the
options bar to check it, dragging with the Smudge tool
will paint using the currently selected foreground color.

NOTE
You can make the effects
of the Blur, Smudge, or
Sharpen tool partially
transparent after you use
the tool. To do so, click on
Edit, and then click on
Fade (Tool Name). Specify
an Opacity setting in the
Fade dialog box that
appears, and then click on
OK.



1. Click on the layer in the
Layers palette that holds the
content you want to sharpen.
The selected layer will become
the active layer.

2. Use the Navigator to zoom
in on and display the area to
sharpen. The selected area will
become more visible.

3. Right-click on the Blur tool
in the toolbox. A submenu will
appear.

4. Click on Sharpen Tool. The
Sharpen tool will become the
active tool.
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5. Choose a Brush style on the options bar. The selected
brush will become active for the Sharpen tool.

6. Make a choice from the
Mode drop-down list on the
options bar. The selected mode
will become active for the
Sharpen tool.

7. Select the Strength text box
contents, type a new entry, and
press Enter. (Alternately, click
on the right arrow beside the
Strength choice, drag the slider,
and then click on the right arrow
again.) The strength setting will
become active for the Sharpen
tool.

8. Click or drag on the layer to
apply the sharpening.
Sharpening will begin to appear.
When you finish adding all the
needed sharpening, you can
continue working with another
tool or operation in Photoshop.
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Erasing Image Content
Photoshop offers three different eraser tools so that you can
achieve exactly the erasing effect that you need in any
particular situation.

Using the Eraser
The standard Eraser tool erases color or content on a layer,
enabling the background layer in the image to show through to
varying degrees, depending on the opacity you specify. If
you’re working on the background layer itself, using the
standard Eraser actually paints or draws the currently selected
background color rather than erasing layer content. The
following steps show an example of each of these uses for the
Eraser.
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NOTE
If you use a large, sharp brush and a higher Strength
setting with the Sharpen tool, clicking or dragging can
have unwanted effects beyond sharpening—the color of
pixels outside the area to be sharpened may be changed
dramatically. Even though the impact of sharpening can
be subtle, you still want to use the Sharpen tool
sparingly to avoid those unwanted changes.

CAUTION
The Eraser tools don’t work on shape layers. To work
around this issue, create a new layer using the Layer,
New, Layer command. Choose the shape layer in the
Layers palette, and select and copy its content using the
Edit, Copy Merged command. Then choose the new
layer you created in the Layers palette and use the Edit,
Paste command to paste the content onto it. You can
then delete the shape layer and erase as needed on the
new layer. 



1. Click on the layer in the Layers palette that holds the
content you want to erase. (In this case, click on any regular
layer except the background layer.) The selected layer will
become the active layer.

2. Use the Navigator to zoom
in on and display the area to
erase. The selected area will
become more visible.

3. Click on the Eraser tool. The
Eraser tool will become the
active tool.

4. Make a choice from the Mode drop-down list on the
options bar. The selected mode will become active for the
Eraser tool.

5. Choose a Brush style on the
options bar. The selected brush
will become active for the Eraser
tool. Note that selecting certain
brush styles enables airbrush
capabilities for the Eraser tool. 
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NOTE
Because the Mode choice
affects the available Brush
choices in this case,
choose the Mode first. If
you choose the Block
mode, you cannot choose
a brush shape. 
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6. Select the Opacity text box contents, type a new entry,
and press Enter. (Alternately, click on the right arrow beside
the Opacity choice, drag the slider, and then click on the right
arrow again.) The opacity setting will become active for the
Eraser tool. 

7. If available, select the Flow
text box contents, type a new
entry, and press Enter.
(Alternately, click on the right
arrow beside the Flow choice,
drag the slider, and then click on
the right arrow again.) The flow
setting will become active for
the Eraser tool, controlling how
quickly the eraser works. 

8. Click or drag on the desired
layer. Photoshop will erase the
current layer’s content and
reveal the content on the
background layer.
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TIP
Checking Erase to History on the options bar makes the
Eraser tool restore the area over which you drag to the
state (appearance) it had when you last saved the file.



9. Click on the background
layer in the Layers palette. The
background layer will become
the active layer.

10. Press and hold the Alt
key, then click on the desired
background color in the color
ramp at the bottom of the Color
palette.

11. Drag on the background
layer. The Eraser tool will paint
the selected background color
on the background layer. When
you finish using the Eraser tool,
you can continue working with
another tool or operation in
Photoshop.
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NOTE
If pressing Alt and clicking selects the foreground color
instead, click on the Set Background Color color chip or
box near the left side of the Color palette, and then
Alt+click on the desired background color.



Using the Background Eraser
The Background Eraser tool erases the content on any layer,
including both the foreground and background colors on the
layer. Areas you erase with this tool become transparent, so

that content on other layers in
the image can show through. If
the image has only one layer, or
if you’re erasing the background
layer and there’s no content in
front of it, then the areas erased
with this tool will be transparent
if the image file is placed in a
document.

1. Click on the layer in the
Layers palette that holds the
content you want to erase. 
The selected layer will become
the active layer.

2. Use the Navigator to zoom
in on and display the area to
erase. The selected area will
become more visible.

3. Right-click on the Eraser
tool. A shortcut menu will
appear.

4. Click on Background Eraser
Tool. The Background Eraser
tool will become the active tool.
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5. Click on the Brush style on the options bar. A palette of
brush options will appear.

6. Make Diameter, Hardness,
Spacing, Angle, and Roundness
choices in the palette. The
selected choices will affect the
shape of the eraser brush as
follows:

• Diameter. Enables you to
specify the size of the brush
(the area to be erased).

• Hardness. Enables you to
specify the size of the brush’s
hard center, as a percentage
of the total diameter.

• Spacing. If you want erasure
brush strokes to be noncontiguous as you erase, increase
this setting to add spacing or skips.

• Angle. This setting works with the Roundness value you’ve
specified to tip the brush shape. You can either enter a
value in the Angle text box or drag the arrow axis on the
brush preview. 

• Roundness. Enables you to specify whether a brush is
round. Decrease this value to less than 100% to decrease
roundness.
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NOTE
Use the bottom two settings, Size and Tolerance, to
further control the brush when you’re using a graphics
tablet with Photoshop.



7. Click the Brush style down arrow. The palette of brush
settings will close.

8. Make Limits, Tolerance, and
Sampling choices on the options
bar. The selected choices will
affect the erasing as follows:

• Limits. Controls how far the
erasing can spread, based on
dragging over similar colors.

• Tolerance. Controls whether
the eraser will erase only
pixels of alike colors (lower
settings) or similar colors.

• Sampling. Determines
whether erasing tests
matching colors continuously
or by the color initially
selected.

9. Click or drag on the layer to
erase. Photoshop will erase the
current layer’s content, leaving a
transparent area behind.
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Using the Magic Eraser
Use the Magic Eraser tool when you want to erase a
contiguous area of color on a layer. You can either completely
erase the area of color or make the erasure less opaque so that
only part of the color area is erased.

1. Click on the layer that holds
the content to erase in the
Layers palette. The selected
layer will become the active
layer.

2. Use the Navigator to zoom
in on and display the area to
blur. The selected area will
become more visible.

3. Right-click on the Eraser
tool. A shortcut menu will
appear.

4. Click on Magic Eraser Tool.
The Magic Eraser tool will
become the active tool.
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5. Make a Tolerance entry on the options bar. The specified
setting will become active for the Magic Eraser tool. Lower
settings will tell the tool to erase only colors that are a closer
match; higher settings will enable the tool to erase less similar
colors.

6. Select the Opacity text box
contents, type a new entry, and
press Enter. (Alternately, click
on the right arrow beside the
Opacity choice, drag the slider,
and then click on the right arrow
again.) The Opacity setting will
become active for the Magic
Eraser tool.

7. Click or drag on the area with the color to erase on the
current layer. Photoshop will erase the selected color and any
matching adjacent areas, applying transparency if specified.

277ERASING IMAGE CONTENT

TIP
To make a Tolerance
entry, drag over the
contents of that text box,
type a new entry, and
press Enter.

TIP
No matter what types of changes you’re making, don’t
forget to save your file from time to time.



Adding a Gradient
You can add a gradient onto most layers, except for layers that
hold text. The gradient blends the colors you specify, so you
may have a bit more flexibility when you use this method to
add a gradient, as opposed to inserting a gradient fill layer as
described in Chapter 8 in the section called “Adding a
Gradient Layer.” For example, you can add the gradient within
the selection on a layer. These steps describe how to use the
Gradient tool.

1. Click on the foreground
color for the gradient on the
color ramp in the Color palette.
The selected color will become
the foreground color (first color)
for the blend.

2. Press and hold the Alt key,
and click on the background
color for the gradient on the
color ramp in the Color palette.

3. Click on the layer to which
you want to add the gradient in
the Layers palette. The selected
layer will become the active
layer.
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4. If you want to fill a particular
area with a gradient, select the
area first (either manually or with
a path) or use a mask to prevent
Photoshop from displaying the
gradient in the affected area.

5. Click on the Gradient tool in the toolbox. The Gradient
tool will become the active tool.

6. Click on a gradient style
button. (The available choices
include Linear Gradient, Radial
Gradient, Angle Gradient,
Reflected Gradient, and
Diamond Gradient.) Photoshop
will apply the selected style.

7. Select the Opacity text box
contents, type a new entry, and
press Enter. (Alternately, click
on the right arrow beside the
Opacity choice, drag the slider,
and then click on the right arrow
again.) The Opacity setting will
become active for the Gradient
tool.
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8. Drag on the layer to set the
angle or center point for the
gradient (depending on the style
you selected in Step 6).
Photoshop applies the gradient
immediately.
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NOTE
If needed, click on the down arrow beside the Gradient
Picker box, and then click on a new gradient to use.
Photoshop will apply the selected gradient and its
colors. If you click on the Gradient Picker box itself, the
Gradient Editor dialog box opens. You can use it to edit
the gradient style, or click on the arrow button at the top
right of the Presets section of the dialog box and then
click on a choice at the bottom of the submenu that
appears to see other gradient possibilities.

NOTE
Changing the Mode setting can allow the Gradient tool
(and the Paint Bucket tool, described in the next section)
to apply a different behavior, such as dissolving the
image.TE
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9. Review the results. (If you
made a selection, you can
deselect it first.) As with other
types of effects you create, the
gradient interacts with other
content on the layer, blending
with that content if the gradient
wasn’t 100% opaque. Note that
in this instance, because the text
and leaf images appear on
separate layers and those layers
are in the front of the image, the
gradient doesn’t fill or overlay
the content of the other layers.
After you finish the gradient, you
can work with another tool or
operation in Photoshop.

Filling with the Paint Bucket
Use the Paint Bucket tool to fill a contiguous area of color (or
similar colors) with the current foreground color.
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CAUTION
The Paint Bucket tool doesn’t work on shape layers. To
work around this issue, create a new layer using the
Layer, New Layer command. Choose the shape layer in
the Layers palette and select and copy its content using
the Edit, Copy Merged command. Then choose the new
layer you created in the Layers palette and use the Edit,
Paste command to paste the content onto it. You can
then delete the shape layer and erase as needed on the
new layer. 



1. Click on the foreground
color for the fill on the color
ramp in the Color palette. The
selected color will become the
fill color for the Paint Bucket
tool.

2. Click on the layer in the
Layers palette that includes the
area you want to fill. The
selected layer will become the
active layer.

3. Right-click on the Gradient
tool in the toolbox. A shortcut
menu will appear.

4. Click on Paint Bucket Tool.
The Paint Bucket tool will
become the active tool.
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TIP
If you want to fill a particular area with the selected
color, select the area first (either manually or with a path)
on the layer, and then click in the selection later to fill it.



5. Select the Opacity text box contents, type a new entry,
and press Enter. (Alternately, click on the right arrow beside
the Opacity choice, drag the slider, and then click on the right
arrow again.) The Opacity setting will become active for the
Paint Bucket.
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TIP
If you want to use the Paint Bucket to fill an area with a
pattern, choose Pattern from the Fill drop-down list, and
then choose a pattern from the Pattern drop-down list.
The steps in the section called “Adding a Pattern Layer”
in Chapter 8 explain how to save a pattern choice based
on an image selection.



6. Select the Tolerance text
box contents, type a new entry,
and press Enter. The Tolerance
setting will become active for
the Paint Bucket tool.
(Remember, tolerance refers to
how carefully a tool must match
the color of the area on the
selected layer you click on in
order to identify which pixels to
fill or erase.)

7. Click on the area to fill with
the foreground color you
selected. Photoshop applies the

gradient immediately. Even if the layer includes other areas
with the same color, those areas will not be filled if they are
not contiguous. After you finish filling, you can work with
another tool or operation in Photoshop.

Using Photo Techniques
One of the past benefits of using a professional photographer
was the photographer’s (or the photo lab’s) ability to
manipulate lighting—both when shooting the initial photo and
when creating the prints. The Dodge, Burn, and Sponge tools
in Photoshop help you mimic a photographer’s tricks in
correcting lighting in an image. The Healing Brush and Patch
tools help you repair an image, such as a scanned image of a
photo with spots, scratches, and other blemishes. 

Dodging an Area
Use the Dodge tool to lighten an area that’s too dark in your
image. In the case of scanned content or a photo downloaded
from a digital camera, dodging can actually reveal detail that
previously wasn’t visible in the image. Follow these steps to
work with dodging.
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1. Open the image to correct and select the desired layer
and zoom, if needed. The image (and layer) will become active
or current.

2. Click on the Dodge tool in
the toolbox. The Dodge tool will
become the active tool.

3. Choose options on the
options bar as needed. The
options for the Dodge tool are:

• Brush. Designates the brush
style for the tool.

• Range. Specifies whether the
Dodge tool affects shadows,
midtones, or highlights in the
areas over which you drag.

• Exposure. Identifies how
much of a change the Dodge
tool makes as you drag.

• Airbrush. This button enables the airbrush effect for the
tool.

4. Click on or drag over the area(s) to dodge. Photoshop
makes the corrections immediately. After you finish dodging,
you can work with another tool or operation in Photoshop.

Burning an Area
The Burn tool has the opposite impact as the Dodge tool.
Burning darkens an area in the image, as if more light were
directed to that area when the “photo” was being developed.
You can use burning to help balance an area that seems weak
or too light in an image, or to emphasize a particular area. In
the case of a color image, burning can intensify the color in an
area and make it stand out from its background a bit more.
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1. Open the image to correct
and select the layer to burn, if
needed. The image (and layer)
will become active or current.

2. Right-click on the Dodge
tool in the toolbox. A shortcut
menu will appear.

3. Click on Burn Tool. The Burn tool will become the active
tool.

4. Choose options on the
options bar as needed. The
options for the Burn tool are:

• Brush. Designates the brush
style for the tool.

• Range. Specifies whether the
Burn tool affects shadows,
midtones, or highlights in the
areas over which you drag.

• Exposure. Identifies how
much of a change the Burn
tool makes as you drag.

• Airbrush. This button enables
the airbrush effect for the
tool.
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TIP
Use the Navigator
whenever you need to
zoom in on the area to
correct with a tool.



5. Click on or drag over the
area(s) to burn. Photoshop
makes the corrections
immediately. After you finish
burning, you can work with
another tool or operation in
Photoshop.

Sponging an Area
The Sponge tool (sponging) changes color saturation in a color
image and contrast in a grayscale image. In either case, using
the Sponge tool helps make the area you’re correcting appear
more bright or crisp, to help it stand out from surrounding
content in the image.

1. Open the desired image and
select the layer to correct, if
needed. The image (and layer)
will become active or current.

2. Right-click on the Dodge
tool in the toolbox. A shortcut
menu will appear.

3. Click on Sponge Tool. The
Sponge tool will become the
active tool.
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4. Choose options on the
options bar as needed. The
options for the Sponge tool are:

• Brush. Designates the brush
style for the tool.

• Mode. Specifies whether the
Sponge tool saturates (adds
more color intensity) or
desaturates (decreases color
intensity) in the area you drag
over.

• Flow. Identifies how much of
a change the Sponge tool
makes as you drag.

• Airbrush. This button enables the airbrush effect for the
tool.

5. Click on or drag over the area(s) to sponge. Photoshop
makes the corrections immediately. After you finish sponging,
you can work with another tool or operation in Photoshop.

Using the Healing Brush
Spots, scratches, pen marks, and more can all mar an image.
Fortunately, Photoshop 7 introduces the Healing Brush tool,
which you can use to repair imperfections much more easily
than was possible in the past. With the Healing Brush tool, you
sample an area that resembles the flaw to fix, and then paint
over the flaw. Follow these steps to try this outstanding tool.
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1. Open the desired image and
select the layer to correct. The
image (and layer) will become
active or current. Zoom in, if
needed.

2. Click on the Healing Brush
tool. The Healing Brush tool will
become the active tool.

3. Click on the Brush style on the options bar. A palette of
brush options will appear.

4. Make Diameter, Hardness,
Spacing, Angle, and Roundness
choices in the palette. The
selected choices will affect the
shape of the Healing Brush tool
as follows:

• Diameter. Enables you to
specify the size of the brush
(the area to be “healed”).

• Hardness. Enables you to
specify the size of the brush’s
hard center, as a percentage
of the total diameter.

• Spacing. If you want erasure
brush strokes to be
noncontiguous as you heal,
increase this setting to add
spacing or skips.
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• Angle. This setting works with the Roundness value you’ve
specified to tip the brush shape. You can either enter a
value in the Angle text box or drag the arrow axis on the
brush preview. 

• Roundness. Enables you to specify whether a brush is
round. Decrease this value to less than 100% to decrease
roundness.

5. Click on the Brush style down arrow. The palette of brush
settings will close.

6. Click on the Sampled option
button to select it, if needed.
The Healing Brush tool will use
the area you sample in the image
to make the needed repair.

7. Alt+click on the area to
sample. (Of course, you should
sample an area that looks like
the area to patch.) The target
mouse pointer will appear to
verify that you are sampling, and
the sample will be loaded after
you click. 
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NOTE
Use the bottom setting, Size, to further control the brush
when you’re using a graphics tablet with Photoshop.
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8. Click again or drag on the
area to repair. Photoshop will
cover the flaw using the sampled
content.

9. Review the results.
Depending on how close the
sample was to the area to be
repaired, the repair should be
totally or nearly impossible to
see.
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Patching a Flaw
Use the new Patch tool to increase the speed with which you
can make even more complicated repairs. With this tool, rather
than painting over an area with sampled material, you select a
patch area from the image and then drag that patch over the
area to repair. This tool works particularly well when the area
to repair has a pattern, striping, or some other type of texture
that the Healing Brush tool cannot capture. Use the following
steps to create a patch and use it to repair an image. 

1. Open the desired image and select the layer to correct.
The image (and layer) will become active or current. Zoom in, if
needed.

2. Right-click on the Healing
Brush tool in the toolbox. A
shortcut menu will appear.

3. Click on Patch Tool. The
Patch tool will become the active
tool.
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4. Click the Destination option button on the options bar.
This will set up the Patch tool so that you will first select the
sample to use as the patch, and then drag it over the area to
be patched.

5. Drag on the image to select
the source area (patch). The area
you drag around will be selected
so that you can use it as the
patch.

6. Drag the patch from the source location over the flaw;
release the mouse button only when you’ve positioned the
patch as needed. The patch will cover the flaw.
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TIP
As long as the patch
remains selected, you can
move it and reposition it.
You also can rotate the
patch (Edit, Transform,
Rotate) and make other
changes to ensure a
precise fit.

TIP
It’s important to select a
patch source area that’s
large enough to cover the
flaw, but not so large that
it will cover nonmatching
areas around the flaw.



7. Click on Select. The Select
menu will appear.

8. Click on Deselect. The 
patch selection marquee will
disappear.

9. Review the results.
Depending on how close the
patch was to the area to be
repaired, the repair will be
totally or nearly impossible to
see.
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When you create a new image file, you specify its size. When you
import an image from a scanner or digital camera, you have less
control over the size and orientation of the image. In either case, you
can use some tricks to tweak the size and orientation of the image so
that it suits your purpose. In this chapter, you’ll learn how to:

Use the Crop tool to crop an image

Resize the image

Adjust the image canvas

Rotate the entire canvas

Trim the edges of the image

1212
Working with Image
Size and Orientation
Working with Image
Size and Orientation



Cropping the Image
When you crop the image, you select the area of the image
that you want to keep, and then have Photoshop hide or
remove the unselected portions of the image. You can crop if
an image’s subject is off-center, if you need to eliminate a
distracting element from the image, or if you need to fit the
image to a particular height and width.

1. Click on the Crop tool on the toolbox. The Crop tool will
become active.

2. Make entries in the Width
and Height text boxes, if
needed. When you use these
text boxes, Photoshop will resize
the cropped material to the
specified dimensions (in addition
to performing the crop).

3. Make an entry in the Resolution text box, if needed. If
you make an entry, Photoshop will resample the cropped
material to the specified resolution.
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NOTE
Enter the abbreviation for
inches, in, in the Width
and Height text boxes
unless you want to specify
the measurement in pixels
(px).

TIP
Clicking on Front Image loads the current image
dimensions into the text boxes.



4. Drag on the image. This will
select the area to keep; the area
outside the selection will be
shielded or grayed out.

5. Adjust shielding settings, if needed. Photoshop will
change the temporary shading used to mask the areas to be
cropped out of the image.

6. Click on the Perspective
check box, if needed. This will
enable perspective cropping, so
that you can add perspective
while cropping.

7. Drag the crop selection to
resize or rotate the crop zone.
Dragging a corner will resize the
crop zone; dragging a side will
rotate the crop zone.
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NOTE
If you click the Crop tool again at this point, a message
box appears to ask whether you want to crop the image.
You can click on Crop to proceed, Cancel to stop the
crop operation, or Don’t Crop to remove the cropping
selection.

NOTE
If you’ve selected part of the image with a selection tool,
you can click on Image and then click on Crop to display
the Crop dialog box. Click on an option button to
determine whether the cropped out areas should be
Hidden or Deleted, and then click on OK to apply the
crop.

8. Click on the Commit (check)
button on the options bar or
press Enter. Photoshop will crop
the image to the specified zone.
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Changing the Image Size
You can resize an image file when you want to both fit the image
to a particular size and keep all of the content in the image.
Resizing the image also gives you the opportunity to resample i t ,
or change the resolution (pixels per inch) in the image. 

1. Click on Image. The Image menu will appear.

2. Click on Image Size. The
Image Size dialog box will open.
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TIP
Although either increasing or decreasing the resolution
can degrade image quality, in general more pixels per
inch leads to better image quality.

TIP
To see the current image size before you display the
Image Size dialog box, press and hold the Alt key, and
click and hold on the Doc size indicator near the bottom-
left corner of the Photoshop window.



3. Enter a new Width or Height under either Pixel
Dimensions or Document Size. Photoshop will adjust the other
three text box entries to keep them proportional.

4. Enter a new Resolution.
Photoshop will apply the new
resolution setting.

5. Click on Auto. The Auto Resolution dialog box will open.
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TIP
Click on the Constrain
Proportions check box to
clear the check if you want
to resize only one image
dimension. Otherwise,
changing a Height entry
automatically adjusts the
Width, and vice versa.

TIP
Use the Resample Image drop-down list to choose
another resampling method for faster (but less accurate)
resampling. Or, click on the Resample Image check box
to clear it and disable resampling. Doing so constrains
the image height, width, and resolution; you can change
any one of those settings and Photoshop adjusts the
others accordingly. 
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6. Make a new Screen text box entry and choose another
measure from the Screen drop-down list, if needed.
Photoshop will apply the designated line screen settings when
you finish resizing the image.

7. Click on a Quality option.
Photoshop will apply the new
quality setting.

8. Click on OK. The Auto
Resolution dialog box will close.
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NOTE
The settings in the Auto Resolution dialog box affect the
image if you plan to include it in a document that will be
professionally printed. These settings are less important
if you’ll be using the image online or merely printing it
from your own printer.



9. Click on OK. The Image Size
dialog box will close and
Photoshop will resize and
resample the image as specified.

Changing the Canvas Size
The canvas size and image size always use the same
dimensions. Thus, changing the canvas size changes the image
size, but not in the same way that using the Image Size
command does. When you change to a canvas size that’s
smaller than the current image/canvas size, Photoshop crops
out part of the image. When you change to a canvas size that’s
larger than the current image/canvas size, Photoshop adds
white space to the image. (If the image has a filled background,
the fill color fills the added space.)
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1. Click on Image. The Image
menu will appear.

2. Click on Canvas Size. The
Canvas Size dialog box will open.

3. Enter a new Width and/or Height, and choose another
measurement unit for each, if needed. Photoshop will display
the projected New Size for the image above those
measurements.

4. Click another Anchor point,
if needed. When you’re
increasing the canvas size, the
selected anchor point will control
where white space will be added
around the image. When you’re
decreasing the canvas size, the
selected anchor point will
designate which part of the
image to keep and which to crop
out.

5. Click on OK. Photoshop will
apply the new canvas size, unless
it needs to display a warning
regarding the size change, as
shown in Step 6.
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6. Click on Proceed in the
warning dialog box, if it appears.
Photoshop will finish resizing the
canvas.

Rotating the Canvas
You can rotate the canvas to rotate the entire image—all the
content on all the layers. Photoshop provides these rotation
options:

• 180°. Rotates the canvas so that the top of the image
becomes the bottom.

• 90° CW. Rotates the canvas one quarter turn in the
clockwise direction.

• 90° CCW. Rotates the canvas one quarter turn in the
counterclockwise direction.

• Arbitrary. Displays the Rotate Canvas dialog box so that
you can specify a precise rotation amount and direction.

• Flip Canvas Horizontal. Flips the image right to left.

• Flip Canvas Vertical. Flips the image top to bottom.

Use the following steps when you’re ready to rotate the image.
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1. Click on Image. The Image
menu will appear.

2. Point to Rotate Canvas. The
Rotate Canvas submenu will
appear.

3. Click on a Rotation choice. If
you chose anything but
Arbitrary, Photoshop will apply
the rotation immediately.
Otherwise, the Rotate Canvas
dialog box will appear.

4. Type an entry in the Angle text box. Your entry will specify
how much rotation Photoshop applies.

5. Click on the °CW or °CCW
option. You choice will specify
either the clockwise or
counterclockwise rotation
direction.

6. Click on OK. Photoshop will
rotate the image as specified by
the rotation settings you
entered.
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Trimming the Canvas
You can use the trim feature to crop out unneeded information
around the edge of an image, such as a white photo print
border; blank canvas space that’s no longer needed; or
discolored areas around an image from a contact sheet fading
or folding. For the trim feature to work, the area to be
trimmed must all be the same color.

1. Click on Image. The Image menu will appear.

2. Click on Trim. The Trim
dialog box will open.
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3. Click on a Based On option
button. Photoshop will use the
specified setting to identify
which pixels to trim from the
image.

4. Click on the Trim Away
check boxes as needed. Clearing
a Trim Away check box tells
Photoshop not to trim the
designated portion of the image.

5. Click on OK. Photoshop will
perform the image trim.
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You can think of a filter as a special effect. When you apply the
filter, Photoshop makes changes to the image or selection that might
otherwise take you numerous steps to create or that might not even
be possible. A plug-in can correct problems or lend a completely
different appearance in the image. This chapter enables you to:

Understand the available filters

Apply a filter when you need it

Adjust the filter

Use the last filter again
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Previewing the Filters
The default Photoshop installation installs dozens of filters. The
Filter menu groups the filters on several submenus. Table 13-1
lists the submenus and gives a description of the types of
filters found in each submenu group.
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Table 13-1 Reviewing Filter Groups

Group Includes Filters That

Artistic Make the image look like it was created with watercolors or pastels, has a
film grain, poster edges, and so on.

Blur Add blurs to simulate movement, such as in a single direction or rotation.

Brush Strokes Apply a brush stroke effect in one of various available shapes.

Distort Give the appearance of natural or artificial distortions caused by shape and
light, such as a ripple, glass, or twirl effect.

Noise Apply noise (white speckling) to affect the image appearance, or fix spots
and scratches.

Pixelate Apply one of several dotted effects to the image, such as simulating the
Pointillism technique.

Render Let you change the fill, add a lighting effect, apply 3D, and more.

Sharpen Improve image sharpness.

Sketch Apply a drawing effect in one of various available techniques.

Stylize Make a number of changes, like glowing edges or embossing, that lend a
modern effect.

Texture Convert the image’s appearance to make it consistent with the selected
texture.

Video Change the color method used in a video still.

Other Create a custom filter or work with other custom filters.

NOTE
Plug-ins are generally additional filters that you can
install. See Chapter 18, “Working with Plug-Ins,” to learn
more about installing and using plug-ins.
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Applying a Filter
Applying some filters merely requires selecting the appropriate
filter command. The vast majority of filters, however, display a
dialog box with a preview that enables you to adjust and
preview the filter before applying it. Because the filter settings
vary to such a degree, the following steps provide an overview
of using a filter.

1. Open the image you want to adjust. The image will open in
a window in Photoshop.

2. Display the layer that holds
the image content to filter. The
selected layer’s content will
appear.

3. Use a selection tool to select
the desired image area, if
needed. A selection marquee will
appear.
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TIP
After you apply one filter, you can apply another to
blend filter effects.

NOTE
Photoshop applies the
filter effect only to the
current layer and current
selection (if any).



4. Click on Filter. The Filter
menu will appear.

5. Point to a filter submenu
name. The submenu will appear.

6. Click on a filter in the
submenu. Photoshop will either
apply the filter immediately, or
display the settings dialog box
for the filter.

7. Adjust dialog box settings as needed. The preview in the
dialog box adjusts to show what the filter will do to the image
or selection when applied.

8. Click on OK. The dialog box
will close and Photoshop will
apply the filter.
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NOTE
If the image doesn’t use
RGB color or is a
bitmapped, indexed, or
16-bit per channel image,
Photoshop won’t allow
you to apply a filter to it.
Consult Chapter 15,
“Understanding Colors
and Channels,” to learn
more about image color
modes.



Fading a Filter
Fading a filter enables you to make the filter effect more
transparent or adjust the light or color density for the filter
effect. Using the Fade capability gives you even greater control
over how the filter affects the image.

1. Display the layer that holds
the filtered image content. The
selected layer’s content will
appear.

2. Select the filtered area, if
needed. A selection marquee will
appear.
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NOTE
The Fade command may not be available for all filters. It
also is not available after you save and close the image;
you must use it during the current image editing session.
It is, however, available for some of the painting tools in
Photoshop, and works for those just as described here.

TIP
Name and save the
selection area before
applying a filter. (See
“Saving a Selection” and
“Loading a Selection” in
Chapter 6.) Then, you can
easily reload the selection
to fade or adjust the filter
settings.



3. Click on Edit. The Edit menu
will appear.

4. Click on Fade (Filter Name).
The Fade dialog box will open.

5. Drag the Opacity slider. The
Opacity setting will adjust
accordingly.

6. Click on the down arrow
beside the Mode list. The Mode
list will open.
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7. Click on a mode in the list.
The image or selection will
preview the selected Opacity
and Mode settings.

8. Click on OK. The dialog box
will close and Photoshop will
apply the fade.

Reapplying the Last Filter
You can apply the most recently used filter to another selection
or image. Using this shortcut applies the filter using the
settings for the filter that you selected when you previously
used the filter.

1. Open the image to adjust.
The image will open in a window
in Photoshop.

2. Display the layer that holds
the image content to filter and
use a selection tool to select the
desired image area, if needed.
The selected layer’s content will
appear, and a selection marquee
will appear.
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3. Click on Filter. The Filter
menu will appear.

4. Click on the filter at the top
of the menu. Photoshop will
apply the filter immediately.
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NOTE
If you’re applying the filter
to an entire layer and the
image is large, it can 
take a few minutes for
Photoshop to process the
filter application.

TIP
You can press Ctrl+F (that is, press and hold the Ctrl key,
press the F key, and release both keys) to reapply the
last filter. Reapplying the same filter enables you to
achieve a consistent look among different selections or
images.



In most environments, you’ll use a local or network printer to print your
image file so you can check your work (or use the image as intended).
Photoshop adds a number of printing features that you may not have
seen before if your previous computer experience has been limited to
word processors and spreadsheets. This chapter helps you explore the
printing possibilities in Photoshop and shows you how to:

Choose the printer to use

Choose a screen setting for traditional printing

Choose print scaling options

Use transfer settings to correct certain color problems

Add a border, bleed, or background for the printout

Print with other special marks and features

Send the print job

Print multiple copies of an image on a page with the Picture Package
feature
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Choosing a Printer and Page
Setup
Stating the obvious, different printers offer different
capabilities. You may have a black-and-white laser printer for
basic document printouts and image proofing, and a color
printer for sales documents and final image printouts. You
need to select the printer to use to print the current image
from among those installed on your system, as described here.
Once you’ve selected the printer, you can set available page
setup options, which will vary depending on the capabilities of
the printer. For example, the software with many printers now
calculates margins for you, so the margin choices may be
disabled in the Page Setup dialog box. 

1. Click on File. The File menu will appear.

2. Click on Page Setup. The
Page Setup dialog box will open.
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3. Click on the Printer button.
Another Page Setup dialog box
will open. 

4. Click on the down arrow
beside the Name drop-down list.
The Name drop-down list will
open.

5. Click on the desired printer
in the list. The printer will
become the active printer.

6. Click on Properties. The
Properties dialog box for the
selected printer will appear.
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7. Choose options for the
printer as needed. The choices
will become the active choices.

8. Click on OK. Your printer settings will take effect and the
Properties dialog box will close.

9. Click on OK. Your printer
selection will take effect and the
second Page Setup dialog box
will close.
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NOTE
Of course, the available
properties will vary
depending on the
capabilities and driver
software for the printer
you selected in Step 5, so
it’s not possible to cover
available settings in detail.
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10. Choose other settings as
needed. The available settings
include:

• Paper. Choose a paper Size
and Source (the tray or feeder
holding the desired paper in
your printer).

• Orientation. Choose Portrait
(short edges of the paper at
the top and bottom) or
Landscape (short edges of
the paper at the left and right)
to indicate how the printer will
orient the paper.

• Margins. For most printers, these settings will be grayed out
(disabled) and will be calculated based on other print
settings you select in Photoshop. If these settings are
available, you can enter a new Left, Right, Top, or Bottom
margin setting. 

11. Click on OK to finish. The printer settings (and any other
Page Setup settings) will take effect.
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NOTE
The available paper sizes vary depending on the selected
printer. You also can change the paper size in the
Properties dialog box for your printer, which you open
by clicking on the Properties button beside the selected
printer. Notice that you don’t need to change the Source
drop-down list choice unless your printer has multiple
paper trays or doesn’t switch trays automatically.



Changing the Print Settings
Photoshop offers a variety of other print settings via the Print
with Preview command on the File menu. These settings have
an impact on how Photoshop prepares an image for printing
from your printer for output by a professional print shop (or for
inclusion in a document that will be output professionally). In
the dialog box where you work with these print settings, a
preview image shows the impact of your choices, helping you
to better fine-tune the printout. This section shows you how to
find the various settings you may need to prepare the current
image for printing.

Centering and Scaling the
Image
For each printout, you can choose how to position the image
on the paper relative to the edges of the paper. You also can
scale the image to a larger or smaller size so it better fits the
paper. (Note that the scaling is only a temporary printing
change and does not affect the size of the saved image.) The
next steps review the options for positioning and scaling the
image.
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NOTE
You must save an image to save your print setup choices
for it. Use the Save As command on the File menu to
save a Photoshop file as an EPS file. The section called
“Saving to Another Format” in Chapter 2 explains how
to save a Photoshop file in another format.



1. Click on File. The File menu
will appear.

2. Click on Print with Preview.
A large Print dialog box will
open. (A different Print dialog
box appears when you choose
the File, Print command.) 

3. Click on the Center Image check box to clear it. The Top
and Left choices will become active.

4. Specify Top and Left entries
and measurement units. The
image will reposition on the
paper as specified.
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TIP
If you change the image
position on the paper, it
looks best to allow a little
more space below the
image than above it.



5. Change the Scale text box
entry if you want to increase or
decrease the size of the image in
the printout. The image will
resize accordingly.

6. Click on Done. The Print
dialog box will close.
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NOTE
If you scale the image, you
may need to readjust the
Top and Left position
entries when the Center
Image check box is
unchecked. You also can
drag the image in the
preview area to adjust its
position if the Show
Bounding Box check box
is checked.



Working with Screens
A screen (or halftone screen) controls the size, shape, and
alignment of the dots of black or colors that print during a
printout. For full-color printing, the CMYK (cyan, magenta,
yellow, and black) screens each must be set to a particular
angle, so that the screens don’t overlap but do align properly.
When printing to your own printer, you typically will not need
to change screen settings, because your printer will handle
screening for you according to its individual capabilities.
However, if you plan to have the image professionally printed
or will be saving the image as an .EPS file for professional
printing or printing from a PostScript printer, you may need to
adjust the screens as described next. Consult the print shop
you’ll be using for the correct screen settings.

1. Click on File. The File menu
will appear.

2. Click on Print with Preview.
The Print dialog box will open.
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3. Click on the Show More
Options check box to check it.
The Print dialog box will expand
and display additional options.

4. Click on Screen. The
Halftone Screens dialog box will
open.

5. Click on the Use Printer’s Default Screens check box to
clear it. The other screen settings in the dialog box will become
active.

6. Choose an ink color from
the Ink drop-down list. The
settings you set next will apply
to the selected color.

7. Choose screen settings for
the selected ink as follows:

• Frequency. Your entry in this
text box (and your selection
from the accompanying
measurement drop-down list)
will determine how large or
fine the screen size (ink dots)
are. A higher Frequency
setting results in a more fine
screen for smoother printing.

326 CHAPTER 14:  PRINTING YOUR IMAGE



• Angle. Your entry in this text
box will specify the alignment
of the screen for the selected
color. Each color screen must
use a different angle.

• Shape. Your choice from this
drop-down list will control the
shape of the ink (toner) dots
created by the screen.

8. Repeat Steps 6 and 7 to choose screen settings for other
ink colors. The choices you make will become active for the
current image.
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NOTE
Again, consult your print shop for the correct screen
settings. If you use the wrong Angle settings, in
particular, your image will have an undesirable
patterning called moiré, which occurs when the various
screens don’t align properly. Also note that you can use
the Save and Load buttons in the Halftone Screens
dialog box to save and load the appropriate settings
required by various print vendors. You enter the
necessary settings (communicated by your print vendor)
and then save them. Then you can use the Load button
to load them for any future projects you send to that
print vendor. 



9. Click on OK. The Halftone
Screens dialog box will close.

10a. Click on Done to finish at
this time. The print settings  will
take effect.

OR

10b. Choose other settings as
described in the rest of this
section, and then click on Done
to finish. The new settings
you’ve selected will take effect.
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Adjusting Transfer Settings
The transfer settings are for use only when you’re printing an
image to film for professional full-color printing or saving a
Photoshop file to the .EPS format for that purpose, so most
users will never need to change these settings. You would
change the transfer settings if the ultimate output device has
problems with dot gain and dot loss (ink color dots growing or
shrinking), meaning that the device isn’t calibrated properly. If
your print shop asks you to change the transfer settings for an
image, the following steps lead you through the choices for
doing so.

1. Click on File. The File menu will appear.

2. Click on Print with Preview.
The Print dialog box will open.
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3. Click on the Show More
Options check box to check it, if
needed. The Print dialog box will
expand and display additional
options.

4. Click on Transfer. The
Transfer Functions dialog box
will open.

5. Click on the All Same check
box to clear it. The color options
buttons below that check box
will become active.

6. Click on an ink color option
button. The settings you set next
will apply to the selected color.

7. Enter transfer settings for
the color into the appropriate
text box(es). The graph at the
left side of the dialog box will
change to reflect your changes.

330 CHAPTER 14:  PRINTING YOUR IMAGE

NOTE
Make sure that the
Override Printer’s Default
Functions check box in the
Transfer Functions dialog
box is checked so that
your changes will apply.TE
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8. Repeat Steps 6 and 7 to choose transfer settings for other
ink colors. The choices you make will become active for the
current image.

9. Click on OK. The Transfer
Functions dialog box will close.
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NOTE
Your print shop can provide the needed transfer
settings, and you can use the Save and Load buttons to
reuse those settings in the future.



10a. Click on Done to finish at
this time. The printer settings
will take effect.

OR

10b. Choose other settings as
described in the rest of this
section, and then click on Done
to finish. The new settings
you’ve selected will take effect.

Adding a Border
If you prefer, you can specify that the image print with a black
border around it, for a more finished edge appearance. Use
the next set of steps to add the border.

1. Click on File. The File menu
will appear.

2. Click on Print with Preview.
The Print dialog box will open.
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3. Click on the Show More
Options check box to check it, if
needed. The Print dialog box will
expand and display additional
options.

4. Click on Border. The Border
dialog box will open.

5. Choose a measurement unit
from the right drop-down list.
The type of units you select will
become active.

6. Enter a value in the Width
text box. The value you enter will
set the border width.
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NOTE
The Width setting can be
0 to 3.5 mm, 0 to 10
points, or 0 to .150 inches.

TIP
Don’t forget that if a text box already contains an entry,
you can double-click on the entry to select it, and then
type a replacement entry.



7. Click on OK. The Border
dialog box will close.

8a. Click on Done to finish at
this time. The printer settings
will take effect.

OR

8b. Choose other settings as
described in the rest of this
section, and then click on Done
to finish. The new settings
you’ve selected will take effect.
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Specifying a Bleed
Adding a bleed enables you to set up the image so that a small
part of it along each edge prints outside the crop area. (See
“Using Other Print Settings” to see how to add crop marks to a

printout.) This ensures that when
you trim the image to the actual
crop size, there won’t be any
unwanted white areas.
Specifying a bleed, as described
next, resembles specifying a
border, as described in the
preceding steps. 

1. Click on File. The File menu
will appear.

2. Click on Print with Preview.
The Print dialog box will open.

3. Click on the Show More
Options check box to check it, if
needed. The Print dialog box will
expand and display additional
options.

4. Click on Bleed. The Bleed
dialog box will open.
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5. Choose a measurement unit
from the right drop-down list.
The type of units you select will
become active.

6. Enter a value in the Width
text box. The value you enter will
set the bleed width.

7. Click on OK. The Bleed
dialog box will close.
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NOTE
The width setting can be 0
to 3.18 mm, 0 to 9.01
points, or 0 to .125 inches.



8a. Click on Done to finish at
this time. The printer settings
will take effect.

OR

8b. Choose other settings as
described in the rest of this
section, and then click on Done
to finish. The new settings
you’ve selected will take effect.

Choosing a Background Color
If needed, you can print a background color on the areas of the
page (paper) that the image itself doesn’t fill. This can create a
nice “frame” around the image and lend a more finished
appearance to the printout. Follow the next set of steps to add
a background color to a printout.

1. Click on File. The File menu
will appear.

2. Click on Print with Preview.
The Print dialog box will open.
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3. Click on the Show More
Options check box to check it, if
needed. The Print dialog box will
expand and display additional
options.

4. Click on Background. The
Color Picker dialog box will
open.

5. Click on a color in the narrow band of colors near the
middle of the dialog box. Photoshop will display a different
range of colors in the Select background color box.

6. Click on a color in the Select
background color box. The color
you click on will become the
active background color.

7. Click on OK. The Color
Picker dialog box will close.
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8a. Click on Done to finish at
this time. The printer settings
will take effect.

OR

8b. Choose other settings as
described in the rest of this
section, and then click on Done
to finish. The new settings
you’ve selected will take effect.

Using Other Print Settings
The large Print (with Preview) dialog box includes a number of
other settings that you can apply to control the appearance of
your printout. You can enable these additional features via
check boxes. Table 14-1 details those check box choices, and
the steps following the table review how to choose additional
print settings.
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NOTE
The printer you’ve specified, the nature of the image,
and the other print settings you’ve chosen affect which
of the choices listed in Table 14-1 are available for any
given printout.



Table 14-1 Additional Page Setup Choices

Option Effect When Checked

Interpolation If an image has low resolution that may appear jagged when printed,
this option attempts to correct the problem by resampling to increase
the resolution while printing.

Calibration Bars Prints one (grayscale) or two (CMYK) color or tint comparison bars if a
blank area is available on the page outside the edges of the image.
This helps a professional print shop check the image tone or color ver-
sus other comparable images or other images used in the same print
job.

Registration Marks Prints marks (again, in the available white space outside the edges of
the image) used to align color plates in professional full-color printing.

Corner Crop Marks Prints crop marks specifying the corner of each image. Any bleed you
specified extends beyond the area bounded by the crop marks.

Center Crop Marks Prints crop marks specifying the center of each edge of the image. Any
bleed you specified extends beyond the area bounded by the crop
marks.

Caption If you’ve entered a caption for the image in the File Information dialog
box (as described in the section “Adding File Info” in Chapter 2), the
caption prints.

Labels Adds the image file name to the printout, typically at the center top, in
the blank area of the page outside the image.

Emulsion Down Another setting typically used only when generating film, as by a print
shop, this setting adjusts the type so that it’s readable when the pho-
tosensitive layer of the film or photo paper faces away. Again, consult
your print shop to see if this feature is needed.

Negative Generates a negative image when printing to film. This feature is most
likely to be used by a print shop for generating film separations, but
you may need to choose it if you’re saving the image to EPS format for
later use by a print shop. Your print shop can tell you if you need to
use this option.

Include Vector Data When the image includes vector content, checking this option sends
the vector information on each layer to a PostScript printer. This
results in improved print resolution for the edges of all vector data. 

Encoding Also for use with PostScript printers, the choices on this drop-down list
enable the user to specify the format in which Photoshop sends data
to the printer. Binary is the default choice. For printers that support it,
the JPEG option reduces the amount of data transferred (for faster
printing), but also reduces image quality. Choose ASCII for printers
that don’t support the other two formats; the ASCII format transfers
the most data and generally results in the slowest print speed.
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1. Click on File. The File menu
will appear.

2. Click on Print with Preview.
The Print dialog box will open.

3. Click on the Show More Options check box to check it, if
needed. The Print dialog box will expand and display additional
options.

4. Click on other options to
check them as needed. The
selected features will be applied
to the printout.

5. Click on Done. The Print
dialog box will close.
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NOTE
As noted earlier, save the
image to preserve your
print choices for it.



Printing the Image
You should at last be ready for the moment of truth—sending
your final image to the printer. Follow these steps to get the
job done, so to speak.

1. Click on File. The File menu
will appear.

2. Click on Print. The (small)
Print dialog box will open.
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NOTE
In the large Print dialog box, you also can open the drop-down list below the
Show More Options check box and choose Color Management (rather than
the default choice, Output) to specify color settings for the source space and
print space. Then, during printing, Photoshop will adjust the image color to
work best with the color management scheme or capabilities for your printer
or output device. You need to click on the Proof Setup option under Source
Space first if you’ve set up the image to display with proof colors rather than
the default monitor colors onscreen. Chapter 15 will discuss how to proof
colors.

TIP
You also can click on the
Print button in the large
Print dialog box to open
the small Print dialog box.



3. Click on the option
identifying what to print in the
Print Range area:

• All. Will print the entire
current image.

• Selected. Will print only the
area that’s selected in the
current image.

• Pages. Will print only the
pages you identify by making
entries in the From and To
text boxes.

4. Change the entry in the Number of copies text box, if
needed. Photoshop will print multiple copies of the image if
you change this setting.

5. Click on OK. Photoshop will
send the print job to the printer
and close the Print dialog box.
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NOTE
Check Print to file if you
want to “print” the file to
a special disk file that you
can then provide directly
to your print shop.



Printing Multiple Images with
Picture Package
Photoshop 7 includes a new feature—the Picture Package
feature—that enables you to create a single sheet that prints
multiple copies of an image at various sizes. (Each picture
package resembles the print sheets you received for school
photos as a kid.) With the Picture Package feature, you select
the image to package, choose how to lay out the duplicates on
the page, and then specify any additional information you’d
like to include with each photo duplicate. Use these steps to
create a picture package.

1. Click on File. The File menu will appear.

2. Point to Automate. The Automate submenu will appear. 

3. Click on Picture Package.
The Picture Package dialog box
will open.
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NOTE
You can choose File,
Automate, Contact Sheet
II to create a contact sheet
showing a small thumbnail
of each image in a folder
that you designate. If the
specified folder holds
more images than can fit
on a single contact sheet,
Photoshop automatically
creates as many separate
contact sheets as are
needed. Remember to
save each contact sheet in
order to reuse it in the
future.



4. Choose File from the Use
drop-down list. File will become
the active choice.

5. Click on the Browse button.
The Select an Image File dialog
box opens.

6. Click on the file to use for
the picture package, using the
Look In drop-down list to
navigate to the proper disk and
folder first, if needed. The file
will be selected.

7. Click on the Open button.
The selected image appears in
the preview area of the Picture
Package dialog box.
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8. Choose the Document
settings to use for the picture
package. The Page Size,
Resolution, and Mode choices
work as previously discussed
with regard to adjusting the
image and printout. The Layout
choice determines how many
duplicates each page will hold,
as well as their size. The preview
area of the Picture Package
dialog box shows the specified
layout.

9. Specify the Label settings to
use for the picture package. The
Font, Font Size, Color, and
Opacity settings work just as for
adding text to an image. You can
choose a Position for the label
on each duplicate, as well as
choosing whether to Rotate the
label text. To control what
actually appears as the label, you
can either choose Custom Text
from the Content drop-down list
and then add your own text into
the Custom Text text box, or
choose one of the other file info
options from the Content drop-
down list. (The latter approach
assumes that you’ve entered the
corresponding category of file
information for the file.)
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10. Click on OK. Photoshop will generate the picture
package in its own image window. Make sure you save the
picture package document in order to use it in the future. 
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TIP
Unfortunately, you can’t see the label information until
you generate the picture package. 
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Part IV Review Questions
1. How can you correct an area that’s too sharp or fuzzy? See

“Blurring an Area,” “Smudging an Area,” and “Sharpening an
Area” in Chapter 11.

2. How do you fill a selection? See “Filling with the Paint Bucket” in
Chapter 11.

3. Which toolbox tool enables you to access pro photo correction
techniques? See “Using Photo Techniques” in Chapter 11.

4. How do you remove unwanted parts of the image? See “Cropping
the Image” in Chapter 12.

5. How do you resize the image? See “Changing the Image Size” in
Chapter 12.

6. How do you change the image orientation? See “Rotating the
Canvas” in Chapter 12.

7. What kinds of filters are available? See “Previewing the Filters” in
Chapter 13.

8. How do you apply a filter to an image? See “Applying a Filter” in
Chapter 13.

9. What print choices can you adjust before printing? See “Choosing a
Printer and Page Setup” and “Changing the Print Settings” in
Chapter 14.

10. How do you finish a print job? See “Printing the Image” in 
Chapter 14.
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When you’re preparing images for professional printing, color
management becomes an important issue. That’s because there are
differences between how colors are composed onscreen (out of light)
and when printed (out of ink). This chapter helps you explore issues
surrounding working with color in Photoshop, including how to:

Understand the available color modes

Calibrate your monitor

View and use color channels

Convert an image to another type of color

Prepare the image for professional output

Proof the image color

1515
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Reviewing the Color Modes
As you learned in Chapter 2, when you create a new image in Photoshop, you can choose the color
mode that it should use. When you’re creating an image for onscreen use, you can typically stick
with the default mode, RGB color. However, you may want to choose another of the color modes
for special situations. Alternatively, you can convert an image to a particular color mode later, after
you’ve created or scanned it. Table 15-1 details the available color modes in Photoshop, so you can
understand color basics while working with color choices in this chapter.
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Table 15-1 Image Color Modes

Mode Description

Bitmap This mode enables you to create a black-and-white image only. Because it
provides for only two tones, you can’t convert a full-color image to this mode,
because too much image information would need to be discarded.

Grayscale This mode provides for 256 shades of gray in the image, offering enough vari-
ation to facilitate clear detail in the image.

RGB This mode mimics visual light—composing images of red, green, and blue—
and works best for images to be viewed onscreen, such as those ultimately to
be saved for use in a presentation.

CMYK (Cyan, This mode optimizes images to be printed, because cyan, magenta, yellow,
Magenta, and black are the ink colors used for color printing. This mode tries to
Yellow, and compensate for the fact that paper absorbs some of the ink, affecting the
blacK) appearance of colors.

Lab This mode uses luminance and brightness settings to help balance the image
for all types of devices—printers, monitors, and scanners.

Multichannel This mode allows you to convert color images for special printing situations.
This mode converts the various color channels to channels with 256 colors of
gray, with each channel having variations in the distribution of gray tones,
according to the original colors.

Indexed Color This mode converts an image to a more limited palette of 256 colors, using
the matching or lookup system that you specify. You may want to convert to
indexed color, for example, for images to be used on a Web page or in a pre-
sentation, because this mode dramatically decreases the file size while main-
taining image appearance. (In fact, this is the preferred setting for Web
graphics.)

Duotone This mode prepares an image for traditional duotone printing, which uses two
solid ink colors such as a dark gray and a blue, yielding a nicely tinted image.
You also can construct images with three ink colors (tritones) and four ink col-
ors (quadtones).



Adjusting Your Display
When you install Photoshop, by default the Adobe Gamma
utility installs as well in the Windows Control Panel. You can use
this utility to calibrate the monitor, a process that saves a color
profile that you can apply so images will display using exactly
the same tones on other systems with similarly calibrated
monitors or in other applications using color controls. Follow
these steps to create the calibration profile for your monitor,
starting from the Windows XP desktop.

1. Click on Start. The Start menu will appear.

2. Click on Control Panel. The
Control Panel window will open.

353ADJUSTING YOUR DISPLAY



3. Click on Other Control
Panel Options in the See Also
list. The Other Control Panel
Options window will open.

4. Click on the Adobe Gamma
icon or link. The Adobe Gamma
dialog box will open.

354 CHAPTER 15:  UNDERSTANDING COLORS AND CHANNELS

NOTE
If you’re using Windows
Millennium Edition, you
may need to click on the
View All Control Panel
Options link at the left
side of the Control Panel
window. For earlier
Windows versions, choose
Start, Settings, Control
Panel.



5. Click on the Step By Step
(Wizard) option button. The
option button will be selected.

6. Click on Next. The next
wizard dialog box will appear.

7. Select the contents of the
Description text box and type a
new name, if needed. The name
you enter will be applied to the
calibration (ICC) profile created
for the monitor.

8. Click on Next. The next
wizard dialog box will appear.
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9. Adjust the monitor’s
brightness and contrast
controls as directed, and then
click on Next. The settings will
be read and the next wizard
dialog box will appear.

10. Click on the down arrow beside the Phosphors drop-
down list, and then click on another choice in the list, if
needed. The selected phosphors setting will be used for the
calibration.

11. Click on Next. The next
wizard dialog box will appear.
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NOTE
Make a change in Step 10
only if the documentation
for your monitor indicates
that it uses phosphors
other than those
suggested by the wizard.



12. Drag the slider until the
center box becomes about the
same tone as the light parts of
the patterned frame, as
instructed. The selected gamma
setting will be used for the
calibration.

13. Click on Next. The next
wizard dialog box will appear.

14. Click on the down arrow
beside the Hardware White Point
drop-down list, and then click on
another choice in the list, if
needed. The selected hardware
white point setting will be used
for the calibration.

15. Click on Next. The next
wizard dialog box will appear.
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16. Click on the down arrow
beside the Adjusted White Point
drop-down list, and then click on
another choice in the list, if
needed. The selected adjusted
white point setting will enable
you to work at an alternate white
point setting if you prefer one
that’s slightly different from the
calibrated image.

17. Click on Next. The next
wizard dialog box will appear.

18. Click on Finish. The Save
As dialog box will appear.
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19. Type a name for the
calibration file in the File name
text box. The name you type will
appear.

20. Click on Save. Adobe
Gamma calibrates the monitor
according to the settings you
specified and saves the
calibration settings for future
use.

Applying a Color Profile
After you’ve used the calibration process to save a color
profile, you can apply that color profile (or one of the profiles
available by default within Photoshop) to the current image file,
as described here, so that Photoshop will display the image
using the correct calibration settings. This ensures that any
color changes you make will appear correctly on other
calibrated displays and devices.
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NOTE
At this point, you can click on the window Close button
to close the Other Control Panel Options window.



1. Click on Image. The Image
menu will appear.

2. Point to Mode. The Mode
submenu will appear.

3. Click on Assign Profile. The
Assign Profile dialog box will
open.

4. Click on the Profile option
button. The Profile option
becomes active.

5. Click on the down arrow
beside the Profile option, and
then click on another choice in
the list, if needed. The selected
profile’s settings will be used to
display the image.

6. Click on OK. The selected
profile will be applied to the
image.
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NOTE
As when you make any other changes using Photoshop,
don’t forget to save your color changes.
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Using Color Channels
When an image uses one of the color modes that has color (for
example, not bitmap or grayscale mode), Photoshop displays
each color to be displayed or printed as a separate channel.
You can work with the image information for a particular
channel to edit only that color in the image. This section shows
you how to display a channel and gives an example of working
with channel content.

Changing to a Channel
You use the Channels palette to work with the various color
channels in a Photoshop image. Follow these steps when you
want to display a particular channel only.
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NOTE
Bitmap, grayscale, duotone, and indexed images have a
single channel. You can add more channels, called alpha
channels, to any type of image but bitmaps. (See
“Adding an Alpha Channel” in the next chapter to learn
how to add an alpha channel.) The alpha channels you
add can hold masks or add separate colors to be printed
in the image.



1. Click on Window. The Window menu will appear.

2. Click on Channels. The
Channels palette will become the
active palette.

3. Click on the desired
channel. The channel will
become the current or active
channel, and its content will
appear in the image window.
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TIP
You also can click the
Channels tab, if it’s visible
in the Layers palette. The
Layers palette window
holds five tabs, making it
tough to see the tab to
click. You can either resize
the palette window to
make the tabs accessible,
or use the Window menu
as noted in the steps in
this book. 

TIP
To hide a channel, click on
the eye icon to the left of
the channel name. To
redisplay the change, click
on the empty box to
redisplay the eye icon.



Working on a Channel
You can edit the content on a single color channel just as you
can edit the content of a single layer. You can make a selection
on the channel, use editing tools such as the Airbrush, delete

selected channel content, apply
a filter, and so on. The following
steps show just one example of
the editing possibilities.

1. Make a selection on the
current channel using the tool of
your choice, if needed. The
selection will become active.

2. Make changes to the
channel content using the tool or
filter of your choice. This
example shows a filter being
selected. The changes will
appear on the channel
immediately.
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3. Click on the composite channel. The composite channel
will become the current or active channel, and all the image
color content will reappear in the image window. From this
point, you can continue working with other Photoshop tools.

Converting Images
Images you create don’t have to remain in the original color
mode. Photoshop makes it easy to convert to another color
mode when needed. This section walks you through a few of
the more common color mode conversion scenarios.

Choosing CMYK Color
Adobe recommends that you perform most color corrections
(and other edits) to an image before you convert the image to
CMYK color for professional printing. (Adobe also recommends
that you save a copy of the image file before converting to
CMYK, so that you can work with the original colors in the
image, if needed, at a later time.) You convert to CMYK when
the image is ready to facilitate a print shop creating color
separations—a separate piece of film for each ink color, used
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NOTE
If you experiment with
color channel changes,
you’ll find they can be
very subtle. Although the
average person might not
catch all your channel
changes, being able to
control and manipulate
colors is essential if you
plan to use your images
for professional-level
output.



for creating a plate to print each color ink. Typically, you’ll
convert to CMYK color from RGB color, as in the following
steps.

1. Click on Layer. The Layer
menu will appear.

2. Click on Flatten Image.
Photoshop will merge all the
separate layers onto a single
layer, so that you can convert the
image to CMYK color. (This is
another reason why you should
complete your edits in RGB color
before converting to CMYK.)

3. Click on Image. The Image menu will appear.

4. Point to Mode. The Mode
submenu will appear.

5. Click on CMYK Color.
Photoshop will convert the
image to CMYK color
immediately; if you display the
Colors palette, you will see the
new channels.
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NOTE
You use the Mode
submenu of the Image
menu to convert between
all color modes.



Working with Bit Depth
In Photoshop, the bit depth refers to the amount of color
information each pixel can hold per color channel. (Grayscale
images also have a bit depth, given their tonal variations.) So,
an image set to 16 bits per channel (the default for many
scanners) would have an overall color depth of 48 bits (16 x 3)
for an RGB image. The higher the bit depth, the greater the
possible variation of colors in the image, and the more detail
the image can appear to have. On the other hand, an image set
to 8 bits per channel provides a much smaller file size, which
may work best for certain publications and applications. The
following steps show you how to convert from 8 bits per
channel to 16 bits per channel, and back again.

1. Click on Layer. The Layer
menu will appear.

2. Click on Flatten Image.
Photoshop will merge all the
separate layers onto a single
layer, so that you can convert an
image from 8 bits per channel to
16 bits per channel.
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NOTE
In some cases, when you add layers and masks to a
scanned image, Photoshop automatically converts the
image from 16 bits to 8 bits, so you have to manually
adjust the bit depth later.



3. Click on Image. The Image
menu will appear.

4. Point to Mode. The Mode
submenu will appear.

5. Click on 16 Bits/Channel.
Photoshop will convert the
image to 16 bits of color
information per channel
immediately.

6. Click on Image. The Image menu will appear.

7. Point to Mode. The Mode
submenu will appear.

8. Click on 8 Bits/Channel.
Photoshop will convert the
image to 8 bits of color
information per channel
immediately.
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NOTE
Some tools and features,
such as the Text tool,
don’t work in an image set
to 16 bits of color. If you
try to use an unavailable
tool or feature while the
image is set to 16 bits,
Photoshop will display a
message telling you to
convert the image to 8
bits per channel.



Converting to Grayscale
Another common scenario involves converting a color image to
grayscale. Most of us take color photos with either our
traditional or digital cameras. When you want to use one of
those images in a black-and-white publication, convert the
image to grayscale mode using Photoshop, as described here.

1. Click on Image. The Image menu will appear.

2. Point to Mode. The Mode
submenu will appear.

3. Click on Grayscale. A dialog
box will appear to ask whether
you want to complete the
conversion by discarding color
information.
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NOTE
It’s not necessary to flatten the image before converting
to grayscale. However, if you do not flatten the image
first and the image contains a color adjustment layer, the
wording of the dialog box that appears after Step 3 will
be slightly different, asking if you want to discard the
adjustment layer information. 



4. Click on OK. Photoshop will
complete the grayscale
conversion.

Prepping 
for Color
Separations
You need to use trapping only if your image will be output via
traditional printing methods from CMYK color. Because the
process literally lays down the ink colors in separate passes (on
many printing presses), slight shifting in the paper or the
printing plates can result in white gaps where the ink colors
don’t abut as needed. To avoid this problem, you can use
trapping to cause colors to overlap slightly so that there is no
gap during printing.

369PREPPING FOR COLOR SEPARATIONS

NOTE
Obviously, if you convert
from grayscale back to
one of the color modes,
Photoshop won’t be able
to re-create the original
color information. For that
reason, it’s a good idea to
save a copy of your image
file before converting to
grayscale, so that you can
continue working with the
color version of the image
whenever you need it.

NOTE
Most images only need trapping when they use large blocks or areas of solid
color. Trapping an image with more variation, like a scanned photo, can
actually cause problems with the color separations and ultimate print job. To
see whether you need to use trapping in an image and to get some guidance
about what trapping settings to use, consult your print shop.



1. After converting the image
to CMYK color, click on Image.
The Image menu will appear.

2. Click on Trap. The Trap
dialog box will appear.

3. Type a new Width entry, and
change the measurement unit in
the accompanying drop-down
list, if needed. The settings will
determine how much the colors
overlap by when printed.

4. Click on OK. Photoshop will
finish adding the specified
trapping.
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Proofing Colors
Photoshop provides you the means to proof the appearance of
the various color plates (Cyan, Magenta, Yellow, and blacK)
after you’ve converted an image to CMYK color. You might
want to do this, for example, to look for small specks of color

that you may want to clean up by
erasing them from the applicable
channel. The following steps
explain how to get started
proofing a color plate.

1. Click on View. The View
menu will appear.

2. Click on Proof Colors (to
check it). The color proofing
feature will become active.

3. Click on View. The View
menu will appear.

4. Point to Proof Setup. The
Proof Setup submenu will
appear.

5. Click on one of the Working
(Color) Plate choices.
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NOTE
You can repeat Steps 3
through 5 to proof other
plates.



6. Click on View. The View
menu will appear.

7. Click on Proof Colors (to
uncheck it). The color proofing
feature will be disabled, and all
the colors will reappear in the
image.
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In addition to working with the color information on individual
channels, you can use some commands to adjust and correct the
overall color in an image. By using a few straightforward commands,
you can make color corrections that once required quite a bit of time
in the photo lab. This chapter introduces you to basic color
correction techniques in Photoshop, including how to:

Make quick color corrections

Adjust image tones

Rebalance the image color

Change image brightness and contrast

Use a special color effect

Create an alpha channel

1616
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Using the Auto Color
Command
If you want to improve the appearance of your image without
working in depth with color settings, you can use the Auto
Color command. This command searches the image content
and improves the contrast and colors. The following steps
show how to use the Auto Color command to adjust an
image’s color and contrast with ease.

1. Click on Image. The Image
menu will appear.

2. Point to Adjustments. The
Adjustments submenu will
appear.

3. Click on Auto Color. The
image color and contrast will be
adjusted.
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NOTE
The changes the Auto Color command makes are based
on the settings in the Auto Color Corrections Options
dialog box. You can access this dialog box by choosing
Image, Adjustments, Curves. Then click on the Options
button in the Curves dialog box.



Changing the Tonal Quality
The tonal quality settings in Photoshop enable you to
manipulate the image appearance by adjusting highlights or
shadows. This can make the image appear a bit lighter or
darker if you adjust all the colors in the image, or can make

more subtle changes if you
adjust one channel only. Follow
these steps to work with the
image tone.

1. Click on Image. The Image
menu will appear.

2. Point to Adjustments. The
Adjustments submenu will
appear.

3. Click on Levels. The Levels
dialog box will open.

4. Click on the down arrow
beside the Channel drop-down
list, then click on the desired
channel in the list. The desired
channel will be selected for tonal
adjustments.
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5. Drag the Input Levels sliders as needed to adjust the
tone. The left slider affects shadows, the middle slider affects
midtones, and the right slider affects highlights. The image
window will preview the changes.

6. Drag the Output Levels
sliders as needed to further
adjust the tone for the selected
channel. The left slider adjusts
shadows and the right slider
adjusts highlights. The image
window will preview the
changes.

7. Click on OK. Photoshop will
close the Levels dialog box and
apply the tonal changes.

Correcting the Color Balance
The color balance in an image refers to the overall proportion
of various colors in the image. For example, if a photo looks
too yellow to you, you can make a color balance adjustment as
described next to correct that problem. Color balance changes
make a general correction to the image color.
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1. Click on Image. The Image
menu will appear.

2. Point to Adjustments. The
Adjustments submenu will
appear.

3. Click on Color Balance. The
Color Balance dialog box will
open.

4. Click on the option button for the tonal range to correct in
the Tone Balance area, if needed. The color balance changes
you make will be applied to the specified tonal range.

5. Drag the Color Balance
sliders as needed to change the
amount of color in an image. The
image window will preview the
changes.

6. Click on OK. Photoshop will
close the Color Balance dialog
box and apply the color changes.
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Correcting Brightness and
Contrast
Brightness generally refers to the amount of light (overall
lightness) in the image, and contrast refers to the difference
between the lightest points and the darkest points in the
image. Adding brightness to an image can soften its
appearance, whereas increasing contrast can make an image
appear a bit more well-defined. You adjust both brightness and
contrast in the same dialog box, as shown next.

1. Click on Image. The Image
menu will appear.

2. Point to Adjustments. The
Adjustments submenu will
appear.

3. Click on Brightness/
Contrast. The Brightness/
Contrast dialog box will open.
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NOTE
You also can make various color corrections and apply
various color special effects by adding an adjustment
layer to the image. The adjustment layer enables you to
display the color correction or effect when needed, or
hide it when not needed. Use the New Adjustment Layer
submenu of the Layer menu to add an adjustment layer.



4. Drag the Brightness slider.
The image window will preview
the changes.

5. Drag the Contrast slider.
The image window will preview
the changes.

6. Click on OK. Photoshop will
close the Brightness/Contrast
dialog box and apply the
changes.

Applying a Special Color Effect
Some of the commands on the Adjustments submenu of the
Image menu—specifically the Invert, Equalize, Threshold, and
Posterize choices—apply special color effects. Each of these
commands works a bit differently and applies a slightly
different effect, so the following steps provide an example of
using one of them—the Posterize choice.

The posterizing effect reduces the number of colors used in the
image, so that the image becomes composed of larger color
areas, much like paint-by-number pictures or the way posters
used to be designed.
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NOTE
The Invert Image command reverses the colors in an image, creating a
negative effect. Equalize finds the lightest and darkest pixels in the image and
sets them to white and black, respectively, then distributes the brightness
values for the remaining pixels between the two extremes. Finally, the
Threshold command converts any image to a high contrast black-and-white
image.



1. Click on Image. The Image
menu will appear.

2. Point to Adjustments. The
Adjustments submenu will
appear.

3. Click on Posterize. The
Posterize dialog box will open.

4. Type a new Levels text box
entry, if needed. The image
window will preview the
specified degree of
posterization.

5. Click on OK. Photoshop will
close the Posterize dialog box
and apply the special effect.
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Adding an Alpha Channel
As noted in the last chapter, an alpha channel is an extra
channel you use to store a selection in an image. Then, you can
easily reload the selection from the channel, or even convert

the channel to a spot color
treatment as described in the
section called “Adding Spot
Color” in the next chapter. The
steps that follow explain the
easiest way to save a spot
channel—by saving a selection as
a spot channel.

1. Make a selection on a layer
using the selection tool of your
choice. The selection will appear
in the image.

2. Click on Window. The
Window menu will appear.

3. Click on Channels. The
Channels palette will become
active.
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4. Click on the Save Selection
as Channel button at the bottom
of the Channels palette. The new
channel will appear immediately
in the Channels palette.

5. Click on the new channel in
the palette. The new channel will
be selected.

6. Click on the Channels
palette menu button. The
palette menu appears.

7. Click on Channel Options.
The Channel Options dialog box
will open.
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8. Type a name for the channel
in the Name text box. Your new
name will replace the temporary
name in the text box.

9. Click on OK. The Channel
Options dialog box will close and
Photoshop will save the channel
under the name you specified.
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NOTE
To load the selection from a channel, click on the channel
in the Channels palette, and then click on the Load
Channel as Selection button at the bottom of the
Channels palette.
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You’ve seen old photos where photographers hand-painted tints
onto black and white images, or warmer brown and ivory images
called sepia prints. You can achieve similar effects in Photoshop, as
well as create your own special treatments such as duotones for
printing. This chapter reveals these three tricks, showing you how to:

Add spot color to an image

Create a duotone image

Convert a color image to sepia tones
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Adding Spot Color
Typically, you would add spot color to enhance or colorize an
area on a grayscale image, but you can really add spot color to
any image that allows multiple channels. You can use an alpha
channel to create the spot color, as described in the following

example, or you can make
another selection and then start
with Step 4 to finish adding the
spot color.

1. Click on Window. The
Window menu will appear.

2. Click on Channels. The
Channels palette will become
active.

3. Click on the alpha channel
that you want to use to apply the
spot color in the palette. The
channel will be selected.

4. Click on the Load Channel as
Selection button at the bottom
of the palette. The selection
appears immediately in the
channel.
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5. Click on the Channels
palette menu button. The
palette menu will appear.

6. Click on New Spot Channel.
The New Spot Channel dialog
box will open.

7. Type a name for the spot
channel in the Name text box.
Your new name will replace the
temporary name in the text box.

8. Click on the Color box. The
Color Picker dialog box will
open.
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9. Click on a color in the narrow band of colors near the
middle of the dialog box. Photoshop will display a different
range of colors in the Select spot color box.

10. Click on a color in the
Select spot color box. The color
you click on will become the
active spot color.

11. Click on OK. The Color
Picker dialog box will close.

12. Make a new entry in the
Solidity text box, if needed. An
entry greater than 0 will make
the spot color more opaque.

13. Click on OK. The New Spot
Channel dialog box will close,
finishing the spot color channel.
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14. Click on the composite
channel in the Channels palette.
The image will reappear in the
image window.

15. Click on the eye icon box
beside the spot channel so that
the icon appears in it. The spot
color will appear in the image.

16. If you were working in a
grayscale image, convert the
image to RGB or CMYK color.
After you make the conversion,
the image will print with the spot
color. (If you skip the conversion,
the image will still print in
grayscale.)
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NOTE
The name of the
composite channel in a
grayscale image is “Gray.”



Creating a Duotone Image
As noted in an earlier chapter, a duotone image typically is a
grayscale image to which you add a second printed color to
tint the image overall. (You can add two tint colors to create a
tritone image, and three tint colors to create a quadtone
image.) The steps here illustrate an example of converting a
grayscale image to a duotone for a nicely tinted printout.

1. Click on Image. The Image
menu will appear.

2. Point to Mode. The Mode
submenu will appear.

3. Click on Duotone. The
Duotone Options dialog box will
appear.
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NOTE
Remember, some tools and conversions aren’t available
for images using 16 bits of color information per channel,
so convert to 8 bits per channel. To convert to a
duotone, the image must be set to 8 bits per channel.
Refer to “Working with Bit Depth” in Chapter 15 to see
how to make this change.
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4. Click on the down arrow
beside the Type drop-down list,
and then click on Duotone in the
list. The second ink color will
become active for the image.

5. Click on the white Ink 2 box.
The Custom Colors dialog box
will open.
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NOTE
Of course, you would click
on Tritone or Quadtone to
add more than one tint
color to the image.



6. Click on a color in the narrow
band of colors near the middle
of the dialog box. Photoshop will
display a different selection of
colors in the list at the left side
of the dialog box.

7. Click on a color in the list at the left side of the dialog box.
The color you click on will become the active tint color, and the
image window will preview the selected tint.

8. Click on OK. The Custom
Colors dialog box will close.
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NOTE
You actually can choose
colors from a number of
different color sets. To
view colors in another set,
make another choice from
the Book drop-down list.



9. Type a color plate name in
the Ink 2 text box. (Enter Cyan,
Magenta, or Yellow.) The name
will tell Photoshop to use a
separate color plate for the tint
ink color.

10. Click on OK. The
Duotone Options dialog box
will close, finishing the
duotone creation.

11. Click on Image. The Image
menu will appear.

12. Point to Mode. The Mode
submenu will appear.

13. Click on Multichannel.
Photoshop separates the single
duotone color channels into
multiple channels, so you can
preview individual colors.
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TIP
If the duotone will be
included in a document 
to be printed by a
professional printer, it’s
best to write down the
Pantone Color name (or
leave it entered in the Ink
2 text box) so you can tell
the printer the exact tint
ink color.



14. Click on the color channel
to preview in the Channels
palette. Photoshop will display
the ink areas to be printed with
that color in the image window.

15. Click on Edit. The Edit
menu will appear.

16. Click on Undo
Multichannel. Photoshop
removes the multichannel mode
and redisplays the single
duotone color channel.
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Making a Sepia Image
You’ll typically work in the opposite direction when you create
a sepia image, working from a color image to one that appears
more like a creamy brown grayscale. (But you can make a
“sepia” image with any mix of color that you prefer.) Use the
following steps to make your favorite color image appear as a
traditional (and trendy) sepia image.
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TIP
You can convert a grayscale image to RGB color and
then use the techniques described here to make it a
sepia image.

NOTE
Photoshop includes an action you can use to create a
sepia tone on a layer (choose File, Automate, Batch, and
then choose Sepia Toning from the Action drop-down
list, and use the other Batch dialog box settings to finish
applying the automation). There are also actions for
applying other color effects, and you can download
actions for applying sepia tone and other effects from
the Internet. See Chapter 19 to learn more about
actions, and Appendix D for sources for downloadable
goodies, including actions. 



1. Click on Image. The Image
menu will appear.

2. Point to Adjustments. The
Adjustments submenu will
appear.

3. Click on Channel Mixer. The
Channel Mixer dialog box will
appear.

4. Click on the Monochrome
check box. Photoshop checks
the check box.

5. Click on the Monochrome
check box. Photoshop unchecks
the check box.
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NOTE
You have to check and
uncheck the Monochrome
check box to be able to
blend channels separately.



6. Choose a channel from the
Output Channel drop-down list.
The selected color channel will
be ready for adjustment.

7. Drag the Source Channels
slider for the selected color. The
image window will preview the
color change in the image.

8. After you adjust the mix for
each channel, click on OK. The
Channel Mixer dialog box will
close, so that you can review the
final tint.
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Simply stated, a plug-in is a mini-program that extends the
capabilities of Photoshop (or its companion program ImageReady).
Each plug-in functions in one of three ways: as a filter, as an
additional import or export choice, or as a file format choice in the
Save As or Open dialog box. This chapter shows you how to take
advantage of plug-ins, including how to:

Install a plug-in you’ve purchased or downloaded

Use a plug-in that performs a special action 

Use a filter plug-in
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Installing Plug-Ins
By default, the plug-ins that come with Photoshop install to
various subfolders of the C:\Program Files\Adobe\Photoshop
7.0\Plug-Ins\ folder. You can purchase additional plug-ins or
download a variety of freeware and shareware plug-ins from a
number of sources online. (See Appendix D, which lists some
Web sites where you can begin your search for available 
plug-ins.)

If you download a particular type of plug-in, you typically can
just move or copy the plug-in file (after decompressing it,
unzipping it, or renaming it, if indicated per the instructions
accompanying the plug-in) to the folder that holds similar plug-
in files, assuming the plug-in doesn’t include its own installer
program. In other cases, you may want to store your third-
party plug-ins in a separate folder to distinguish them from the
plug-ins provided with Photoshop. If you choose this route, you
need to specify the alternate plug-in location, as described
next.
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NOTE
If a plug-in was written for Photoshop only, copy it 
to the appropriate subfolder of C:\Program
Files\Adobe\Photoshop 7.0\Plug-Ins\Adobe Photoshop
Only\. If a plug-in was written for ImageReady only, 
copy it to the appropriate subfolder of C:\Program
Files\Adobe\Photoshop 7.0\Plug-Ins\Adobe ImageReady
Only\.
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1. Click on Edit. The Edit menu will appear.

2. Point to Preferences. The
Preferences submenu will open.

3. Click on Plug-Ins & Scratch
Disks. The Preferences dialog
box will appear, with its Plug-Ins
& Scratch Disks settings
displayed.

4. Click on the Additional Plug-
Ins Directory check box. The
check box will be checked.

5. Click on Choose. The Browse
for Folder dialog box will open.
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NOTE
In ImageReady, you would
choose Edit, Preferences,
Plug-Ins to start specifying
another plug-ins folder.



6. Select the folder that holds
the plug-ins in the folder tree.
The specified folder will become
active as a plug-in folder.

7. Click on OK. The Browse for
Folder dialog box will close.

8. Click on OK. The Preferences
dialog box will close.
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9. Click on File. The File menu
will open.

10. Click on Exit. Photoshop
will close. 

11. Open the newly specified plug-ins folder on the desktop.

12. Decompress or rename
the plug-in file, or run its installer
as required. The appropriate
plug-in files will decompress or
be installed in the appropriate
folder location. 

13. Close the folder on the
desktop.
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NOTE
When you close
Photoshop, save changes
to any open file, if
prompted. You must exit
and restart Photoshop (or
ImageReady) for the new
plug-ins folder to take
effect.



14. Click on Start. The Start menu will appear.

15. Point to All Programs (or
Programs in Windows versions
prior to XP). The Programs
submenu will appear.

16. Click on Adobe Photoshop
7.0. The Photoshop program will
load, with the added plug-ins
newly active. You can now open
files as needed and use the 
plug-ins.
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NOTE
In some cases, you may have to move the plug-ins to
C:\Program Files\Adobe\Photoshop 7.0\Plug-Ins\ rather
than running them from the alternate folder. Be sure to
read any Readme file that comes with a plug-in to verify
how to install it, particularly if the plug-in creates one or
more folders when you unzip or decompress it.

NOTE
In some cases, you will need to copy additional files to
the folder that holds the Photoshop program or to the
C:\Windows\System\ folder. Consult the Readme file
that comes with the plug-in to verify how to install it.



Applying a Plug-In to a File
As noted at the very beginning of the chapter, plug-ins
generally work in limited ways, enabling you to open or save
files in different formats, or to apply custom filters to an image.
This section shows an example of using a filter that falls into
each category.

Applying by Opening or Saving
If a filter enables you to use Photoshop to work with files of
different formats, the filter typically adds the format into the
Files of Type list of the Open dialog box or the Format list of
the Save As dialog box. The following steps show one
example—using a filter that enables you to save files in the
Windows icon format (.ICO). Before you begin the steps, be
sure you open the file to which you want to apply the plug-in.

1. Click on File. The File menu
will appear.

2. Click on Save As. The Save
As dialog box will appear.

405APPLYING A PLUG-IN TO A FILE

NOTE
In other cases, plug-ins
that work with file formats
appear on the Import or
Export submenus of the
File menu.



3. Click on the down arrow
beside the Format drop-down
list, then click on the file format
provided by the plug-in (in this
case, BoxTop ProJPEG 5.0). The
selected format will be used for
the save operation.

4. Change the File name and
Save in location, if needed. The
newly saved file will use the
name and location you specify.

5. Click on Save. The Save As
dialog box will close and one of
two things will happen. Either
the file will be saved immediately
in the new format, or a dialog
box for the plug-in will appear to
prompt you to specify additional
settings for the saved file.
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6. Adjust settings as needed.
In many cases, an image preview
or output settings will change to
show the impact of the new
settings on the image file that
will be created.

7. Click on OK or Save. The
dialog box will close and the
image will be saved. You can
then close and use the image.

Applying a Filter Plug-In
In most cases, installing a plug-in installs a new filter or group
of filters. Photoshop typically adds the new filter choices or
groups (submenus) to the bottom of the Filter menu, making
added filters as easy to access as default filters. Like the default
filters, some plug-in filters will display a dialog box prompting
you to choose additional settings, whereas others will take
effect immediately. The following steps show an example
freeware plug-in filter.
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1. With the file to filter open, click on Filter. The Filter menu
will appear.

2. Point to the name for the
filter group, if needed. The
group submenu will appear.

3. Click on a filter. The filter will appear, or the filter dialog
box will appear.

4. Adjust filter settings as
needed. Either a preview area in
the filter dialog box or the image
window itself will preview the
filter changes.

5. Click on OK. Photoshop will
apply the filter settings to the
image.
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NOTE
As with other commands
and effects in Photoshop,
many filters require that
an image be using a
particular color mode. For
example, the image shown
here had to be converted
to RGB color at 8 bits per
channel before the plug-in
filter could be used.



Using the Liquify Plug-In
In Photoshop 7.0, Adobe has made significant enhancements
to the Liquify plug-in. Because this plug-in now offers so many
features, it appears as a stand-alone command (rather than as
part of a submenu) on the Filter menu. The Liquify plug-in now
offers a variety of settings for distorting and manipulating an
image. The Turbulence tool represents one new enhancement
to this filter, enabling you to place distortion along with a
“jitter” effect. You can view a mesh that illustrates the
distortion, as well. The following steps illustrate some of the
basics for working with this important plug-in.

1. With the file to filter open, click on Filter. The Filter menu
will appear.

2. Click on Liquify. The Liquify
dialog box will appear.
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3. Adjust the zoom setting for
the image, if needed. The image
will appear at the new zoom.

4. Click on the Mesh check
box. The mesh will appear on
the image so that you can view
the distortion more easily.

5. Click on the desired tool. The tool will be selected. In this
example, the Turbulence tool is selected.

6. Adjust Tool Options as
needed. The mouse pointer will
change in size or appearance
accordingly when you move the
pointer over the image.

7. Drag on the image at the
desired location(s). The image
will be distorted according to
the selected tool, its settings,
and the amount of dragging. 

8. Click on OK. The Liquify
dialog box will close, and the
image will appear with its new
distortion in Photoshop. 
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411USING THE LIQUIFY PLUG-IN

NOTE
You can click on the Save Mesh button in the Liquify
dialog box to save the distortion settings you’ve created.
Later, you can use the Load Mesh button in the Liquify
dialog box to open the mesh and apply it to another
image.
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If you’ve made it this far along in the book, you can see that the
possible combinations of Photoshop features and filters you can use
are endless, not to mention the sheer number of specific settings you
use with each feature or filter. In Photoshop, you can create actions
and droplets to store a series of commands and settings that you
choose. This chapter shows you how to save yourself some work in
Photoshop, including how to:

Record an action

Play an action

Make a droplet from an action

Use a droplet

1919
Working with 
A c t i o n s
Working with 
A c t i o n s



Creating an Action
If you’ve ever created a macro in an application, then you’ll
have an easy time creating an action. Like a macro, an action is
a series of steps and settings that you save so that you can
repeat them quickly later. Saving and using the action
eliminates the necessity to remember the filter settings you
prefer, for example, or the color adjustment choices to use.
Actions come in handy when you need to prepare multiple
images using the same settings—for example, if you’re
converting a series of grayscale images to duotones using a
particular Pantone color for inclusion in the same publications.
The steps that follow show you how to use the Actions palette
to record a new action.

1. Click on Window. The Window menu will appear.

2. Click on Actions. The Actions
palette will become active.
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3. Click on the Create New Set
button at the bottom of the
palette. The New Set dialog box
will appear.

4. Type a name for the new set.
The name you type will replace
the placeholder entry in the
Name text box.

5. Click on OK. The new set will
appear in the Actions palette
and will be selected by default.
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NOTE
To add a new action to an
existing set, click on the
set name in the Actions
palette and then follow
the rest of the steps here.



6. Click on the Create New
Action button at the bottom of
the palette. The New Action
dialog box will appear.

7. Type a name for the new
action. The name you type will
replace the placeholder entry in
the Name text box.

8. Specify other settings in the
dialog box, such as adding a
Function Key (shortcut key
combination) to play back the
action. The remaining settings
will be added for the function.

9. Click on Record. Recording
will start.
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10. Perform the steps to
record. The steps will be added
to the named action.

11. Click on the Stop
Playing/Recording button at the
bottom of the Actions palette.
Photoshop will stop recording
your steps, finishing the action.
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NOTE
If a particular feature can’t
be recorded, either it will
be unavailable or you’ll
see a warning message.

NOTE
As with plug-ins, you can download a number of free action (.ATN) files from
various Web sites, such as those listed in Appendix D. Decompress or 
unzip the action file, if needed, and then copy it to the C:\Program
Files\Adobe\Photoshop 7.0\Presets\Photoshop Actions folder. Click on the
Actions palette menu button, and then click on Load Actions. The Load dialog
box will appear. Select the newly copied action, and then click on Load. To
save a set of actions you’ve created in an .ATN file (necessary only to back up
your actions or share them with others), select the set in the Actions palette,
click on the Actions palette menu button, and then click on Save Actions. Use
the Save dialog box that appears to finish the save.



Using an Action
Much as you use a recording process to create an action, you
use a playback process to run the action. Before you run the
action, open the file to which you want to apply the action, and

perform any preliminary steps to
prepare for the action, such as
making a selection or converting
to the proper color mode. Then
use the steps that follow.

1. Click on Window. The
Window menu will appear.

2. Click on Actions. The Actions
palette will become active.

3. Scroll to display the set that holds the action to perform in
the palette. The actions will appear in the palette.

4. Click on the action to
perform. The action will be
selected.

5. Click on the Play Selection
button at the bottom of the
palette. The action plays
immediately.
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NOTE
Click on the right arrow to
the left of the set name if
you don’t see its actions.



Making a Droplet
You can save an action as a droplet, a mini-program you can
use to process image files even when Photoshop isn’t running.
Use the following steps to create a droplet using default
droplet settings.

1. Click on File. The File menu
will open.

2. Point to Automate. The
Automate submenu will appear.

3. Click on Create Droplet. The
Create Droplet dialog box will
open.
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NOTE
The Automate submenu also includes a number of pre-
set automations—mini-programs you can use to process
a batch of images. For example, you can use the Contact
Sheet automation to create a contact sheet image file
from all the images stored in a particular folder.



4. Choose the set that holds
the action to convert from the
Set drop-down list. The set’s
actions will become available in
the Action drop-down list.

5. Choose the action to save as
a droplet from the Action drop-
down list. The selected action
appears.

6. Click on Choose. The Save
dialog box will open.

7. Navigate to the folder
where you want to save the
droplet. It will become the active
folder.

8. Type a name for the new
droplet file. The name you type
will replace the placeholder entry
in the File name text box.

9. Click on Save. The Save dialog box will close and the name
you specified will appear in the Create Droplet dialog box.
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NOTE
By default, the Save dialog
box displays the My
Documents folder, but
you can save a droplet in
any location you prefer. 
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10. Click on OK. Photoshop
will close the Create Droplet
dialog box and finish saving the
droplet.

Using a Droplet
As you saw in the last section, Photoshop saves a droplet you
create as an .EXE file. The Photoshop program doesn’t have to
be open for you to use the droplet. You can use the droplet
from the folder where you saved it, or copy the .EXE file to any
other folder, including the Windows desktop—shown in the
next set of steps—for convenient use. You don’t have to open
Photoshop, so the droplet provides a fast alternative for
making changes to a number of files, because you also don’t
have to open the individual image files in Photoshop. Using the
droplet is an easy drag-and-drop operation, as illustrated next.
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1. Open the folder that holds
the file to process with the
automation. The folder will
appear in Windows.

2. Drag the file to process
from its folder and drop it onto
the icon for the droplet file (on
the desktop or in another
folder). The droplet’s actions will
be performed on the file. You
can repeat the process for as
many files as need to be
processed.
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NOTE
Of course, the file(s) to be processed must use the
correct color mode and other settings, or the droplet will
stop and display an error message.
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Part V Review Questions
1. How do I choose what type of image colors to use? See “Reviewing

the Color Modes” in Chapter 15.

2. What’s a color channel, and how do I select one? See “Using Color
Channels” in Chapter 15.

3. What are the most common color mode conversions? See
“Converting Images” in Chapter 15.

4. What do I do if my image is too dark? See “Correcting Brightness
and Contrast” in Chapter 16.

5. Can you add color to spot in an image? See “Adding Spot Color” in
Chapter 17.

6. What’s a duotone, and how do you create one? See “Creating a
Duotone Image” in Chapter 17.

7. How do you add plug-ins to Photoshop? See “Installing Plug-Ins” in
Chapter 18.

8. What methods do you use to employ a plug-in? See “Applying a
Plug-In to a File” in Chapter 18.

9. How do you create an action? See “Creating an Action” in Chapter
19.

10. How do you use an action? See “Using an Action” in Chapter 19.
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Because Photoshop provides some of the best tools for creating
and editing images in general, it’s not surprising that it offers
superior options for preparing images for use in Web pages. This
chapter walks you through the basic skills for preparing images for
the Web, including how to:

Understand the Web graphic formats

Understand what will happen if you choose Save As

Create an optimized JPEG image

Create an optimized GIF image

Create a WBMP image

Generate a Web photo gallery
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Reviewing Web Graphic
Formats
The HTML Web page format spurred the growth of the
Internet not only because it could present information in an
attractive graphic format, but also because its files were
relatively compact in size for reasonable download times. In
the spirit of preserving those download times, a few different
new formats for graphics files also emerged. Through special
compression technology, these file formats preserve color and
detail while dramatically reducing file size—sometimes
eliminating megabytes in file size. Table 20-1 lists the most
common Web graphic file formats and their features.

Table 20-1 Web Graphic File Formats

Format Description

Compuserve GIF (.GIF) This mode requires conversion to
Indexed Color mode (which limits
the image to 256 colors) and
enables you to preserve transparen-
cy so that the Web page back-
ground shows through.

JPEG (.JPE, .JPG, This mode does not preserve 
or .JPEG) transparency, but it does enable you

to specify the amount of compres-
sion to use so you can control file
size and quality.

PNG (.PNG) Portable Network Graphics (PNG)
mode enables you to preserve
transparency and choose specific
methods for reducing colors and
handling dithering in the image. This
format isn’t used often.

WBMP This 1-bit color format optimizes
images for wireless devices.
Converting an image to this format
converts it to simplified black-and-
white.
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Using Save As
You can use the Save As command on the File menu to save an
image in the common Web graphic formats. (See the section
titled “Saving to Another Format” in Chapter 2 for an overview

of how to use the Save As
command.) When you use the
Save As command and choose
one of the Web file formats,
you’ll be prompted to make
various changes depending on
the selected format:

• GIF. The Indexed Color dialog
box appears to specify color
palette, transparency, and
matte settings, and then the
GIF Options dialog box
appears to prompt you
whether to choose an
interlaced GIF format.

429USING SAVE AS

TIP
Remember, when you create a new image with the 
File, New command, you click on the Transparent 
option button to set up an image with a transparent
background. If you scan an image or download it from 
a digital camera, you cannot specify a transparent
background, so it’s best to copy a selection from such 
an image, create a new image with a transparent
background, and then paste the copied selection into it.



NOTE
When you have Photoshop create an interlaced file, part
of the image can “pre-load” on the Web page. This
means that the user will see the image at low resolution
until the full file downloads.

• JPEG. The JPEG Options
dialog box appears so you can
specify image quality and
matte options. Transparent
areas will be filled with white
when you finish the save.

• PNG. The PNG Options
dialog box appears, so you
can choose whether to add
interlacing.
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Save an Optimized Image File
To see all the settings for Web graphic file formats in a single
dialog box, use the Save for Web command on the File menu.
This command enables you to select a Web file format, specify
settings for the format, and then proceed with the save. The
rest of this section shows you how to use the Save for Web
command to optimize and save a file in the three most common
Web graphic formats—JPEG, GIF, and WBMP.

Saving a JPEG
These steps show you how to use the Save for Web command
to save a JPEG file, so that you can choose the optimum
compression for your image.

1. Click on File. The File menu
will appear.

2. Click on Save for Web. The
Save For Web dialog box will
open, with its Optimized tab
selected.
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3. Click on the down arrow
beside the drop-down list in the
upper-left corner of the Settings
box, and then click on JPEG. The
JPEG choices will appear in the
Settings box.
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NOTE
You can use the drop-down list right beside the Settings
label at the top of the Settings box to choose a pre-
saved set of optimization settings, such as JPEG High or
GIF 32 Dithered. Click on the Optimize Menu button (the
menu button with the right arrow on it just to the right
of the top drop-down list), and then click on Save
Settings. You can then use the Save Optimization
Settings dialog box that appears to save your choices on
the Optimized tab of the Save For Web dialog box under
one name, so you can later choose that name (and thus
your saved settings) from the drop-down list beside the
Settings label. 



4. Choose an image quality
setting, either by choosing a
general setting from the drop-
down list at the left or by using
the Quality choice at the right.
The statistics in the lower-left
corner of the preview area will
change to show the file size that
will result from the designated
quality setting.

5. Click on the down arrow
beside the Matte drop-down list.
A menu will appear.

6. Click on Other. The Color
Picker dialog box will appear so
that you can use it to specify a
matte for the image.
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NOTE
A matte color in a GIF or
PNG Web graphic helps
the edges of transparent
areas blend with the Web
page background; in a
JPEG image it fills areas
that were originally
transparent with the
specified color for
blending.



7. Click on a color in the narrow band of colors near the
middle of the dialog box. Photoshop will display a different
range of colors in the Choose a color box.

8. Click on a color in the
Choose a color box. The color
you click on will become the
active matte color.

9. Click on OK. The Color
Picker dialog box will close.

10. Click on Save. The Save
Optimized As dialog box will
appear.
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11. Edit the File Name text box entry as needed. The name
you specify will be applied to the Web graphic file.

12. Click on Save. The Save
Optimized As and Save For Web
dialog boxes will close. Only the
original image will be open in
Photoshop. You can find the
new, optimized Web graphic file
in the folder where you saved it.

Saving a GIF
Saving an optimized GIF file follows much the same process as
saving an optimized JPEG file. Get started with the process now.

1. Click on File. The File menu
will appear.

2. Click on Save for Web. The
Save For Web dialog box will
open, with its Optimized tab
selected.
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NOTE
You can use the Save In
drop-down list to choose
another disk and folder
location for the saved file,
if needed.



3. Click on the down arrow
beside the drop-down list in the
upper-left corner of the Settings
box, and then click on GIF. The
GIF choices will appear in the
Settings box.
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NOTE
You can use the drop-down list right beside the Settings
label at the top of the Settings box to choose a pre-
saved set of optimization settings, such as JPEG High or
GIF 32 Dithered. Click on the Optimize Menu button (the
menu button with the right arrow on it just to the right
of the top drop-down list), and then click on Save
Settings. You can then use the Save Optimization
Settings dialog box that appears to save your choices on
the Optimized tab of the Save For Web dialog box under
one name, so you can later choose that name (and thus
your saved settings) from the drop-down list beside the
Settings label.



4. Choose image color
settings, both by choosing a
color reduction setting from the
drop-down list at the left and by
choosing the maximum number
of colors for indexing the color
using the Colors choice at the
right. The statistics in the lower-
left corner of the preview area
will change to show the file size
that will result from the
designated quality setting.

5. Choose image dithering
settings, both by choosing a
dithering method from the drop-
down list at the left and by
choosing the amount of
dithering using the Dither choice
at the right. The statistics in the
lower-right corner of the preview
area will change to show the
specified dithering method.
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6. Leave the Transparency
check box checked. This ensures
that the transparent areas in the
image will remain transparent in
the final GIF file.

7. Click on the down arrow
beside the drop-down list below
the Transparency check box. A
menu of transparency dithering
algorithms will appear.

8. Click on the desired
algorithm. The preview will show
the impact of the selected
algorithm.
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NOTE
Specifying the transparency dither algorithm will be
necessary for images with semi-transparent areas, such
as gradients or bleeds. 

NOTE
You also can add a matte for the GIF, but it won’t be as
obvious in the preview. That’s because the matte for a
GIF image serves more as a blending zone between the
image content and the Web page background.



9. Click on Save. The Save
Optimized As dialog box will
appear.

10. Edit the File name text box entry as needed. The name
you specify will be applied to the Web graphic file.

11. Click on Save. The Save
Optimized As and Save For Web
dialog boxes will close. Only the
original image will be open in
Photoshop. You can find the
new, optimized Web graphic file
in the folder where you saved it.
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NOTE
You can use the Save In
drop-down list to choose
another disk and folder
location for the saved file,
if needed.



Saving a WBMP
As noted earlier in this chapter, a WBMP file is a black-and-
white file created specifically for wireless (and handheld)
devices. When you convert an image to WBMP, you may lose

some of the detail, but the
tradeoff is necessary. Follow
these steps to save a file as a
WBMP file.

1. Click on File. The File menu
will appear.

2. Click on Save for Web. The
Save For Web dialog box will
open, with its Optimized tab
selected.

3. Click on the down arrow
beside the drop-down list in the
upper-left corner of the Settings
box, and then click on WBMP.
The WBMP choices will appear in
the Settings box.

440 CHAPTER 20:  CREATING WEB IMAGES

TE
AM
FL
Y

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Team-Fly® 



4. Choose image dithering
settings, both by choosing a
dithering method setting from
the drop-down list at the left and
by choosing the amount of
dithering using the Dither choice
at the right. The statistic in the
lower-right corner of the preview
area will change to show the
specified dithering method.

5. Click on Save. The Save
Optimized As dialog box will
appear.
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6. Edit the File name text box
entry as needed. The name you
specify will be applied to the
Web graphic file.

7. Click on Save. The Save
Optimized As and Save For Web
dialog boxes will close. Only the
original image will be open in
Photoshop. You can find the
new, optimized Web graphic file
in the folder where you saved it.

Setting Up a Web Photo
Gallery
The new Web Photo Gallery feature enables you to create a
Web page linking to a collection of images. The original images
all should be stored in the same folder and can be in any file
format that Photoshop recognizes. The Web Photo Gallery
feature creates a Web page named index.htm and stores that
Web page in the folder location you specify. The Web Photo
Gallery feature then creates a subfolder named \images\,
which holds large copies of the original image files (converted
to JPEG format, if needed), as well as other images (such as
navigation buttons) needed for the Web photo gallery. Each
image will be displayed on a separate page when the viewer
selects the image from the initial gallery page. 

442 CHAPTER 20:  CREATING WEB IMAGES

NOTE
You can use the Save In
drop-down list to choose
another disk and folder
location for the saved file,
if needed.



The Web Photo Gallery feature also creates a subfolder named
\pages\, which holds an .HTM file for each image; the
index.htm file has a link to each of these .HTM files. Finally, a
new \thumbnails\ subfolder holds a smaller version of each
image in the gallery for display on the index.htm page. Follow
these steps to create a basic Web photo gallery.

1. Move or copy the images
for the gallery into a single
folder in Windows. The images
will appear in that folder.

2. In Photoshop, click on File.
The File menu will open.

3. Point to Automate. The
Automate submenu will appear.

4. Click on Web Photo Gallery.
The Web Photo Gallery dialog
box will open.
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5. Click on Browse. The Browse
For Folder dialog box will open.

6. Select the folder that holds
the images to include in the
photo gallery. The folder will
become selected.

7. Click on OK. The folder will
be displayed as the source
folder.
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NOTE
Depending on the current
choice for the Options
drop-down list in the Web
Photo Gallery dialog box,
the settings at the bottom
of the dialog box will
differ.



8. Click on Destination. The
Browse For Folder dialog box
will open.

9. Select the folder where you
would like to store the photo
gallery Web page and its
subfolders of source files. The
folder will become selected.

10. Click on OK. The folder will
be displayed as the destination
folder.
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NOTE
The destination folder
must be different from the
source folder.



11. Enter other information
about the site as needed. The
information will be included on
the initial Web Photo Gallery
page.

12. Click on OK. Photoshop
will generate the Web Photo
Gallery, launch your Web
browser, and display the initial
page. The page will show
thumbnail images. 

13. Click on an image link or
thumbnail. The Web Photo
Gallery page for that image will
open. From this point, you can
continue browsing images in the
gallery or close your Web
browser.
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NOTE
If you move or copy the
Web Photo Gallery to
another location, you must
move all the elements—
the index.htm file, the
\images\ folder, the
\pages\ folder, and the
\thumbnails\ folder.



Web browsing hinges on the ability to navigate by following links.
You can use the Slice tool to identify areas for linking in an image,
and then save that image as a Web (HTML) file so that an image with
the links can be incorporated into an overall Web site. This chapter
introduces you to the basics for the slice feature, including how to:

Add a slice and set its options

Work with existing slices

Save the sliced image in HTML format

2121
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Adding Slices or “Hotspots”
The Slice tool on the Photoshop toolbox adds slices into an
image file. By then specifying the slice options, you create a
link to a particular Web address called a URL (Uniform
Resource Locator). After you save the image as an HTML file
(as described in the final section of this chapter, “Saving the
Sliced File in HTML”), users can click on the area defined by
the slice to follow the link. That’s why such linked areas are
called “hotspots.” The steps the follow explain how to add a
slice and set it up as a hotspot, after you’ve performed all the
needed edits in Photoshop.

1. Click on the Slice tool in the toolbox. The Slice tool will
become active.

2. Drag on the image to define
the slice. (You don’t really need
to select a layer first.) When you
release the mouse button, the
new slice will appear.
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NOTE
In addition to the slice you
drew, called a user slice,
Photoshop divides the
rest of the image into
slices called auto slices.
Typically, Photoshop adds
draws vertical slice lines
continuing from one or
both corners of the slice
you drew, depending on
its location. It also may
draw horizontal slice lines
from the top or bottom of
the slice. 



3. Right-click on the slice
number for the new slice. A
shortcut menu will appear.

4. Click on Edit Slice Options.
The Slice Options dialog box will
open.

5. Specify options, as follows:

• URL. Enter the URL for the
Web page that will appear
when the user clicks on the
hotspot. To enter an absolute
address (not just a relative
address on the server holding
the page), be sure to include
http:// at the start of your
entry.

• Target. Specify the frame in
which the linked page will
appear, if applicable. (Consult
the Help system for your Web
authoring software to learn
more about working with
frames.)
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• Message Text. Enter more descriptive information about
the linked Web page. The description will appear in the Web
browser status bar when the user hovers the mouse pointer
over the hotspot.

• Alt Tag. Enter a description
to appear in place of the
image content if the page is
displayed in a nongraphical
Web browser.

6. Click on OK. The Slice
Options dialog box will close and
the specified settings will be
applied to the slice.

Viewing and Hiding Slices
If it so happens that you do need to make further edits to the
sliced image before you save it as an HTML file, you can hide
the slice lines so they won’t distract you. Then, redisplay the
slices later, as needed.
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1. Click on View. The View
menu will appear.

2. Point to Show. The Show
submenu will appear.

3. Click on Slices. Photoshop
will uncheck the Slices command
and hide the slices in the image
file.

4. Click on View. The View menu will appear.

5. Point to Show. The Show
submenu will appear.

6. Click on Slices. Photoshop
will check the Slices command
and redisplay the slices in the
image file.
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NOTE
If you need to resize a
slice, right-click on the
Slice tool, and then click
on Slice Select Tool in the
shortcut menu that
appears. Then drag the
corner of the slice area to
resize it.



Saving the Sliced File in HTML
When you need to save the sliced file in HTML format, use the
Save for Web command on the File menu, as demonstrated
here.

1. Click on File. The File menu will appear.

2. Click on Save for Web. The
Save For Web dialog box will
open, with its Optimized tab
selected.
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TIP
If you previously used the Save for Web command to
save a JPEG or GIF image and specified a matte, you’re
going to want to be sure to remove that matte color.
Click on the Optimize menu button (the round button
with the arrow on it) in the Save For Web dialog box,
and then click Edit Output Settings in the menu. Open
the drop-down list that has HTML selected in it by
default, and then click on Background. Open the Color
drop-down list, click on None, and then click on OK to
return to the Save For Web dialog box.



3. Click on Save. The Save
Optimized As dialog box will
appear.

4. Edit the File name text box
entry as needed. The name you
specify will be applied to the
HTML file.

5. Click on Save. The Save
Optimized As and Save For Web
dialog boxes will close. Only the
original image will be open in
Photoshop. You can find the new
HTML file in the folder where
you saved it.
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TIP
Use the File, Open command in your Web browser to
open and preview the new HTML file. (Note that you can
use Save As to resave the file to use the shorter .htm
extension, instead.)  You can even click on the hotspot to
test the link. When you copy or move the Web page, be
sure to copy or move the accompanying \images\ folder
created by the HTML saving process. That folder holds
the actual sliced image content.
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Part VI Review Questions
1. What Web graphics formats can Photoshop create? See “Reviewing

Web Graphic Formats” in Chapter 20.

2. How do I save an image in a Web graphic format? See “Saving an
Optimized Image File” in Chapter 20.

3. How do I save an image with transparency so the Web page
background shows through? See “Saving a GIF” in Chapter 20.

4. What do I do if I want to save an image for a monochrome Palm
Pilot or other handheld device? See “Saving a WBMP” in Chapter
20.

5. How can I more quickly publish a collection of images to the Web?
See “Setting Up a Web Photo Gallery” in Chapter 20.

6. What’s a hotspot and how do I create one? See “Adding Slices or
‘Hotspots’” in Chapter 21.

7. How do I make sure a description of the link appears in the Web
browser status bar? See “Adding Slices or ‘Hotspots’” in Chapter
21.

8. The slices are in the way. Can I hide them? See “Viewing and Hiding
Slices” in Chapter 21.

9. What do I do to get the file with hotspots ready for the Web after
I’ve added the slices? See “Saving the Sliced File in HTML” in
Chapter 21.
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Among the many controversies regarding the Internet, protection
of original material (intellectual property in legal lingo) concerns a
wide variety of users—from individual graphic artists to huge record
companies. To protect your work, you have to have a way to identify
the digital matter you create.

Photoshop works with the digital rights management company
Digimarc to enable you to embed a digital watermark in your
Photoshop images and read the digital watermark information in
other images. Then, others who want to use your images can find
your contact information via Digimarc to license the images from you.
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Registering with Digimarc
To be able to add a digital watermark, you must register online
with Digimarc. You can watermark up to 99 images for free.
Beyond that, Digimarc charges a subscription fee based on the
number of images you plan to watermark per year. The
following steps detail how to register with Digimarc to obtain
the PIN and Digimarc ID you need to watermark your images.

1. Click on Filter. The Filter
menu will appear.

2. Point to Digimarc. The
submenu will appear.

3. Click on Embed Watermark.
The Embed Watermark dialog
box will open.
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NOTE
You must have an image file open, as well as a layer
that’s not locked, before you start the following steps.
Ideally, open an image to which you want to add a digital
watermark.
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4. Click on Personalize. The
Personalize Digimarc ID dialog
box will open.

5. Click on Info. Your Web
browser will open and the Dial-
up Connection dialog box will
open to prompt you to connect
to the Internet if you don’t have
an Internet connection that’s
always on. If your connection is
always on, you can skip to Step 7.
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NOTE
The first time you connect
under Windows XP, the
Network Connections
dialog box may appear
first. If it does, choose
your connection in the list,
and then click on Connect.
Click on Dial in the next
dialog box that appears. 



6. Click on Connect. Your
system will dial its Internet
connection and then will display
the initial Digimarc registration
page with pricing information.

7. Click on the Sign Up 
Today link. The Digimarc
ImageBridge™ Watermarking
Subscription Quote Step 1 of 4
page will appear.
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NOTE
If a Security Alert message
box appears, click on OK
to continue.



8. Click on the down arrow for
the top drop-down list. The
drop-down list will open.

9. Click on 1-99. That choice
will appear in the drop-down list. 

10. Click on the down arrow
for the bottom drop-down list.
The drop-down list will open.

11. Click on Digimarc
ImageBridge™ Basic
Watermarking. That choice will
appear in the drop-down list. 
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12. Click on Continue. The
Digimarc ImageBridge™
Watermarking Subscription
Quote Step 2 of 4 page will
appear.

13. Click on Continue because
there’s no need to change the
choices on this page. The
Digimarc ImageBridge™
Watermarking Subscription
Quote Step 4 of 4 page will
appear.
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14. Click on Continue. The
Digimarc ImageBridge™
Watermarking Subscription
Terms & Conditions page will
appear.

15. Use the scroll bars to scroll
both the page and the license
agreement information on the
page. The information will scroll
so that you will be able to review
the agreement.

16. Click on the Accept button. The next Digimarc ID Signup
page, where you enter information, will appear.
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17. Scroll down if needed, then
make choices and fill in fields as
needed to complete the
registration. The Web page will
scroll and display the registration
information you entered.

18. Click on the Submit
button, and click on Yes if you
see a Security Alert message
box. After Digimarc processes
your request, the Web page
indicating that your ID has been
assigned appears.

19. Click on the Print button on the toolbar. Your Web
browser will send your Digimarc PIN and ID information to the
printer.

20. Click on the Close (X)
button, and click on Disconnect
Now in the Auto Disconnect
dialog box when it appears (if
applicable). Your system will
disconnect from the Internet and
return to Photoshop.
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NOTE
If your system doesn’t
prompt you to disconnect,
right-click on the
connection button in the
system tray area at the
right end of the Windows
taskbar, and then click on
Disconnect.



21. Type your Digimarc ID and
PIN in the appropriate text
boxes in the Personalize
Digimarc ID dialog box. The
numbers will appear in the
boxes.

22. Click on OK. The
Personalize Digimarc ID dialog
box will close, and the PIN and
ID will be stored in the Embed
Watermark dialog box.
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NOTE
For some images, you may see a prompt to flatten the
image (combine its layers) or rasterize a shape or text
layer (convert the layer’s content to a bitmap or raster
format rather than a shape or vector format). In 
such cases, you can click on OK to proceed with
flattening/rasterizing and adding the watermark.
However, if you haven’t finished editing the image, you
may instead want to click on Cancel. You can then finish
the edits, make a copy of the image file (so you have a
version of the file that you can edit later), and embed the
watermark in the original.



23. Enter or change any
additional watermark settings
as needed. The settings will
appear in the Embed Watermark
dialog box. 

24. Click on OK. The Embed
Watermark dialog box will close
and the digital watermark will be
applied to the current image.

Embedding a Digital
Watermark
Embedding a digital watermark adds your Digimarc ID to it and
also identifies the image as copyrighted. Digital watermarking
doesn’t work well on images created primarily with solid colors;
in addition, the image must be adequate in size (generally 100
x 100 pixels for images to be used digitally and 750 x 750
pixels for images to be printed) to hold the watermark
information. Also note that you should embed the watermark
before you convert the image to a file format that will
compress the image information, such as the JPEG or GIF
format. Follow the process detailed next when you need to
add a watermark.
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1. Open the image to which you want to add a watermark.
The image appears in Photoshop.

2. Click on Filter. The Filter
menu will appear.

3. Point to Digimarc. The
submenu will appear.

4. Click on Embed Watermark.
The Embed Watermark dialog
box will open.
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NOTE
For some images, you may see a prompt to flatten the
image (combine its layers) or rasterize a shape or text
layer (convert the layer’s content to a bitmap or raster
format rather than a shape or vector format). In 
such cases, you can click on OK to proceed with
flattening/rasterizing and adding the watermark.
However, if you haven’t finished editing the image, you
may instead want to click on Cancel. You can then finish
the edits, make a copy of the image file (so you have a
version of the file that you can edit later), and embed the
watermark in the original. In other cases, you may see a
message to change the DPI of an image before adding
the watermark. Again, you can do so if you wish or
simply continue with the watermarking process. 



5. Type the year in the
Copyright Year text box.
Photoshop will mark the image
as copyrighted in the specified
year.

6. Click on check boxes in the
Image Attributes area. This 
will identify the image as
appropriate for particular types
of uses.

7. Click on the down arrow for
the Target Output list, and then
click on an output type in the list.
Photoshop will adjust the
Watermark Durability setting to
reflect the selected type of
output. (You can further change
those settings, if needed.)
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NOTE
If your image is set with 200 dpi or more and you choose
Web from the Target Output drop-down list, the DPI
Inconsistency dialog box appears to remind you to
convert (resample) the image to less than 200 dpi. Click
on OK to close the reminder dialog box. You will also
see the DPI Inconsistency dialog box if the image is set
to less than 300 dpi and you choose Print from the
Target Output drop-down list; in this instance, it
recommends that you resample the image to 300 dpi or
more. Also note that once you add the watermark using
one type of target output, you can’t repeat the process
for another type of output. So, choose the proper Target
Output type the first time.
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8. Click on OK. Photoshop will
apply the watermark and mark
the image as copyrighted. The
copyright symbol will appear
beside the file name in the file
window title bar.

Viewing a Digital Watermark
When you open an image that you think has a digital
watermark in Photoshop, you can check for the watermark and
look up the identity of the image’s creator.

1. Click on Filter. The Filter
menu will appear.

2. Point to Digimarc. The
submenu will appear.

3. Click on Read Watermark.
The Watermark Information
dialog box will open. It will
identify the creator ID (Digimarc
ID) for the person or
organization that created the
image, the copyright year, and
the usage restrictions that were
placed on the image.
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4. Click on Web Lookup. Your
Web browser will open and the
Dial-up Connection dialog box
will appear to prompt you to
connect to the Internet, if you
don’t have an Internet
connection that’s always on. If
your connection is always on,
you can skip to Step 6.

5. Click on Connect. Your
system will dial its Internet
connection. The Web browser
will then display the Digimarc
information for the image’s
creator.
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6. Click on the Print button on the toolbar. Your Web
browser will send the image creator’s name and ID information
to the printer.

7. Click on the Close (X)
button, and click on Disconnect
Now in the Auto Disconnect
dialog box (if needed). Your
system will disconnect from the
Internet and return to
Photoshop.

8. Click on OK. The Watermark
Information dialog box will close.
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Photoshop offers a wide variety of preferences that you can use to
adjust how it looks and operates. Use this appendix as a reference to
help you find a setting when you need it.
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Using Basic Preferences
No matter which preference you need, you can use one of a
few methods to find the dialog box that holds it. After you
learn here how to find a set of choices in the Preferences
dialog box, each subsection that follows reviews key
preferences in each set of choices.

1. Click on Edit. The Edit menu will appear.

2. Point to Preferences. The
Preferences submenu will
appear.

3. Click on General or one of
the seven choices in the next
group on the submenu. The
Preferences dialog box will open.
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4. Click on the down arrow
beside the list box at the top of
the dialog box. The list of various
preference sets will appear.

5. Click on a set in the list. The
Preferences dialog box will
display the selected settings.

6. Click on Prev or Next. The
Preferences dialog box will
display the previous or next set
of choices.
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NOTE
Assuming Tool Tips are enabled in Photoshop, you can
hover the mouse pointer over a Preferences dialog box
option to see what that option does.



General
• Color Picker and Interpolation. Control which Color Picker

appears when you display the Color Picker to choose image
colors, and choose which
Interpolation method
Photoshop uses if you
resample the image.

• Redo Key. Controls which
keyboard combination you
must press to redo an action
you just undid.

• Print Keys. Controls which
key combinations you must
press to preview and print an
image or print it directly. 

• History States. Controls how
many history states appear in
the History palette.

• Options. Choose to enable various operations, such as
whether Photoshop shows Tool Tips, includes Asian Text
Options, beeps after an operation, or displays font names in
English.

• Reset All Warning Dialogs. Resets warning dialog boxes so
that they will appear in the future if you’ve previously
disabled them.
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File Handling
• Image Previews. Controls whether Photoshop saves small-

image thumbnail files for previews, or prompts you to do so.

• File Extension. Specifies whether Photoshop uses
uppercase or lowercase characters for the file name
extension when saving.

• Ask Before Saving Layered
TIFF Files. For a previously

flat TIFF file into which you’ve added layers, displays the
TIFF Options dialog box when you save.

• Always Maximize Compatibility for Photoshop (PSD) Files.
When checked, saves composite image information, better
ensuring compatibility with earlier and future Photoshop
versions.

• Enable Workgroup Functionality. Enables the commands
on the Workgroup submenu of the File menu so that you can
automate the workflow for all users of your Photoshop files
on a network server. The accompanying options control how
Photoshop handles images that a user checks out and opens
from the server. 

• Recent file list contains. Controls how many files the File,
Open Recent submenu lists.
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NOTE
The capitalization for the
file name extension can be
important if an image is
for a Web page. For
example, some Web sites
only work if the file name
extension for Web pages
and graphics appears in all
uppercase characters,
such as .HTM or .GIF. 



Display & Cursors
• Color Channels in Color. When checked, the Channels

palette shows each channel in color rather than grayscale.

• Use Diffusion Dither. When
checked, Photoshop uses
diffusion dithering rather than
pattern dithering to eliminate
the “patchy” effect that can
appear when the monitor
displays fewer colors (such as
256 colors, or 8-bit color) than
the image file contains (such
as 16.7 million colors in a 24-
bit image).

• Use Pixel Doubling. When
checked, reduces onscreen
image resolution for faster
previewing after some
operations.

• Painting Cursors. Controls
how the mouse pointer looks
and behaves when a painting
tool is active.

• Other Cursors. Controls how
the mouse pointer looks and
behaves when a tool other
than a painting tool is active.
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Transparency & Gamut
• Grid Size. Controls the size of the grid used to depict

transparency in the Layers palette.

• Grid Colors. Controls the colors for the grid used to depict
transparency in the Layers palette.

• Use video alpha. When
checked, tells Photoshop to
use video hardware support
for previewing transparency.

• Opacity. Controls the opacity
of the warning color (specified
with the Color setting)
overlaying areas of color that
fall outside the color gamut
for the system or printer.

• Color. Chooses the warning
color to display for image
areas that use a color outside
the color gamut for the
system or printer.
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Units & Rulers
• Units. Enables you to choose the default measurement units

used for Rulers and Type sizes.

• Column Size. Enables you to
choose default column Width
and Gutter size used when
cropping and sizing images
for documents.

• New Document Preset
Resolutions. Enable you to
set the default print and
screen resolutions used by
new Photoshop files that you
create.

• Point/Pica Size. Controls the
true sizing used for points and
picas in Photoshop files.
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Guides, Grid & Slices
• Guides. Enables you to choose the Color and Style that

guides use when you display them.

• Grid. Enables you to choose
the Color and Style for
gridlines when you display
them, as well as the width
between major gridlines
(Gridline every) and the
number of minor grid sections
(Subdivisions) between each
pair of major gridlines.

• Slices. When an image
contains slices, enables you to
control the line color defining
each slice and whether slice
numbers appear.

Plug-Ins & Scratch Disks
• Additional Plug-Ins

Directory. Check this option,
and then click Choose to
identify another folder holding
plug-ins on your system’s hard
disk.

• Legacy Photoshop Serial
Number. If a plug-in requires
it, you can enter the
Photoshop serial number in
the old style here.

• Scratch Disks. Enables you to
specify additional hard disks
as temporary storage
(memory overflow) for in-
progress work in Photoshop.
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Memory & Image Cache
• Cache Levels. Controls how

many levels of image detail
Photoshop stores in a memory
cache. Increase the number
for faster screen redraw and
histogram generation.

• Use cache for histograms.
When checked, uses the
cached image information,
rather than rechecking the
image, for histogram
information.

• Maximum Used by
Photoshop. Controls how
much system memory
Photoshop can use during a
work session.
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Photoshop 7.0 for the Macintosh offers features identical to those
in the Windows version. To use Photoshop on the Mac (in OS X), you
need to be comfortable with only a few command, mouse, and
keystroke techniques that differ on the Mac side of things. Table C-1
lists the Windows command or technique and the Mac equivalent for
various functions in Photoshop.

CC
Mac Command
E q u i v a l e n t s
Mac Command
E q u i v a l e n t s



Table C-1 Mac Command Equivalents

Function Windows Mac

Preferences Edit, Preferences Photoshop, Preferences
Color Settings Edit, Color Settings Photoshop, Color Settings
Exiting File, Exit Photoshop, Quit Photoshop
Display tool shortcut menu Right-click on tool Control+click on tool
Display other shortcut menus Right-click Control+click
Select background color Alt+click on color ramp Option+click on color ramp
(Color palette)
Move a selection Ctrl+drag Command+drag
Undo Ctrl+Z Command+Z
Zoom out Alt+click Shift+Option+click
(Zoom tool)
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NOTE
Of course, the Mac has no Start menu as in Windows. To open Photoshop,
navigate to the folder that holds the Photoshop program icon (it’s typically a
subfolder of the Applications folder in Mac OS X), and double-click the icon to
start Photoshop. Also, you use the Calibrate utility in Mac OS X to calibrate
the monitor color settings, rather than a Control Panel choice.



Photoshop inspires more online interaction, publishing, and
software product development than many other programs due to the
wealth of features and options that Photoshop offers. In addition to
consulting the resources listed in Table D-1, you can search for
“Photoshop” using your favorite Web search engine to yield dozens
of links to sites offering tips, help, and downloads.

DD
O n l i n e
R e s o u rc e s
O n l i n e
R e s o u rc e s



Table D-1 Online Photoshop Resources

Category Resource Description

Online Forums www.adobe.com/support/ Go to this page to find links to
forums/main.html the Photoshop Mac and Windows

forums operated by Adobe. You
can log in as a guest, or register
to be able to post messages.

Online Tutorials www.adobe.com/products/ Adobe’s official tutorial site,
tips/photoshop.html with tips from leading experts.

Web Site www.photoshopuser.com The site for the National
Association of Photoshop
Professionals, providing publica-
tion reviews and training
resources.

Web Site www.planetphotoshop.com Offers online tutorials, links to
software downloads, links to other
Photoshop sites, and information
about resources such as seminars
and books. 

Web Site, Plug-ins www.thepluginsite.com Offers filters, plug-ins, and graph-
ics that you can download or pur-
chase, as well as other resources.

Web Site, Plug-ins www.desktoppublishing.com/ Known as the Photoshop Paradise
photoshop.html site, provides tips and tricks,

resources, and links to actions,
filters, and plug-ins.

Web Site www.elementkjournals.com/ips/ The Inside Photoshop online mag-
azine. View a sample issue.
Subscribe to access the greatest
variety of articles.
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Action. The equivalent of a macro in many
other programs. You record a series of
steps or commands you take in Photoshop,
so that you can later play back the steps
simply by running the action from the
Actions palette or by pressing the shortcut
key combination you assigned to the action
when you created it.

Adjustment layer. Add this special type of
layer when you need to display a color
correction or effect, or hide it when not
needed.

Alpha channel. A channel you add beyond
the default color channels in the image.
You can use the alpha channel to store a
selection or mask for the image.

Anchor point. When you create a curved
path, each anchor point represents the
transition between curved segments.

Animated GIF. A moving Web graphic file
that you create by converting layers to
frames in ImageReady (or another program
capable of generating animation),
specifying animation settings, and then
saving the file as a .GIF file.

Anti-aliasing. A correction that sharpens the
jagged edges of a selection, preserving as
much detail as possible.

Auto Slice. (See Slice.)

Background erase. When you use the
background eraser tool, Photoshop makes
the pixels you drag over transparent on the
current layer or all layers.

Background layer. When you create a new
image, the first layer is a background layer
that you can make white, transparent, or
fill with a background color that you
specify. The exception occurs when you
import an image from a scanner or digital
camera; in that case, the image itself
becomes the background layer.

Bleed. When you create a bleed for printing,
you specify that the image content 
should extend slightly beyond the crop
boundaries of the image, so there won’t be
any unwanted unprinted edges once the
output is trimmed to its final size.

Blur. Adding some fuzziness or decreasing
the focus in selected areas of an image to
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soften the image appearance or
camouflage a defect.

Border. A small line you specify to be printed
around the edge of an image.

Brightness. A setting that controls the overall
lightness of an area.

Burn. The equivalent of a traditional photo
development technique, in which you
increase the “apparent exposure” of an
area in the image to increase the contrast
and darken the specified area.

Canvas size. The size of the white page that
holds your image content in the image
window.

Channel. Photoshop divides the colors in a
color (or grayscale) image into separate
channels that you manage via the Channels
palette. The default color mode, RGB
color, uses four channels—one each for the
red, green, and blue channels, plus a
composite channel that shows the
individual channels combined. Channels
enable you to make color corrections for
just the selected channel, without altering
the other channels.

Check box. In a dialog box or on a toolbar,
you click on a check box to toggle a
feature on and off. The feature is on or
selected when the check box is checked,
and off or deselected when it isn’t.

Clipping path. A path you use to designate
part of an image so that only that portion
appears when you save the file as an .EPS,
.DCS, .PDF, or .TIFF file for inclusion in
another document. The areas outside the

clipping path will be transparent after the
save, so that you can better lay out the
document text in relation to the image.

Color balance. The overall proportion of
various colors in the image.

Color mode. Identifies what type of color
model is being used for the image. For
example, grayscale images use only shades
of gray, with one grayscale color channel
by default. CMYK (Cyan, Magenta, Yellow,
Black) color has been optimized for full,
four-color printing. RGB color optimizes
images for onscreen display; monitors
combine red, green, and blue pixels to
form colors. Lab color uses luminance and
brightness settings to optimize color for
various devices. Multichannel mode adapts
the image for special printing situations,
converting image tones to 256 gray
shades. Indexed color converts an image
to 256 colors for use on Web pages.
Duotone mode converts an image for
traditional duotone printing, which uses
only two ink colors—typically black and a
lighter tone—to yield a nicely tinted image.
Finally, Bitmap mode can be used to create
black-and-white images. 

Color separations. After an image has been
converted to CMYK color, it can be used to
generate color separations for professional
printing. Each separation represents a 
film sheet that will ultimately be used to
create a printing plate, with each plate
representing a single ink color to be
printed. Full-color printing uses a minimum
of four color plates—Cyan, Magenta,
Yellow, and blacK.
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Command button. In a dialog box or on a
toolbar, you click on a command button 
to choose the command the button
represents. When an ellipsis (...) follows the
button name, clicking on the button
displays a dialog box where you can
specify further options.

Context menu (shortcut menu). A
specialized menu that appears when you
right-click on a screen element or a toolbox
tool. The menu offers commands
pertaining to the current tool, image, or
selection.

Contrast. A color setting that determines the
overall variation between the light points
and dark points in the image. In some
cases, increasing contrast can help the
image appear to have a bit more detail.

Direction line. When creating curved line
segments, you use the direction points on
direction lines emerging from the curved
segment to specify the direction and depth
of the curves.

Direction point. A point at the end of the
direction line that you drag to specify the
direction (drag horizontal to the curve
segment) and depth (drag perpendicular to
the curve segment) of the curve.

Dithering. When an image uses more colors
than your monitor can display, Photoshop
uses dithering to compensate for the color
discrepancies.

Dodge. The equivalent of a traditional photo
development technique, in which you
decrease the “apparent exposure” of an

area in the image to decrease the contrast
and lighten the specified area.

Draw program. A program that creates
vector objects—objects created from
outlines so that you can later edit them—
which often have a more compact file size
and can be resized with limited quality loss.

Drop-down list box. In a dialog box or on a
toolbar, a list you open by clicking on an
arrow. The list presents available choices
when opened, and you can click on the
desired choices once the list is opened.

Droplet. An action you save as an
independent program, so that it can be
used outside of Photoshop.

Erase. Removing the foreground pixels on a
layer to reveal the background color or
transparency.

Feathering. A correction that blurs the edges
of a selection by adding a shift zone of a
pixel width that you specify. Feathering
can cause the edges of the selection to
lose detail.

File Browser. A new feature in Photoshop
that enables you to find files by browsing
through thumbnail previews. 

Gamut. The range of colors that your system
can actually display. You can set up
Photoshop to display a warning if an image
includes colors outside the gamut.

Grid. Spacer lines you can display to help
align objects in an image.

Halftone Screens. (See Screens.)
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Healing Brush tool. A new tool that helps
you to remove scratches and spots from
scanned photographs. 

Histogram. A graph you can display to see
how much of an image’s content (roughly
how many pixels) fall within various color
intensity levels in the image.

Hotspot. (See Slice.)

Image resolution. (See Resolution.)

Image size. The dimensions of the image file,
in inches, centimeters, points, picas, or
pixels.

Interlaced. When you save a file and make it
interlaced (an option available when you’re
saving an image into common Web graphic
file formats), part of the image can “pre-
load” on the Web page. This means that
the user will see the image at low
resolution until the full file downloads.

Interpolation. The method that Photoshop
uses to determine how to add content
(when changing to a higher resolution) or
remove content (when changing to a lower
resolution) when you resample the image
to resize it or change its resolution.

Layer. In Photoshop, you can store different
types of content on different logical
“sheets” or layers in the image, so that
later you can manipulate the content of
each layer separately . For example, text
that you add to an image with the Text
tool always appears on a new layer.

Layer mask. A mask you create based on a
selection on a layer. Layer masks typically
define fuzzier areas than vector masks. 

Magic eraser. Use this tool to remove or
change contiguous pixels of one color (or
non-contiguous pixels in that color) on a
layer.

Mask. A special type of select you use to hide
part of a layer, so that you can manipulate
only the visible portions of the layer.

Option button. In a dialog box or on a
toolbar, a round button that you click on to
choose or enable the option it represents.
Option buttons typically appear in a group,
with the members of the group being
mutually exclusive. That is, when you click
on one option in the group, all other
options in the group will be deselected.

Options bar. When you select a toolbox tool,
the options bar below the Photoshop
menu bar presents choices you can use to
adjust how the tool will operate.

Paint program. A program that enables you
to create an image by recoloring pixels
using various tools. Paint programs
typically create bitmap images, which are
larger in file size and harder to edit than
vector images. Resizing bitmap images to a
larger size often makes them look jagged
and unattractive.

Palette. A special collection of tools or
settings. Photoshop organizes its palettes
on tabs in special palette windows that
appear at the right side of the Photoshop
window by default.

Pantone or Pantone Matching System
(PMS). This color-matching system has
become the standard in professional
printing, design, and image processing. A
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PMS number identifies each unique ink
color. So, for example, when you use a
particular spot color (and identify it by its
PMS number) in images or documents that
are printed at a different time, the spot
color should be identical in the print jobs.

Pattern Maker. A new plug-in that enables a
user to create, adjust, and preview a new
pattern based on a selection from an
image file. 

Picture Package. A new feature that enables
you to print multiple images on a single
page, so that you can quickly develop
“proof sheets” for a collection of images. 

Pixels. A variation of the phrase “picture
element,” each pixel is a single dot of color
in the image. Higher resolution images
have smaller pixels, and therefore look
more detailed and smooth, and less grainy.

Plug-ins. Special add-in programs that you
can install to extend Photoshop’s
functionality. Most plug-ins add new filters
into Photoshop, but some offer more file
format and import/export options. You can
purchase numerous plug-in collections, and
even download freeware and shareware
plug-ins from any of dozens of Web sites.

Posterizing. A special effect that reduces the
number of colors used in the image, so
that the image becomes composed of
larger color areas, much like the way
posters used to be designed and printed
or like paint-by-number pictures. 

ppi (pixels per inch). (See Resolution.)

Preset. A collection of settings for a
particular tool, or a special brush shape or
pattern for a particular tool. Presets are
saved in library files.

Preset Manager. A feature that enables you
to load and unload preset libraries, as well
as to create new libraries. 

Raster images. Also called bitmap images,
these are images composed of individual
colored pixels. Paint programs typically
create raster images.

Rasterize. Converting vector (resizeable line)
objects in an image to raster (bitmap)
content. In Photoshop, you sometimes
must rasterize text layers (which are vector)
before you can perform certain commands
or add certain effects to the text layer.

Resample. Resizing an image and/or
changing its resolution.

Resolution. The quantity of pixels (image
dots) that print per unit of measure in the
image, usually expressed as pixels per inch
(ppi). The higher the image resolution
value, the finer the quality of the image.
For example, an image that has 300 ppi
has much more color detail than an image
at 72 ppi, because at the higher resolution
the pixels are smaller (more pixels packed
in per inch, for example). This necessitates
smaller pixels of color, and therefore a
finer appearance.

Rollover. A special effect you create for a
Web image that causes part of the image
to change when the user performs a
certain mouse action. For example, you
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might set up a glow to appear behind part
of the image when the user moves the
mouse pointer over that area of the image.

Sampling. A method of creating a new brush
or pattern based on a selected portion of
an image.

Screens. Used for professional printing, the
screen settings specify how the image
color should be broken up into printed
dots.

Sepia. A variation of grayscale, where an
image typically appears in ivory and brown
tones rather than black-and-white.

Slice. An area you identify on an image for
conversion to a hotspot—a clickable Web
hyperlink.

Slider. In a dialog box or on a toolbar, a small
thumb or bar you drag with the mouse to
change the setting for an item.

Smudge. A tool you use to drag one color
into another on a layer.

Spinner buttons. Click on one of these small
up and down arrow buttons beside a text
box to increase (up spinner button) or
decrease (down spinner button) the value
held in the text box. 

Spot color. A small area of color you specify
to overprint other colors on an image. You
set up a spot color as a separate channel.
For professionally printed documents, the
spot color will be applied by a completely
separate printing plate.

Text box. In a dialog box or on a toolbar, a
box into which you type an entry. Text

boxes that hold numeric settings often also
include spinner buttons, which you can
click to increase or decrease the text box
entry.

Tolerance. For several tools, the tolerance
setting indicates how precise Photoshop
must be in matching a specified color. A
higher tolerance setting means the tool
typically will match more colors.

Tonal quality. The amount of highlights and
shadows in an image, which can impact its
overall appearance of brightness.

Toolbox. The small window or strip at the left
side of Photoshop that presents its key
drawing, painting, selection, and other
tools.

Trapping. Specifying that blocks of (usually)
solid color should overprint each 
other during professional printing, to
compensate for possible slight shifts in the
printing plates. Your print shop can tell you
whether you need to add trapping for your
images.

Tweening. A technique by which a program
like ImageReady can improve an animation.
When an application uses tweening, it
extrapolates to create additional animation
frames between two selected frames, so
that the animation will appear more
smooth and natural. 

URL (Uniform Resource Locator). The unique
address that identifies a Web site or page
on the Internet. For example, one of
Adobe’s Web pages can be found at
www.adobe.com/products/tips/
photoshop.html.
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User slice. (See Slice.)

Vector images. Images composed of editable
line objects, so the objects themselves can
be edited individually and the image can
be resized to a great degree without
quality loss.

Vector mask. A mask that hides or displays a
clear shape on a layer based on a path. 

WBMP. A graphic file format optimized for
small devices such as wireless devices. 

Work area. The area that holds the image
window and other tools in Photoshop.

Work path. A temporary path you create
with a pen or shape tool that you can save
as a path to reuse later.

Workspace. A saved arrangement of the
toolbox and palettes onscreen in
Photoshop.

XMP (Extensible Metadata Platform). A file
standard for appending descriptive
metadata to a file. Photoshop enables you
to save an .XMP file and append it to the
File Info for any file. 
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8-bit color, 366, 367, 390
16-bit color, 366, 367, 390

A
actions, 413–422

adding to sets, 415
creating, 414–417
described, 414, 489
downloading from Web, 417
droplets, 419–422, 491
mouse, 493–494
settings for, 416
using, 418

Actions palette, 414–418
Add Anchor Point tool, 240–241
adjustment layers, 209, 221, 378, 489
Adobe Gamma dialog box, 354–355
Adobe Gamma utility, 353–359
Adobe Gamma Wizard, 355–358
Adobe Online, 18–20
airbrush effect

Burn tool, 286
Dodge tool, 285
Sponge tool, 288

Airbrush tool, 73–74
alignment

selections, 128, 149, 151, 152–154

Snap To feature, 152–154
alpha channels

adding, 361, 381–383
described, 381, 489
naming, 383
spot color, 386–389

anchor points, 232, 236, 239–242, 303, 489
animated GIFs, 489
anti-aliasing, 109, 489
arrow button, 8, 64
Artistic filters, 310
ASCII format, 340
Assign Profile dialog box, 360
ATN files, 417
Auto Color command, 374
Auto Color Corrections dialog box, 374
Auto Resolution dialog box, 300–301
automations, 419

B
background color

adding to printouts, 337–339
choosing, 26–27, 66–69
Eraser tools, 272, 273
fills, 178
gradients, 278
presets, 160
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Background Eraser tool, 273–275, 489
background layers

creating, 172, 173
described, 489
fill, 178
masks and, 208, 246
transparent, 172, 173, 179, 182, 222, 429

balance, color, 376–378, 490
bit depth, 189, 366–367
bitmap images, 493
Bitmap mode, 352
black-and-white images, 352, 379
Bleed dialog box, 335–336
bleeds, 335–337, 489
blending modes, 173, 178, 182
Blur filters, 310
Blur tool, 262–264, 266
blurring, 262–264, 489–490
BMP format, 30
Border dialog box, 134–135, 333–334
borders

described, 490
printing images with, 332–334
selection, 134–135
width of, 333

bounding boxes, 128
brightness

described, 490
images, 352, 378–379
monitor, 356

Brightness/Contrast dialog box, 378–379
Brush Name dialog box, 90
Brush Strokes filters, 310
brushes

Background Eraser tool, 274–275
Blur tool, 263
Burn tool, 286
choosing, 263
creating, 89–90
custom, 89, 93–94

deleting, 92–93
displaying, 91
Dodge tool, 285
Eraser tools, 270
graphics tablets and, 290
Healing Brush tool, 289–290
sampling, 89–90
Sponge tool, 288

Brushes palette, 89–94
Burn tool, 285–287
burning photographs/images, 285–287, 490

C
cache, 484
Calibrate utility, 486
calibration

images, 340
monitors, 353–358

Calibration Bars option, 340
Cancel button, 7, 133
canvas

rotating, 304–305
size of, 302–304, 490
trimming, 306–307

Canvas Size dialog box, 303–304
Caption option, 340
captions, 340
Center Crop Marks option, 340
Channel Mixer dialog box, 396–397
Channel Options dialog box, 382–383
channels

alpha. See alpha channels
blending, 396
color. See color channels
composite, 364, 389
described, 490
editing content on, 363–364
hiding, 362
loading selections from, 383
naming, 383
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saving selections and, 140
Channels palette, 361–362, 381–383, 386–388
check boxes, 6, 65, 490
Check Spelling dialog box, 83–84
Clipboard, 129
clipped content, 252–256
Clipping Path dialog box, 251
clipping paths, 249–256, 490
CMYK color, 69, 364–365, 389
CMYK mode, 352
CMYK printing, 69, 325, 349
color, 351–372

8-bit, 366, 367, 390
16-bit, 366, 367, 390
adding to printouts, 337–339
adjusting automatically, 374
adjusting display, 353–359
Airbrush tool, 74
background. See background color
balance, 376–378, 490
bit depth, 366–367
brightness, 352, 378–379
burning, 285
calibration, 340
channels. See color channels
CMYK, 69, 364–365, 389
contrast, 287, 374, 378–379, 491
converting grayscale to, 369
correcting, 373–383
custom, 392–393
desaturation, 288
duotone images, 390–394
erasing, 269–272, 276–277
fill layers, 178–180
fills, 281–284
foreground. See foreground color
gamut, 481, 491
gradient layers, 181–184, 278
grayscale. See grayscale images
grids, 481, 483

Grow command, 137
guides, 483
hue, 221–224
indexed, 352, 437
ink, 326, 331, 352
layers, 173, 200
Line tool, 76
Magic Wand tool, 117–120
masks, 204–207, 221–224
matte, 433, 438, 452
modes. See color modes
opacity and, 481
out-of-gamut colors, 481
Paintbrush tool, 71, 94
Pantone, 393, 492–493
paths, 242–244
Pencil tool, 72
posterizing effect, 379, 380, 493
presets, 161
printing, 326, 329–332, 481
proofing, 371–372
recoloring part of image, 221–224
reducing number of, 379
reversing, 379
RGB, 352, 365, 366, 389
sampled, 119
saturation, 221–224, 285, 287
separations, 364–365, 369–370, 490
sepia images, 395–397
shape tools, 77–78
Similar command, 137
slices and, 483
smudging, 264–266
special effects, 379–380, 385–397
spot, 386–389, 494
tints, 390–394
tonal quality settings, 375–376
for tools, 66–69
Type tool, 79
warning, 481
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color, (continued)
Web and, 437

Color Balance dialog box, 377
color channels, 361–364

adjusting, 397
changing to, 361–362, 480
editing, 363–364
Multichannel mode, 352, 393, 394

color correction, 221–224
color depth, 366
Color Management option, 342
color modes

changing, 364–369
converting between, 365
described, 26, 490
overview, 352

Color palette, 12, 13, 67–69
Color Picker

changing masks, 211–212
choosing colors, 68–69, 338
layer creation, 179–180
preferences, 478
spot colors, 387–388

color plates, 371–372, 393
color profiles, 359–360
Color Range dialog box, 118–120
columns, 110–111, 482
command buttons, 7, 491
commands. See also specific commands

executing, 5, 9
filter commands, 219–220
Mac OS equivalents, 485–486

composite channels, 364, 389
compression

described, 428
JPEG files, 431–435

Confirm Password dialog box, 48–49
Constrain Proportions check box, 300
contact sheets, 344

content
blurring, 262–264
on channels, 363–364
clipped, 252–256
erasing, 269–277, 491
help, 14–18
hiding on layers, 174
reusing, 176
selecting. See selections
on separate layers, 171
smudging, 264–266

context menu command, 9
context menus, 9, 491
Contract command, 138
contrast

images, 287, 374, 378–379, 491
monitor, 356

copying
layers, 175–177
paths, 249–250, 251
selections, 129–131

Corner Crop Marks option, 340
corner points, 232
Create Droplet dialog box, 419–421
Crop dialog box, 298
crop marks, 335, 340
Crop tool, 296–298
cropping

images, 296–298, 306–307
perspective cropping, 297
photographs, 217–218, 296–298

cursors, 480
Custom Colors dialog box, 391–392
Custom Shape tool, 78, 226
customizing

brushes, 89, 93–94
colors, 392–393
filters, 310
patterns, 190
shapes, 78, 226
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D
Define Pattern command, 189
deleting

anchor points, 241
brushes, 92–93
guides, 157
in History list, 144
layer masks, 223
layers, 194–195, 201
masks, 211, 213
patterns, 190
selections, 126–127

Dial-Up Connection dialog box, 19, 461, 472
dialog boxes

Adobe Gamma, 354–355
Assign Profile, 360
Auto Color Corrections, 374
Auto Resolution, 300–301
Bleed, 335–336
Border, 134–135, 333–334
Brightness/Contrast, 378–379
Brush Name, 90
Canvas Size, 303–304
Channel Mixer, 396–397
Channel Options, 382–383
Check Spelling, 83–84
Clipping Path, 251
closing, 7
Color Balance, 377
Color Range, 118–120
Confirm Password, 48–49
Create Droplet, 419–421
Crop, 298
Custom Colors, 391–392
Dial-Up Connection, 19, 461, 472
DPI Inconsistency, 470
Duotone Options, 390–393
Duplicate Layer, 175, 246
Duplicate Path, 250

Embed Watermark, 460–471
Fade, 314
File Info, 36–42
Find and Replace Text, 85–86
Gradient Editor, 183, 280
Gradient Fill, 182–184
Halftone Screens, 326–328
Hue/Saturation, 222–224
Image Size, 299–302
Layer Properties, 195–196
Layer Set, 199–200
Layer Style, 196–197
Levels, 375–376
Load, 41
Load Selection, 141
Network Connections, 19, 461
New, 24, 130, 254–255
New Action, 416
New Guide, 155–156
New Layer, 172–174, 178–179, 182
New Set, 415
New Spot Channel, 387–388
New Tool Present, 161
Open, 28–29
Options, 45
Page Setup, 318–320
Pattern Fill, 186–187
Pattern Name, 189
PDF Options, 47–49
PDF Security, 48–49
Personalize Digimarc, 461
Picture Package, 344–346
Place, 255–256
Posterize, 380
Print, 323–343
Properties, 319–320
resetting, 478
Save, 39
Save As, 42–47, 252–253
Save Optimized As, 453
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dialog boxes, (continued)
Save Path, 228, 233, 237–238
Save Selection, 139–140
Save Workspace, 54–55
Select an Image File, 345
Slice Options, 449–450
Smooth Selection, 136
Transfer Functions, 330–331
Trap, 370
Trim, 306–307
typical choices in, 6
warning, 478
Warp Text, 80–81
Watermark Information, 471–473

diffusion dithering, 480
Digimarc, 459, 460–468
digital cameras

importing images, 33–35
transparent backgrounds and, 428

digital watermarks, 459–473
Direct Selection tool, 241–242
direction lines, 491
direction points, 491
display, 353–359, 480. See also monitor
Distort filters, 310
Distort transformation, 131
distorting selections, 131
dithering, 437, 441, 480, 491
Dodge tool, 284–285
dodging photographs/images, 284–285, 491
DPI Inconsistency dialog box, 470
draw programs, 70, 491
drawing

lines, 75–76
shapes, 77–78

drawing tools, 75–78
drop-down list boxes, 6, 491
droplets

described, 491

making, 419–421
using, 421–422

duotone images, 390–394
Duotone mode, 352
Duotone Options dialog box, 390–393
duotone printing, 352
Duplicate Layer dialog box, 175, 246
Duplicate Path dialog box, 250

E
Edit menu, 142
editing color channels, 363–364
editing tools, 261–294
Ellipse, 108–110
ellipsis (...), on menus, 7, 9
Elliptical Marquee tool, 108–109
Embed Watermark dialog box, 460–471
Emulsion Down option, 340
Encoding option, 340
EPS files, 325
Equalize command, 379
Eraser tool, 269–272
erasing

with Background Eraser tool, 273–275
described, 491
with Eraser tool, 269–272
with Magic Eraser tool, 276–277

EXE files, 421
Exit command, 21
Expand command, 138
exposure, 285, 286
Extensible Metadata Platform. See XMP
extensions, file, 479
Eyedropper tool, 69, 119, 120

F
Fade command, 313
Fade dialog box, 314
fading items, 313–315
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Feather command, 138
feathering, 107, 138, 491
File Browser, 52–53, 491
file formats

ASCII, 340
BMP, 30
clipping paths and, 253
GIF, 30, 428
HTML, 428, 452–454
ICO, 405
JPEG, 30, 428
PCX, 30
PDD, 43
Photo CD, 30
PICT, 30
PNG, 428
saving files to other formats, 43–49
supported by Photoshop, 30, 44
TIFF, 30
WBMP, 428, 495
Web graphics, 428–429

File Info dialog box, 36–42
files

applying plug-ins to, 405–408
ATN, 417
browsing, 52–53, 491
EPS, 325
EXE, 421
extensions, 479
finding, 52–53, 491
GIF. See GIF files
HTML, 448, 454
JPEG, 430, 431–435
PDF, 46–49
Photoshop. See Photoshop files
preferences, 479
recent, 28, 479
saving. See saving
sliced, 452–454
TIFF, 479

WBMP, 440–442
Fill command, 135
fill layers, 178–180, 185, 213
Fill Path with Foreground Color button, 244
Fill pixels button, 76
fills

color, 281–284
gradient, 279
layers, 178–180
Paint Bucket tool, 281–284
paths, 242–244
patterns, 283

film separations, 340
filter commands, 219–220
filter plug-ins, 407–408
filters, 309–316

adding, 219–220
applying, 311–312
Artistic, 310
Blur, 310
Brush Strokes, 310
for corrections, 262
custom, 310
described, 309
Distort, 310
fading, 313–315
layers and, 311
masks and, 219–220
Noise, 310
overview, 310
Pixelate, 310
reapplying previous, 315–316
Render, 310
Sharpen, 310
Sketch, 310
Stylize, 310
Texture, 310
Video, 310
Web sites, 488

Find and Replace Text dialog box, 85–86
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finding
with File Browser, 52–53, 491
help topics, 17
Photoshop files, 52–53, 491

Finger Painting check box, 266
Fixed Aspect Ratio option, 107, 109
Fixed Size option, 107, 109
flattening

images, 201, 365, 366, 368
layers, 201, 365, 366
watermarks and, 467, 469

Flip transformation, 131
flipping selections, 131
foreground color

choosing, 66–69
Eraser tools, 273
fills, 281–284
gradients, 181
masks, 212
paths, 244
presets, 160

formats, file. See file formats
frames, 449
Free Transform command, 133
freeform paths, 234–238
Freeform Pen tool, 234–238
Fuzziness slider, 119

G
gamma, monitor, 357
gamut, 481, 491
general preferences, 476–478
Get Picture command, 35
GIF files

animated, 489
matte colors and, 433
options for, 429
saving, 435–439
transparency and, 438

GIF format, 30, 428
Gradient Editor dialog box, 183, 280
Gradient Fill dialog box, 182–184
gradient layers, 181–184, 278
Gradient Picker box, 280
Gradient tool, 279–280
gradients

adding to layers, 278–281
fills, 279
presets, 280
styles, 183, 279, 280

graphics. See images
graphics tablet, 290
grayscale images

adding tints to, 390–394
bit depth, 366
contrast in, 287
converting to, 368–369
converting to color, 369
converting to sepia, 395–397

Grayscale mode, 352
gridlines, 148, 483
grids

color, 481, 483
described, 491
preferences, 481, 483
showing/hiding, 148–149
size of, 481
snapping to, 149, 152–154
style, 483

grouping layers, 199–201
Grow command, 137
guides

adding, 154–157
clearing, 157, 158
color, 483
deleting, 157
described, 154
locking, 158–159
preferences, 483
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snapping to, 152–154
style, 483

H
halftone screens. See screens
Halftone Screens dialog box, 326–328
Hand tool, 102
handles, 128, 133
Healing Brush tool, 288–291, 492
Help contents, 14–18
help features, 14–20
Help menu, 15, 18
hiding

channels, 362
content, 174
grids, 148–149
layers, 214
rulers, 150–151
screen elements, 10–14
slices, 450–451
toolboxes, 10

highlights, 375, 376
histograms, 492
History list, 143–144
History palette, 143–145, 478
history states, 478
hotspots. See sliced elements
HTML files, 448, 454
HTML format, 428, 452–454
Hue/Saturation dialog box, 222–224

I
ICC profiles, 355
ICO format, 405
icon format, 405
Ignore Palettes option, 98, 100
image files. See Photoshop files
Image Size dialog box, 299–302
image view, 95–103

image windows, 176
ImageReady, 401
images. See also photographs

backgrounds. See background color;
background layers

bit depth, 189
bitmap, 493
black-and-white, 352, 379
bleeds, 335–337, 489
blurring, 262–264, 489–490
borders, 332–334
burning areas of, 285–287, 490
cache, 484
captions for, 340
changing color mode, 364–369
color in. See color
converting to grayscale, 368–369
creating for Web, 427–446
cropping, 296–298, 306–307
dimensions, 25
dodging areas in, 284–285, 491
dragging, 102
duotone, 390–394
erasing content, 269–277, 491
fitting to screen, 100–101
flattening, 201, 365, 366, 368
foregrounds. See foreground color
high-contrast, 379
importing, 30–35
labels, 346–347
patching, 292–294
previewing, 479
printing. See printing
raster, 493
recoloring parts of, 221–224
repairing imperfections, 288–291
resizing, 296–304
resolution of, 25, 26
scanned. See scanned images
selecting content. See selections
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images, (continued)
separating into layers, 201
sepia, 385, 395–397, 494
settings, 25
sharpening, 266–269
size of, 130, 492
slicing, 447–454
smudging, 264–266
thumbnails, 344
tonal quality settings, 375–376
transfer settings, 329–332
trimming, 306–307
vector, 495
watermarks for, 459–473
Web Photo Gallery, 442–446

Import command, 31
importing

digital camera images, 33–35
images, 30–35
scanner images, 31–32

Include Vector Data option, 340
index links, 16
indexed color, 352, 437
Indexed Color mode, 352
ink colors, 326, 331, 352
interlacing, 429, 430, 492
Internet, 428. See also Web
interpolation, 340, 478, 492
Interpolation option, 340
Invert Image command, 379

J
JPEG files, 430, 431–435
JPEG format, 30, 428
JPEG option, 340

L
Label settings, 346–347
labels, 346–347

Labels option, 340
Lasso tool, 111–116
layer masks, 208–217, 223, 492
Layer Properties dialog box, 195–196
Layer Set dialog box, 199–200
layer sets, 173, 200, 201
Layer Style dialog box, 196–197
layers, 171–201

adding gradients to, 278–281
adjustment, 209, 221, 378, 489
arranging, 187, 198–199
background. See background layers
blending, 182
blurring and, 262–264
color, 173, 200
content on, 171
copying between images, 176–177
creating, 172–174
creating masks on, 209–211
deleting, 194–195, 201
described, 492
duplicating, 175–176
erasing on, 269–277
fill, 178–180, 185, 213
filters and, 311
flattening, 201, 365, 366
gradient, 181–184, 278
grids and, 148
grouping, 199–201
hiding, 214
hiding contents of, 174
moving, 187
naming, 173, 175, 178, 182
opacity of, 173, 174, 182, 222
order of, 198–199
painting and, 70
pattern, 184–187
properties, 195–196
removing, 194–195, 201
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reusing, 176–177
selecting, 128, 174, 199
sending to back, 180
separating images into, 201
sepia tones on, 395
styles, 196–197
text, 79–82
thumbnails, 224
TIFF files, 479
ungrouping, 199–201, 201

Layers palette, 13, 14, 174, 194–201
Levels dialog box, 375–376
lighting, 284
Line tool, 75–76
lines

direction, 491
drawing, 75–76
grid, 148, 483

Liquify plug-in, 409–411
Load dialog box, 41
Load Path as a Selection button, 245
Load Selection dialog box, 141
loading selections, 140–141
Lock Guides command, 158–159
locking guides, 158–159
luminance settings, 352

M
Mac command equivalents, 485–486
Mac OS–based systems, 485, 486
macros. See actions
Magic Eraser tool, 276–277, 492
Magic Wand tool, 116–120
Magnetic Lasso tool, 111, 114–116
Magnetic Pen tool, 235, 236
magnification. See zooming
Marquee tool, 106–111
masks, 203–224

background layers and, 208, 246

changing, 211–213
color, 204–207, 221–224
controlling, 216–217
creating on layers, 209–211
cropping photos, 217–218
deleting, 211, 213
described, 203, 492
enabling/disabling, 216–217
filters and, 219–220
layer, 208–217, 223, 492
opacity, 205
Quick Mask mode, 204–208
recoloring part of image, 221–224
selection adjustment, 205–208
selections as, 214–216
temporary, 205
thumbnails, 210, 211, 216, 248
vector, 246–248, 495
working with, 217–224

matte colors, 433, 438, 452
measurement units, 336, 482
memory

cache, 484
open files and, 50
preferences, 484

menus, 5, 9
midtones, 376
moiré, 327
monitor. See also display

brightness, 356
calibration, 353–358
contrast, 356
diffusion dithering, 480
gamma setting, 357
phosphors, 356

Monochrome option, 396
mouse actions, 493–494
Move tool, 127–128, 149
Multichannel mode, 352, 393, 394
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N
Navigator palette, 11, 12, 103
Negative option, 340
network connections, 19, 461–462, 472
Network Connections dialog box, 19, 461
New Action dialog box, 416
New dialog box, 24, 130, 254–255
New Guide dialog box, 155–156
New Layer dialog box, 172–174, 178–179, 182
New Set dialog box, 415
New Spot Channel dialog box, 387–388
New Tool Preset dialog box, 161
notes, 87–88
Notes tool, 87–88

O
opacity

layer sets, 200
layers, 173, 174, 182, 222
masks, 205
preferences, 481
warning color, 481

Opacity setting, 173, 174, 182
Open dialog box, 28–29
Open Recent command, 28
optimization. See compression
option buttons, 6, 492
Option dialog box, 45
options bar, 8, 63–65, 492
ovals, 77–78

P
Page Setup dialog box, 318–320
Paint Bucket tool, 281–284
paint programs, 70
Paintbrush tool, 70–71, 93–94
painting cursors, 480
painting tools, 70–74

Airbrush tool, 73–74

color, 71
layers and, 70
mouse pointer and, 480
Paintbrush tool, 70–71
Pencil tool, 72–73

palettes
Actions, 414–418
Brushes, 89–94
Channels, 361–362, 381–383, 386–388
Color, 12, 13, 67–69
described, 492
History, 143–145
Ignore Palettes option, 98, 100
Layers, 13, 14, 174, 194–201
Navigator, 11, 12, 103
organizing, 54–56
Paths, 226, 227, 239–242
pop-up, 9
Presets, 159–167
selecting, 7
selecting items on, 8
tabs in, 8
Tool Presets, 160–164

Pantone colors, 393, 492–493
Pantone Matching System (PMS), 492–493
password-protected PDF files, 46–49
Patch tool, 292–294
patching images, 292–294
Path Selection tool, 241, 242, 248
paths, 225–256

anchor points, 232, 236, 239–242
changing, 239–242
clipping, 249–256, 490
coloring, 242–244
copying, 249–250, 251
creating, 226–248
described, 225
deselecting, 229, 234, 242
filling, 242–244
freeform, 234–238
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naming, 228, 233, 238
pen, 229–234
printing, 226
saving, 228, 233, 238
selections and, 245
shape, 226–229
uses for, 225
vector mask creation, 246–248
viewing, 239
work paths, 232, 237

Paths button, 230
Paths palette, 226, 227, 239–242
Pattern Fill dialog box, 186–187
pattern layers, 184–187
Pattern Maker plug-in, 190–194, 493
Pattern Name dialog box, 189
patterns

creating, 188–194
custom library for, 190
deleting, 190
filling area with, 283
naming, 193
organizing, 190
sampling, 188–189

PCX format, 30
PDD format, 43
PDF files, 46–49
PDF format, 30, 46
PDF Options dialog box, 47–49
PDF Security dialog box, 48–49
Pen tool, 75, 229–232
Pencil tool, 72–73
pens, 229–234
Personalize Digimarc dialog box, 461
perspective, 131
perspective cropping, 297
Perspective transformation, 131
phosphors, 356
Photo CD format, 30

photographs. See also images
blurring areas of, 262–264, 489–490
burning areas of, 285–287, 490
converting to grayscale, 368–369
cropping, 217–218, 296–298
dodging areas in, 284–285, 491
patching, 292–294
repairing imperfections, 288–291
sepia, 385, 395–397
smudging areas of, 264–266
sponging areas, 287–288
techniques for, 284–294
Web Photo Gallery feature, 442–446

Photoshop
exiting, 21
forums, 488
online resources, 487–488
preferences. See preferences
screen elements, 10–14
serial number, 483
starting, 4
system memory, 484
tools overview, 5–9
tutorials, 488
Web site, 488
work area, 3–21

Photoshop DCS options, 253
Photoshop files

adding file info, 36–42
adding XMP information, 38–42
closing, 50–51
creating, 24–27
embedding information in, 36–37
finding, 52–53
formats. See file formats
naming, 25, 44
opening, 27–30
recently used, 28, 479
saving, 42–43
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Photoshop files, (continued)
saving to other formats, 43–49
switching between, 50
working with, 23–56

Photoshop Help system, 14–20
picas, 482
PICT format, 30
Picture Package dialog box, 344–346
Picture Package feature, 344–347, 493
pictures. See images; photographs
Pixelate filters, 310
pixels

color information in, 366
described, 493
doubling, 480
moving selections by, 120
resizing and, 300
resolution and, 26, 299
selecting with Magic Wand tool, 116–120
selection smoothing and, 136–137
trimming, 307
zooming to pixel size, 98–99

pixels per inch (ppi), 493
Place dialog box, 255–256
plug-ins, 399–411

applying, 405–408
described, 399, 493
filter, 407–408
functions, 399
identifying, 483
installing, 400–404
Liquify, 409–411
obtaining, 400
online resources, 488
Pattern Maker, 190–194, 493
preferences, 483
storing, 400, 404, 406
third-party, 400
Web sites, 488

PMS (Pantone Matching System), 492–493

PNG files, 430, 433
PNG format, 428
points, 482, 491
Polygonal Lasso tool, 111, 113–114
polygons, 113–114
pop-up palettes, 9
positioning tools, 147–159
Posterize dialog box, 380
posterizing effect, 379, 380, 493
PostScript printers, 325, 340
ppi (pixels per inch), 493
preferences, 475–484

cache, 484
cursors, 480
display, 480
file handling, 479
gamut, 481
general, 476–478
grids, 481, 483
guides, 483
memory, 484
plug-ins, 483
rulers, 482
scratch disks, 483
slices, 483
transparency, 481
units, 482

Preset Manager, 165–167, 190, 493
presets

adding, 167
automations, 419
colors, 161
described, 159, 493
gradients, 280
replacing, 167
saving, 159–162
using, 162–164

Presets palette, 159–167
Preview button, 33
previewing
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HTML files, 454
images, 479
transparency, 481

Print dialog box, 323–343
Print keys, 478
printers

color and, 326, 329–332
ink colors, 326, 331, 352
margin settings, 321
page setup, 318–321
paper orientation, 321
paper sizes, 321
PostScript, 325, 340
resolution, 482
selecting, 318–320
settings for, 321, 322, 339–342

printing, 317–347
background color, 337–339
with borders, 332–334
color, 326, 329–332
crop marks, 335, 340
duotone printing, 352
multiple, 344–347
page setup, 318–321
Picture Package feature, 344–347
positioning image, 322–332
print settings, 322, 339–342
printer selection, 318–320
procedure for, 342–344
resizing image, 324
scaling image, 322–332
specifying bleeds, 335–337
transfer settings, 329–332
trapping and, 369–370
at various sizes, 344–347
working with screens, 325–328, 494
zooming to print size, 98–99

printing paths, 226
Proof Setup option, 342

properties
layer, 195–196
printer, 319–320

Properties dialog box, 319–320
PSD files, 479
PSD format, 43

Q
Quadtone option, 391
Quick Mask mode, 204–208

R
RAM

cache, 484
open files and, 50
preferences, 484

raster images, 493
rasterizing

described, 493
text layers and, 209, 493
watermarks and, 467, 469

recording actions, 416–417
Rectangle tool, 77–78, 226
rectangles

drawing, 77–78
selecting, 106–108

Rectangular Marquee tool, 106–107
Redo key, 478
Registration Marks option, 340
Render filters, 310
resampling

image cropping and, 296–298
image resizing and, 299, 300, 302
increasing resolution while printing, 340

Reset Tool, 66
Reset (Type) command, 166
resolution

cropped material and, 296
decreasing, 299
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default, 482
described, 493
image quality and, 299
images, 25, 26
increasing, 299, 340
interlacing and, 430
pixels and, 26, 299
preset, 482
printers, 482
resizing and, 299–301
screen, 482

resources, online, 487–488
review questions

Part I, Starting Out with Photoshop, 57
Part II, Making Basic Edits, 168
Part III, Using Layers, Masks, and Paths, 257
Part IV, Fine-Tuning Your Image, 348
Part V, Using More Advanced Techniques,

423
Part VI, Prepping Images for the Web, 455

RGB color, 365, 389
RGB images, 366
RGB mode, 352
rhombus, 131
rollovers, 493–494
Rotate transformation, 131
rotation

canvas, 304–305
clockwise, 305
counterclockwise, 305
crop zone, 297
images, 304–305
options for, 304
patches, 293
selections, 131

Rounded Rectangle tool, 77–78
rows, 110–111
rulers

dragging guidelines from, 156–157
hiding, 150–151

horizontal, 150
preferences, 482
showing, 150–151
vertical, 150

S
sampling, 290, 494
Save As command, 44–45, 429–430
Save As dialog box, 42–47, 252–253
Save dialog box, 39
Save for Web command, 431–442, 452–453
Save Optimized As dialog box, 453
Save Path dialog box, 228, 233, 237–238
Save Selection dialog box, 139–140
Save Workspace dialog box, 54–55
saving

GIF files, 435–439
JEPG files, 431–435
to other formats, 43–49
paths, 228, 233, 238
Photoshop files, 42–43
presets, 159–162
selections, 122, 139–140
WBMP files, 440–442
in Web format, 428–429
workspace, 54–56

Scale transformation, 131
scaling

gradient layers, 184
images, 322–332
patterns, 187
selections, 131

Scan button, 33
scanned images

bit depth, 366
importing, 31–32
transparent backgrounds and, 428

scratch disks, 483
screen elements, 10–14
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screens
described, 494
fitting image to, 100–101
halftone, 325
pixel doubling, 480
resolution, 482
settings, 301, 325–328, 494
working with, 325–328

scroll bars, 101–102
searching

with File Browser, 52–53, 491
help topics, 17
Photoshop files, 52–53, 491

Select an Image File dialog box, 345
Select menu, 134
selections, 105–124

adding, 121
adjusting, 120–122, 205–208
aligning, 128, 149, 151, 152–154
changing selection border, 134–135
columns, 110–111
contracting, 137–138
copying, 129–131
deleting, 126–127
deselecting, 122–124, 142–143
distorting, 131
ellipses, 108–110
expanding, 137–138
flipping, 131
inverse, 122
with Lasso tool, 111–116
layers, 128, 174, 199
loading, 140–141
with Magic Wand tool, 116–120
manipulating, 125–145
with Marquee tool, 106–108
as masks, 214–216
modifying part of, 134–138
moving, 127–128

moving by one pixel, 120
naming, 139–140
odd shapes, 112–116
palette items, 8
palettes, 7
paths as, 245
polygons, 113–114
Quick Mask mode and, 205–208
rectangles, 106–108
reinstating, 124
removing, 121, 122–124
resizing boundaries, 131
rotating, 131
rows, 110–111
saving, 122, 139–140
scaling, 131
sizing, 107
skewing, 131
smoothing, 135–137
snapping to grids/guides, 152–154
transforming, 131–133
undoing changes to, 142–145

separation, color, 364–365, 369–370, 490
sepia images, 385, 395–397, 494
serial number, 483
shadows, 375, 376
shape layers, 269, 281
Shape layers button, 76, 78, 230
shape tools, 77–78
shapes

drawing, 77–78
ovals, 77–78
paths, 226–229
polygons, 113–114
rectangles. See rectangles
selecting odd shapes, 112–116
snapping to, 234, 235

Sharpen filters, 310
Sharpen tool, 266–269
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sharpening images, 266–269
shortcut menus, 9, 491
Similar command, 137
Single Column Marquee tool, 110
Single Row Marquee tool, 110
Sketch filters, 310
Skew transformation, 131
skewing selections, 131
Slice Options dialog box, 449–450
Slice Select tool, 451
Slice tool, 448–455
sliced elements, 447–454, 483, 494
sliced files, 452–454
sliders, 7, 65, 494
Smooth Selection dialog box, 136
smoothing items, 135–137
Smudge tool, 264–266
smudging images, 264–266, 494
Snap command, 153–154
Snap To feature, 149, 152–154
snapping

grids, 149, 152–154
guidelines to ruler increments, 156–157
to shapes, 234, 235

spell checking, 82–84
spinner buttons, 494
Sponge tool, 287–288
sponging photographs, 287–288
spot color, 386–389, 494
Step Backward command, 142, 143
Step Forward command, 143
Stroke command, 135
Stroke Path with Foreground Color button, 244
styles

gradient, 183, 279, 280
guides, 483
layers, 196–197

Stylize filters, 310
Swatches tab, 67

T
tabs, palette, 8
targets, 449, 470
text

adding, 79–88
finding, 84–86
horizontal, 79
notes, 87–88
rasterizing and, 209
replacing, 84–86
spell checking, 82–84
transforming, 132
vertical, 79
warped, 80–82

text boxes, 6, 80–82, 494
text layers, 79–82
Texture filters, 310
Threshold command, 379
thumbnails

contact sheets, 344
File Browser, 52–53
images, 103, 344
layers, 224
masks, 210, 211, 216, 248
printing, 344
Web Photo Gallery, 446

TIFF files, 479
TIFF format, 30
Tile History area, 192–193
tints, 390–394
toggle button, 8, 65
tolerance, 277, 284, 494
Tolerance entry, 277
tonal balance, 377
tonal quality, 375–376, 494
tool buttons, 62–63
Tool Presets palette, 160–164
Tool Tips, 477
toolbox buttons, 8
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toolboxes
described, 62, 494
hiding, 10
showing, 11

tools, 61–94. See also specific tools
colors used by, 66–69
defaults for, 66
drawing tools, 75–78
editing tools, 261–294
overview, 5–9
painting tools, 70–74
pop-up palettes for, 9
positioning tools, 147–159
presets for, 159–167
resetting, 66
selecting, 62–63
setting options, 63–65
shape tools, 77–78

topic links, 15, 17
Torn Edges filer, 207
Transfer Functions dialog box, 330–331
transfer settings, 329–332
transforming selections, 131–133
transforming text, 132
transparency

Background Eraser tool and, 273
background layers, 172, 173, 179, 182, 222,

429
backgrounds, 26, 429
Blur tool and, 266
filter effects, 313
GIF files and, 438
grid colors and, 481
preferences, 481
previewing, 481
Sharpen tool and, 266
Smudge tool and, 266
video hardware support and, 481

Transparent option, 172
Trap dialog box, 370

trapping, 369–370, 494
Trim dialog box, 306–307
trimming items, 306–307
Tritone option, 391
tutorials, Photoshop, 488
tweening, 494
Type tool, 79–82

U
Undo command, 142–143
ungrouping layers, 199, 201
Uniform Resource Locators (URLs), 448, 449,

494
unit preferences, 482
URLs (Uniform Resource Locators), 448, 449, 494

V
vector images, 495
vector masks, 246–248, 495
video alpha, 481
Video filters, 310
view zone, changing, 101–103
views, image, 95–103

W
warning dialog boxes, 478
Warp Text dialog box, 80–81
warped text, 80–82
Watermark Information dialog box, 471–473
watermarks, digital, 459–473
WBMP files, 440–442
WBMP format, 428, 495
Web

color and, 437
creating images for, 427–446
GIF files. See GIF files
graphics formats, 428–429
JPEG files, 430, 431–435
WBMP files, 440–442
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Web pages
hotspots, 447–454
linking to images, 442–446
photo gallery on, 442–446
sliced elements, 447–454

Web Photo Gallery feature, 442–446
Web sites

filters, 488
online resources, 487–488
Photoshop, 488
plug-ins, 488
tutorials, 488

white point setting, 357, 358
Window menu, 10, 11

windows
image windows, 176
resizing, 98, 100

Windows Clipboard, 129
work area, 3–21, 495

work paths, 232, 237, 246, 495
workgroup functionality, 479
workspace, 54–56, 495

X
XMP data, 38–42
XMP (Extensible Metadata Platform), 38, 495

Z
zoom slider, 103
Zoom tool, 96–101
zooming

entering zoom percentages, 103
fitting images to screen, 100
in/out, 96–97
to pixel size, 98–99
to print size, 98–99
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